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Preface
This manual describes the architecture of applications created by Forte WebEnterprise 
Designer. The architecture includes both a hierarchy of TOOL classes and generated HTML 
templates. Once you are familiar with the WebEnterprise Designer architecture, you can 
begin to customize your applications.

This manual is intended for application developers. We assume that you:

■ have programming experience

■ are familiar with SQL and your particular database management system

■ are familiar with HTML

■ understand the basic concepts of object-oriented programming as described in A Guide 
to the Forte 4GL Workshops

■ have used the Forte Repository Workshop

■ have a basic understanding of WebEnterprise Designer as described in Getting Started 
with WebEnterprise Designer

■ understand the basic concepts of WebEnterprise as described in A Guide to 
WebEnterprise
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Organization of This Manual
The first five chapters of this manual discuss the basics of both TOOL and HTML 
customization, including the organization of the elements and generated code you are 
working with, guidelines to customization techniques you should use, and many examples 
of useful customizations. This is followed by a chapter on how to add security to an HTML 
application, using both TOOL and HTML customization techniques discussed previously. 
The last chapter describes how to deploy a WebEnterprise Designer application in a 
complex environment. Briefly, the chapters in the manual are:

Chapter Description

Chapter 1, “WebEnterprise Designer Application 
Architecture”

Provides an overview of the architecture of both supplied 
and generated WebEnterprise Designer classes and how 
they interact.

Chapter 2, “Customizing WebEnterprise Designer 
Application Classes”

Describes how to use the Page Handler Customization 
Wizard, and describes each of the customizations you can 
implement with it.

Chapter 3, “Customizing Generated HTML 
Templates”

Provides an overview of generated HTML template files 
and how they interact. Also provides guidelines and 
examples of customizing them.

Chapter 4, “Customizing Page Designs” Provides guidelines for customizing the provided page 
designs or creating your own.

Chapter 5, “Customizing Page Styles” Provides guidelines for customizing the provided page 
styles or creating your own.

Chapter 6, “Customizing Error Pages” Provides guidelines for customizing the error pages that 
display in the browser.

Chapter 7, “Customization Examples” Describes 12 practical customizations for WebEnterprise 
Designer applications.

Chapter 8, “Customizing Application Security” Provides information on creating a secure WebEnterprise 
Designer application, creating a logon page, and 
integrating the application with your own authentication 
system.

Chapter 9, “Partitioning and Deploying a 
WebEnterprise Designer Application”

Describes how to partition and deploy a WebEnterprise 
Designer application in a complex environment.
Customizing WebEnterprise Designer Applications
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Conventions
This manual uses standard Forte documentation conventions in specifying command 
syntax and in documenting TOOL code.

Command Syntax Conventions
The specifications of command syntax in this manual use a “brackets and braces” format. 
The following table describes this format: 

TOOL Code Conventions
Where this manual includes documentation or examples of TOOL code, the TOOL code 
conventions in the following table are used. 

Format Description

bold Bold text is a reserved word; type the word exactly as shown.

italics Italicized text is a generic term that represents a set of options or values. Substitute an 
appropriate clause or value where you see italic text.

UPPERCASE Uppercase text represents a constant. Type uppercase text exactly as shown.

underline Underlined text represents a default value. 

vertical bars | Vertical bars indicate a mutually exclusive choice between items. See braces and brackets, 
below.

braces { } Braces indicate a required clause. When a list of items separated by vertical bars is enclosed in 
braces, you must enter one of the items from the list. Do not enter the braces or vertical bars.

brackets [ ] Brackets indicate an optional clause. When a list of items separated by vertical bars is enclosed 
by brackets, you can either select one item from the list or ignore the entire clause. Do not 
enter the brackets or vertical bars.

ellipsis … The item preceding an ellipsis may be repeated one or more times. When a clause in braces is 
followed by an ellipsis, you can use the clause one or more times. When a clause in brackets is 
followed by an ellipsis, you can use the clause zero or more times. 

Format Description

parentheses ( ) Parentheses are used in TOOL code to enclose a parameter list. Always include the parentheses 
with the parameter list.

comma , Commas are used in TOOL code to separate items in a parameter list. Always include the 
commas in the parameter list.

colon : Colons are used in TOOL code to separate a name from a type, or to indicate a Forte name in a 
SQL statement. Always include the colon in the type declaration or statement.

semicolon ; Semicolons are used in TOOL code to end a TOOL statement. Always type a semicolon at the 
end of a statement.
Preface
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The Forte Documentation Set
Forte produces a comprehensive documentation set describing the libraries, languages, 
workshops, and utilities of the Forte Application Environment. The complete Forte Release 
3 documentation set consists of the following manuals in addition to comprehensive 
online Help.

Forte 4GL
■ A Guide to the Forte 4GL Workshops

■ Accessing Databases

■ Building International Applications

■ Escript and System Agent Reference Manual

■ Forte 4GL Java Interoperability Guide

■ Forte 4GL Programming Guide

■ Forte 4GL System Installation Guide

■ Forte 4GL System Management Guide

■ Fscript Reference Manual

■ Getting Started With Forte 4GL

■ Integrating with External Systems

■ Programming with System Agents

■ TOOL Reference Manual

■ Using Forte 4GL for OS/390

Forte Express
■ A Guide to Forte Express

■ Customizing Forte Express Applications

■ Forte Express Installation Guide

Forte WebEnterprise and WebEnterprise Designer
■ A Guide to WebEnterprise

■ Customizing WebEnterprise Designer Applications

■ Getting Started with WebEnterprise Designer

■ WebEnterprise Installation Guide
Customizing WebEnterprise Designer Applications
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Forte Example Programs
In this manual, we often include code fragments to illustrate the use of a feature that is 
being discussed. If a code fragment has been extracted from a Forte example program, the 
name of the example program is given after the code fragment. If a major topic is 
illustrated by a Forte example program, reference will be made to the example program in 
the text.

These Forte example programs come with the Forte product. They are located in 
subdirectories under $FORTE_ROOT/install/examples. The files containing the examples 
have a .pex suffix. You can search for TOOL commands or anything of special interest with 
operating system commands. The .pex files are text files, so it is safe to edit them, though 
you should only change private copies of the files. 
Preface
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Viewing and Searching PDF Files
You can view and search 4GL PDF files directly from the documentation CD-ROM, store 
them locally on your computer, or store them on a server for multiuser network access. 

Note You need Acrobat Reader 4.0+ to view and print the files. Acrobat Reader with Search is 
recommended and is available as a free download from http://www.adobe.com. If you do 
not use Acrobat Reader with Search, you can only view and print files; you cannot search 
across the collection of files.

� To copy the documentation to a client or server:

1 Copy the fortedoc directory and its contents from the CD-ROM to the client or server 
hard disk.

You can specify any convenient location for the fortedoc directory; the location is not 
dependent on the Forte distribution.

2 Set up a directory structure that keeps the fortedoc.pdf and the 4gl directory in the same 
relative location.

The directory structure must be preserved to use the Acrobat search feature.

Note To uninstall the documentation, delete the fortedoc directory.

� To view and search the documentation:

1 Open the file fortedoc.pdf, located in the fortedoc directory.

2 Click the Search button at the bottom of the page or select Edit > Search > Query.

3 Enter the word or text string you are looking for in the Find Results Containing Text field 
of the Adobe Acrobat Search dialog box, and click Search.

A Search Results window displays the documents that contain the desired text. If more 
than one document from the collection contains the desired text, they are ranked for 
relevancy.

Note For details on how to expand or limit a search query using wild-card characters and 
operators, see the Adobe Acrobat Help.

4 Click the document title with the highest relevance (usually the first one in the list or 
with a solid-filled icon) to display the document.

All occurrences of the word or phrase on a page are highlighted.

5 Click the buttons on the Acrobat Reader toolbar or use shortcut keys to navigate 
through the search results, as shown in the following table: 

6 To return to the fortedoc.pdf file, click the Homepage bookmark at the top of the 
bookmarks list.

7 To revisit the query results, click the Results button at the bottom of the fortedoc.pdf 
home page or select Edit > Search > Results.

Toolbar Button Keyboard Command

Next Highlight Ctrl+]

Previous Highlight Ctrl+[

Next Document Ctrl+Shift+]
Customizing WebEnterprise Designer Applications
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WebEnterprise Designer
Application Architecture
This chapter discusses the architecture of a generated WebEnterprise Designer application 
by examining the supplied and generated classes and illustrating how they interact.

Topics covered in this chapter include:

■ a description of the runtime interaction between the Web application services and the 
business services

■ a description of the generated WebEnterprise Designer project and its suppliers

■ a diagram describing the relationship between generated classes and supplied classes

■ the flow of control between methods and objects at runtime

■ the flow of control between pages at runtime

■ the effect of properties in the HTML Application Model Workshop on generated classes

Throughout this chapter, examples of general topics are drawn from the HTML Tutorial 
application. For example, you will see references to CustomerOrderHandler and 
Display_CustomerOrder.html—these elements exist in the generated 
HTMLtutAppHandlers project and HTMLtutApp HTML document directory.
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Logical Architecture
Forte WebEnterprise Designer supports a three-tier architecture. In a three-tier 
architecture, the user interface, application services, and database processing are divided 
into separate modules, as illustrated in Figure 1:

Figure 1 Three-Tier Architecture

Using WebEnterprise Designer, you build the first and second tiers of your application. 
With the HTML Application Model Workshop, you create the user interface and Web 
application server; with the Business Model Workshop, you create the application business 
services, which provide access to database information. 

User Interface HTML Application Model

Application Logic

Database Server

HTML Application Model
and

Business Model
Service Objects

Web
page
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Runtime Architecture
Figure 2 illustrates the interactions of the parts of a WebEnterprise Designer application at 
runtime.

Figure 2 Anatomy of a WebEnterprise Designer Application at Run-Time

In Figure 2, the Web Client at the left represents a client machine using a Web browser to 
view a WebEnterprise Designer application. When the user requests new information, the 
browser passes an HTTP request (a URL) to the Web server, requesting a Web page. 

On the Web server, the fortecgi program or a Forte Web server plug-in directs the HTTP 
request to the Forte WebEnterprise Designer AccessService service object, which passes the 
page request to the ScannerService service object, along with any parameter values 
relevant to the page.

The ScannerService service object opens the requested HTML page template and processes 
the Forte tags to create the page. When the service object encounters certain tags in the 
HTML template, it invokes the HandleTag and HandleCondition methods of the handler 
class associated with the template. The handler class uses the Business Service service 
object to access business services (which access the database), and returns any data 
needed in a result set. The handler class caches the result set in the AccessService for future 
use. 

After the ScannerService service object populates the page template with the result set, it 
returns the requested page back to the AccessService service object, which delivers it to the 
Web server. The Web server in turn passes the page to the client Web browser, which 
displays the page.

The AccessService service object maintains state for all the Web clients it serves. Its dialog 
duration is session. Unlike normal session duration service objects, you may load balance 
the AccessService service object. When you do, each new browser request is routed to the 
next available replicate. Subsequent requests from the same browser session will be 
directed back to the replicate that handled the first request.
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Web Application Server Architecture
An application generated by WebEnterprise Designer is comprised of a set of logical pages 
and associations between those pages. These logical pages are implemented by a 
combination of HTML templates and TOOL code. A TOOL class and a set of HTML 
templates are generated for each logical page. 

The handler class The TOOL class generated for each logical page is the bus_class_pageHandler class, referred 
to as the “handler” or “page handler,” and is generated into the html_modelHandlers 
project. It is a subclass of the ExpressClassHandler class from the ExpressHandlers project. 
The handler implements the logic intended by the page, and formats any required data into 
a WebEnterprise result set for substitution into the HTML page built by the WebEnterprise 
scanner.

In particular, the handler page implements the WebEnterprise TagHandlerIFace interface 
and handles WebEnterprise tag requests made by the HTML templates generated for the 
logical page. The html_modelScanner class that is generated for the application 
instantiates each of the handler class objects defined by the application and, when 
required, dispatches to them tag requests made by their associated HTML templates.

The HTML templates The set of HTML templates for each logical page defines how the data for the page will be 
displayed, and implements the links to other logical pages. 

HTML templates are HTML files with embedded WebEnterprise tags. These tags cause: 

■ invocations of either the HandleTag or HandleCondition methods of the handler class 
associated with the template

■ substitution of data generated by the handler class into the HTML page sent in response 
to the request for the WebEnterprise HTML template

In addition, WebEnterprise Designer generates what is required—principally, the Access 
and Scanner services—to invoke the appropriate handler class method when requests for 
HTML templates are made. The Web application server designer usually does not need to 
be concerned with the required mechanisms, but they are essentially described in the 
object interaction diagram of the template request process (see section “Runtime Control 
Flow” on page 35).

Customization guidelines Customizing a WebEnterprise Designer application involves modifying the generated 
HTML templates, the generated handler classes, or both. In general, you customize:

■ the handler class when you want to affect the logic of the page

An example is when you want to modify the data returned by a search request.

■ the HTML template when you want to affect the presentation of data or the connection 
between pages

Examples are when you want to display some fields in bold font, or move the location of 
a field on the page.

Often customization involves changes to both an HTML template and a handler class. For 
example, adding a custom field requires adding a tag reference for the field in the HTML 
template to display the data, and adding the logic to the associated handler class to 
compute the value and place it in the result set for the template.

Examples of all types of customizations are provided in Chapter 7, “Customization 
Examples.”

Runtime Objects by Partition
Figure 3 illustrates the two partitions and their key objects that typically exist at runtime in 
the deployed HTML Tutorial application. 
Customizing WebEnterprise Designer Applications
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Note You can customize every element in this diagram, except aDBSession, by modifying its 
class definition or HTML template. See Chapter 2, “Customizing WebEnterprise Designer 
Application Classes,” for details.

Figure 3 HTMLtutApp Partitions and Objects at Runtime

Multiple ovals means there may be many such objects (for example, an array of). The prefix 
“a” means an instance of the class with that name (for example, aLineItemHandler). 
Control flow arrows mean “invokes methods on.” The object at the beginning of an object 
reference arrow references the object at the arrow end. 
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Use of Express Services
The classes generated by the HTML application model are used in the Web application 
server partition. In addition, some of the classes generated by the business model (the 
business_classClass, business_classQuery, and business_modelClient classes) are also used 
in the Web application server tier. The Web application server is a client of the business 
services generated by the business model.

For a description of Express Services classes, see Customizing Forte Express Applications.
Customizing WebEnterprise Designer Applications
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WebEnterprise Designer Projects
This section describes WebEnterprise Designer projects, including the project generated 
from the HTML application, the libraries and projects that supply the generated project, 
and a brief overview of the HTML templates that are also generated for the application 
(these are described fully in Chapter 3, “Customizing Generated HTML Templates”).

Figure 4 gives you an idea of what all this code is generated for:

Figure 4 Code Generated from a WebEnterprise Designer HTML Application

Figure 4 shows that, for each business class page, WebEnterprise Designer generates a set 
of HTML templates and a Handler TOOL class. In addition, it generates a Scanner service 
object and an Access service object (and corresponding classes that define each service 
object) for the whole application.

All of the TOOL code for the HTML application is generated into the html_modelHandlers 
project. The supplier projects of the html_modelHandlers project include:

■ the HTTP library (a WebEnterprise project)

■ the ExpressHandlers project (a WebEnterprise Designer project)

■ the business models the HTML application uses and their suppliers, which include the 
ExpressDomains and ExpressServices projects

This section provides class hierarchy diagrams of the HTTP library and the 
ExpressHandlers project, followed by a detailed description of the html_modelHandlers 
project. Complete descriptions of the HTTP library and the ExpressHandlers project are 
found in Forte online Help. Descriptions of ExpressDomains and ExpressServices are found 
in Customizing Forte Express Applications.
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HTTP Library
The HTTP library provides classes that are used to:

■ define service objects for a Forte Web application

■ manipulate HTTP requests and responses

■ process HTML templates to generate Web pages

■ Create and track unique client sessions

Figure 5 shows the class hierarchy for the HTTP library.

Figure 5 HTTP Class Hierarchy

In addition to the classes shown in Figure 5, the HTTP Library contains the 
TagHandlerIFace interface. This interface must be implemented in order for WebEnterprise 
to process the Forte tags in the HTML templates. The ExpressHandler class (in the 
ExpressHandlers project, described in the next section) implements this interface.

For descriptions of these classes, see Forte online help.
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The ExpressHandlers Project
The ExpressHandlers project contains a set of superclasses that provides generic 
functionality for the classes generated from the HTML application model. For example, the 
ExpressHandler class is the superclass for the bus_class_pageHandler classes generated for 
each of the application’s pages. Refer to the online help descriptions of the 
ExpressHandlers classes for descriptions of these classes and their components.

Figure 6 shows the ExpressHandlers project’s class hierarchy and the key superclasses of its 
supplier projects.

Figure 6 ExpressHandlers Class Hierarchy and Suppliers

It is the ExpressHandler class and its subclasses that implement the TagHandlerIFace 
interface (see Figure 5 on page 24).
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The html_modelHandlers Project
The html_modelHandlers project contains TOOL classes generated from the HTML 
application model. These classes provide the Web application server logic for the pages in 
the model, and are subclasses of classes defined in the ExpressHandlers project. 

You generate the classes in the html_modelHandlers project with either the File > Generate 
Web Application Server Code command in the HTML Application Model Workshop, or the 
CompilePlan command in the Fscript utility.

For a description of classes generated from the business model, see Customizing Forte 
Express Applications.

WebEnterprise Designer generates the following classes in the html_modelHandlers project 
to implement the user application defined in the HTML application model. 

A Yes in the Custom column means the class is a customizable class and will not be 
regenerated when you regenerate the HTML application model, which preserves your 
customizations.

WebEnterprise Designer also generates the following service objects in the 
html_modelHandlers project:

For information about using and partitioning these service objects, see Chapter 9, 
“Partitioning and Deploying a WebEnterprise Designer Application.”

Generated Class Superclass Custom? Description

bus_class_pageHandler ExpressClassHandler No Contains the information about the behavior of a page in an application. This 
class includes the code generated to implement the functions and behavior 
that you defined for this page.

logon_pageBaseHandler ExpressLogonHandler No Contains the information about the behavior of a logon page in an 
application. This class includes the code generated to implement the functions 
and behavior that you defined for this page.

logon_pageHandler logon_pageBaseHandler Yes Contains your customizations for logon_pageBaseHandler. This class is not 
regenerated when you regenerate your HTML application model code, thereby 
preserving your customizations.

html_modelBaseAccess ExpressHTTPAccess No Defines the Access service object, which contains the generated Web 
connectivity preferences for the application.

html_modelAccess html_modelBaseAccess Yes Contains your customizations for html_modelBaseAccess. This class is not 
regenerated when you regenerate your HTML application model code, thereby 
preserving your customizations.

html_modelBaseScanner ExpressScanner No Defines the Scanner service object, which instantiates and holds the handler 
objects.

html_modelScanner html_modelBaseScanner Yes Contains your customizations for html_modelBaseScanner. This class is not 
regenerated when you regenerate your HTML application model code, thereby 
preserving your customizations.

TestRunner ExpressTestRunner No A class that allows you to test run your application without deploying it.

Generated Service Object Class Defined By Description

html_modelAccessService html_modelAccess Receives HTTP requests from the Web server and passes 
them to the ScannerService, then receives the response 
from the ScannerService and passes the page information 
back to the Web server.

html_modelScannerService html_modelScanner Converts requests from the AccessService service object 
into pages.
Customizing WebEnterprise Designer Applications



WebEnterprise Designer Projects 27
Customizable Subclasses in html_modelHandlers
By default, WebEnterprise Designer does not generate customizable subclasses of 
bus_class_pageHandler. For information about creating customizable subclasses of these 
classes, see “Creating Customizable Classes” on page 48.

Generated HTML Templates
When you generate Web application server code for your HTML application, 
WebEnterprise Designer also generates HTML files. These files correspond to the pages in 
the model, implementing the flow between the pages and the presentation of data in the 
pages. They are generated into the html_model directory under the HTML document root 
directory. 

WebEnterprise Designer generates the following HTML templates in the html_model 
directory of the document root directory. Templates whose names include bus_class_page 
are generated for business class pages; those with link_page in the name are generated for 
link pages. “Logon” templates are generated for logon pages

For more information on these templates, see Chapter 3, “Customizing Generated HTML 
Templates.” For brief information on the document root directory, see “Setting Document 
Root on the ScannerService Service Object Partition” on page 195. For more information on 
document root, see Getting Started with WebEnterprise Designer or WebEnterprise 
Designer online help.

Generated HTML Template Description

Main_bus_class_page.html Top-level HTML definition of a business class page.

Data_bus_class_page.html Provides the tags used to put the data (but not nested data) in the page to 
be displayed.

Display_bus_class_page.html Layout of the Data Display portion of the page, including nested pages.

Insert_bus_class_page.html Insert mode of the page.

Menu_bus_class_page.html Menu area for the page (if the page design includes a menu).

Search_bus_class_page.html Search mode of the page.

Update_bus_class_page.html Update mode of the page.

Header_bus_class_page.html Defines the headers of all the model’s pages (if the page design includes 
them).

Footer_bus_class_page.html Defines the footers of all the model’s pages (if the page design includes 
them).

Scripts_bus_class_page.html Scripts for the page.

Main_link_page.html Top-level HTML definition of a link page.

Display_link_page.html Layout of the data display portion of a link page.

Logon_logon_page.html The page displayed when a non-validated user attempts access to any page 
in the application.

LogonFailed_logon_page.html The page displayed when a user is denied access to the application.

Validate_logon_page.html The page used to validate the logon. This page is never displayed; it redirects 
to the first page of the application or the logon failed page as appropriate.

Start.html Defines a shortcut for a string used in deployment.

manifest.txt Lists all the HTML files generated and so serves as a catalog of the directory.

report.txt Reports on the process of generating the HTML templates, and what has 
been customized.

bus_class_page_qq_field_name.inc Contains stored and displayed values of a lookup field, if one is specified in 
the model.
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WebEnterprise Designer Class Interactions
This section provides information on the interactions between the classes described in the 
previous sections. First, a class diagram of the class hierarchies and class references is 
provided as a map of the territory. This is followed by a description of the main functions of 
the key classes in the diagram.

Class Interaction Diagram
This section presents a class interaction diagram of the WebEnterprise Designer class 
hierarchies. This class diagram uses OMT notation described in the book Object-Oriented 
Modeling and Design (by Rumbaugh, Blaha, Premerlani, Eddy, and Lorensen, published by 
Prentice Hall) to show the classes and their relationships. 

The diagram conventions are:

■ arrows between classes mean that the class at the starting end of the arrow contains an 
attribute whose type is that of the class the arrow points to

■ the label of the arrow identifies the attribute

■ a dot at the end of an arrow indicates a reference to an array

■ a class whose bounding box is a dotted line is a class described in another diagram or 
manual, and details about the class are usually not given

■ key classes display the attributes, constants, and methods referred to in the subsequent 
discussion 

These elements are indicated in the order shown in Figure 7. Constants are indicated by 
the icon used for constants in the Workshop (the pi sign).

Figure 7 Example Class Diagram
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Remember, though, to access attributes, methods, or events defined only for the runtime 
class (and not in the superclass), you must cast the object. Casting means identifying the 
class of a particular object. See the TOOL Reference Manual for more information about 
casting.

Figure 8 WebEnterprise Designer Class Interaction Diagram
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Life of a Template Request
As a context for this information, this section reviews how the parts of a WebEnterprise 
Designer application interact at runtime.

Runtime interactions of a WebEnterprise Designer application were discussed earlier in 
“Runtime Architecture” on page 19. Figure 9 and the description that follows provide 
further detail on how a request from a user’s browser is fulfilled in an HTML application.

Figure 9 Life of a Template Request

The steps in the life of a template request, as depicted in Figure 9, are:

1 The incoming HTTP request from the Web browser is passed to the AccessService 
service object html_modelAccessService.

2 The html_modelAccessService service object:

■ registers itself as a WebEnterprise server

■ defines the application’s session management security policies

■ invokes the HandleTemplateRequest method on the Scanner service object 
html_modelScannerService

3 The html_modelScannerService service object processes the named template and 
builds an HTML stream.

4 When html_modelScannerService encounters a FORTE EXECUTE tag in the template, it 
invokes the HandleTag method of the page’s handler class.

5 The HandleTag method invokes the ProcessAction method to perform the requested 
action.

6 If the action includes retrieving data from a database, the handler class uses the 
Business Service service object to access the business services, and return data in a 
result set.

7 The DisplayPage method of the page handler builds the result set for the Web page.

8 If html_modelScannerService encounters a FORTE IF tag in the template, it invokes the 
HandleCondition method of the page’s handler class.

9 The HandleCondition method determines whether the requested condition holds and 
returns either True or False accordingly.

10 html_modelScannerService then produces an HTTPResponse object, which contains 
the complete Web page, and passes this to the html_modelAccessService service object.

11 html_modelAccessService returns the now-complete requested Web page back to the 
client Web browser.
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Runtime Scenarios
To provide even more detail of some of the steps described above, some of the information 
on individual classes in the following sections includes object interaction diagrams. Such 
diagrams are based on the Jacobson notation described in the book Object-Oriented 
Software Engineering. 

Object Interaction Diagram Conventions
Object interaction diagrams illustrate how objects interact during runtime scenarios in a 
generated page that employs methods of the class under discussion. These diagrams show 
only the key objects involved in a scenario and the methods they invoke on each other. You 
can build diagrams like these on your own by running your application and stepping 
through it in the TOOL debugger.

The diagram conventions are:

■ vertical lines represent objects

The object name is given at the top of the vertical line—its name is identical with its 
class name, but prefixed with the letter “a”.

■ the methods that the objects invoke on each other are represented by horizontal lines 
between objects with an arrow indicating the direction

■ the label on the arrow is the name of the method invoked

■ time flows from top to bottom

■ a method line that points back to the same object is an object that invokes a method on 
itself

Figure 10 Example Object Interaction Diagram
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ExpressHTTPAccess
Steps 1 and 2 in “Life of a Template Request” on page 30 outline the functions of the 
generated html_modelAccessService service object in WebEnterprise Designer 
applications. The html_modelAccessService service object is based on the generated 
html_modelAccess class, which is a subclass of ExpressHTTPAccess.

The ExpressHTTPAccess class extends the WebEnterprise HTTPAccess class by defining a 
number of WebEnterprise Designer-specific attributes and a common initialization 
method called Setup. Every WebEnterprise Designer application has a generated 
ExpressHTTPAccess subclass and a generated service object based on the generated class.

Starting the AccessService Service Object
The details of starting the html_modelAccessService service object are shown in Figure 11. 
Startup is the result of invoking the html_modelAccess class’s Init method.

Figure 11 Object Interaction Diagram of the Startup of the AccessService Service Object

The Setup method drives the initialization of the html_modelAccessService service object 
by invoking the following methods:

■ SetupAccess method—registers the service object as a WebEnterprise server

■ SetupSessionManagement method—defines the application’s session management 
security policies
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Customizing ExpressHTTPAccess
All ExpressHTTPAccess customizations are accomplished by overriding or creating 
methods in the html_modelAccess class. Common customizations are:

■ customizing the application’s server registration

WebEnterprise Designer applications, by default, employ autoregistration (in which the 
service object automatically registers itself with fortecgi). To use manual registration, 
override the html_modelAccess class’s SetupAccess method and modify its 
EnableAccess method accordingly.

■ customizing the application’s session management

The SetupSessionManagement method of the ExpressHTTPAccess class defines the 
WebEnterprise session management characteristics of the application. Depending on 
the setting of the HasLogonHandler attribute, you can define the application’s HTML 
templates with the SESSION_AUTOCREATE property (if no logon page is defined) or the 
SESSION_REQUIRED property.

See Getting Started with WebEnterprise Designer for a description of WebEnterprise 
Designer default session management.

■ authenticating logon information

When a logon page is defined, you must override the LogonSession method of the 
HTTPAccess class to validate the authentication information supplied by the client user 
(typically a username and password).

See Chapter 8, “Customizing Application Security,” for information on creating and 
using logon pages.

■ setting up the primary application to perform session management for included 
applications

By default, each HTML application manages its own WebEnterprise sessions, including 
logon (if defined) and HTML template security. Another common model is to have one 
(primary) HTML application perform session management for itself and other 
(subsidiary) HTML applications. (An included HTML application is a subsidiary 
application.)

To create such a configuration, you must customize the primary HTML application and 
all of the subsidiary HTML applications as follows: 

Subsidiary HTML applications: In each subsidiary application, customize the 
IsPrimarySession method to return FALSE. You can do this through the application-
wide “Is subsidiary application” customization point in the Page Handler 
Customization Wizard. Just selecting this customization is enough; it will generate the 
proper method code. You need not customize the method code it generates.

Primary HTML application: You must customize the ConnectManagedSessions method 
of the primary application to instantiate and populate the ManagedSessions attribute 
with references to the html_modelAccessService service objects of the subsidiary 
applications. You can do this with the application-wide “Define subsidiary applications” 
customization point. Modify the code generated by this customization point to name 
your subsidiary application(s) in the line:

See Chapter 8, “Customizing Application Security,” for more details and an example.

ManagedSessions.AppendRow( subsidiaryAccessService );
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ExpressScanner
Procedures in “Life of a Template Request” on page 30 described how the 
html_modelScannerService service object coordinates the assembly of the Web page that 
fulfills the template request in WebEnterprise Designer applications. The 
html_modelScannerService service object is based on the generated html_modelScanner 
class, which is a subclass of ExpressScanner.

The ExpressScanner class extends the WebEnterprise HTMLScanner class by defining a 
number of WebEnterprise Designer-specific attributes. Every WebEnterprise Designer 
application has a generated ExpressScanner subclass and a generated service object based 
on the generated class.

Starting the ScannerService Service Object
The details of starting the html_modelScannerService service object are shown in Figure 12. 
Startup is the result of invoking the html_modelScanner class’s Init method.

Figure 12 Object Interaction Diagram of Startup of the ScannerService Service Object
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ExpressClassHandler
The ExpressClassHandler class is the primary class used to implement application logic in 
a WebEnterprise Designer Web application server. A subclass of the ExpressClassHandler 
class is generated for every page in an HTML application (see Figure 4 on page 23). In “Life 
of a Template Request” on page 30, it is the methods of these “page handlers” that the 
scanner invokes to translate Forte HTML tags into runtime data.

Page handler classes use two methods to respond to Forte tags: the HandleTag method and 
the HandleCondition method. The method signatures for these methods are predefined in 
the TagHandlerIFace interface (of the HTTP library), which is implemented by the 
ExpressClassHandler class.

Helpful background to this section is the chapter on Creating Pages Using Templates in A 
Guide to WebEnterprise, which describes what a Forte HTML template is and provides an 
example of how the FORTE EXECUTE and FORTE ITERATE tags are used in a template to 
generate a frame.

Runtime Control Flow
The details of a template request are shown in Figure 13. This diagram provides further 
details of the procedure described in “Life of a Template Request” on page 30, and provides 
a starting point for the discussion that follows. It is offered here, because it shows the role 
played by the ExpressClassHandler class (actually, by the generated subclasses, or page 
handler classes) in this process.

Figure 13 Object Interaction Diagram of a Template Request
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The generated html_modelScannerService service object instantiates the generated 
bus_class_pageHandler objects and invokes their HandleTag or HandleCondition methods 
when it encounters the following tags embedded in the templates requested by Web 
clients:

Note In this manual, as in A Guide to WebEnterprise, the tags are referred to in text in 
abbreviated form (for example, “the FORTE EXECUTE tag”), while the actual syntax 
requires a preceding question mark (as above). For a full description of Forte HTML tag 
syntax, see A Guide to WebEnterprise.

Each EXECUTE tag invokes the HandleTag method of the associated ExpressClassHandler 
object. Each IF tag invokes the HandleCondition method of the associated 
ExpressClassHandler object. 

The HandleTag method:

■ invokes the FindHandler method to find the proper handler object to execute this tag 
request (this will be the current object, unless this is a request from a nested page)

■ invokes the ProcessAction method to perform the action being requested

■ invokes the DisplayPage method to format any result data into a WebEnterprise result 
set

Formatting the data for the current logical page might require other logical pages, if the 
current page has any nested or folder logical pages. For more information, see the 
section “Foreign Result Sets” on page 39.

The HandleCondition method:

■ determines whether the requested condition holds and returns either True or False 
accordingly

Referenced Objects
An ExpressClassHandler object (more particularly, a page handler object) holds a reference 
to the html_modelScanner service that uses it. The scanner is used to provide global 
services for the Web application server including key generation, and generation of lookup 
files.

A page handler object, at initialization, creates and holds a reference to the generated 
BusinessClient for the business class that the page is based on. The generated 
BusinessClient is used to retrieve and modify business classes.

Field Identification
Each business class page has a number of attributes specified for display as fields on one or 
more of its HTML page mode templates—Display, Search, Insert, and Update. These may 
be attributes of the primary business class or of associated business classes. 

Primary and Associated Business Classes The business class that the page is based on is 
the primary business class for that page. An associated business class is one that is the 
target of an association from a primary business class, or from another associated class in 
the business model. The association can be either one-to-one, many-to-one, or optional.

<?forte execute ...>

<?forte if ...>
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Field Indexes and Association IDs

Each attribute is given a field index and association ID to identify it and place it in a 
WebEnterprise result set, so that it can be properly rendered on the page. In fact, a field 
index and association ID pair are given to all of the following items:

■ each attribute that appears on any of the HTML page mode templates for the business 
class page

■ each attribute that is indirectly referenced by the business class page

■ each association needed to navigate from the primary business class to all associated 
business classes used by the page

The field index and association ID are integer quantities and are unique only to the current 
business class page. Fields are numbered consecutively from 1, within an association.

The association ID identifies the field or association uniquely within the business class 
page, and, if it is a field, indicates whether it is from the primary or an associated business 
class. A field from the primary business class has an ID of 0; fields from associated business 
classes have IDs unique within the business class page, numbered consecutively from 1. 

Only associations that are actually used are assigned association IDs. An association is used 
if:

■ one or more of the attributes of the associated business class is used by the business 
class page 

■ one or more attributes of any business class included in the associations emanating 
from the associated business class is used by the business class page

Note This definition can be applied successively.

Converting Between Field Index and Attribute ID

Every valid association ID and field index pair is associated with an attribute of the 
business class indicated by the association ID. Use the GetFieldAttrID method to find the 
attribute ID of this attribute. 

You can also do the inverse conversion: to find the field index from the association ID and 
attribute ID, use the GetFieldIndex method.

Data Transfer
Data displayed on an HTML page is rendered into text at some point and WebEnterprise 
Designer applications perform this rendering automatically. The only time you might need 
to affect this is when you want to modify the textural representation of data to be placed on 
the form. Within the ExpressClassHandler, result data is contained in business class objects 
that you can manipulate directly, using the FormatValue and DecodeValue methods. (There 
are customization points available for such customizations. For more information, see 
“Formatting Fields” and “Decoding or Validating Fields” on page 66.)

Result Sets
Result data that is to be rendered on an HTML page is placed in a WebEnterprise ResultSet 
object. Of the total result set data retrieved for the Web client, the ResultSet object holds 
only that part that is to be rendered on the requested page. For example, if a user submits a 
query that returns a result set of 50 rows, but the page being rendered is a form with only 
one visible row, then one of the 50 rows is placed in the ResultSet object, along with the 
information that the row is a specific one of 50 rows.

For more information on result sets, see “ExpressPageData” on page 39.
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Formatting Data into a WebEnterprise Result Set

DisplayPage and FillResultSet are the methods used to populate the ResultSet object. 
DisplayPage determines the specific business class objects to be formatted into the 
ResultSet object. FillResultSet fills the ResultSet object with a single business class invoking 
FormatValue on each attribute added to the ResultSet object.

DisplayPage is the last method invoked by the HandleTag method. Therefore, whatever 
changes you make to data in the result set, they must be made before the DisplayPage 
method is invoked. 

For a descriptive list of all variables pertinent to a ResultSet object, see “Variables” on 
page 44. For information on customizing DisplayPage, see “Formatting Custom Fields” on 
page 66.

Decoding Data from a WebEnterprise Request

When an HTTP request is received, particularly a request from an HTML form, there are 
often parameters that must be decoded. When a request comes from a WebEnterprise 
Designer Insert or Update form, some of the parameters represent new data values for 
attributes in the result set. These values are updated by the UpdateClass method. When a 
request comes from a WebEnterprise Designer Search form, some of the parameters 
represent query constraints that need to be added to the Express query being run. Adding 
query constraints is done by the AddConstraints method. Both UpdateClass and 
AddConstraints use the DecodeValue method on each parameter. DecodeValue can then be 
used as a common point to implement field validation.

Result Sets and Session Management

Since only one instance of a handler class is instantiated for each logical page in the HTML 
application model, the handler class cannot hold any Web client-specific state, such as 
result data. To maintain client-specific state, the handler class uses WebEnterprise session 
management features. Each client’s result set is placed in an ExpressPageData object, 
which is then held by the WebEnterprise session using the page name as the key. To retrieve 
the result set associated with the current request, the handler class uses the HTTPRequest 
object passed on the HandleTag or HandleCondition request, and invokes the 
GetSessionData method on it, passing the current page name as the key.

The result set for a given Web client therefore becomes a collection of result sets, one for 
each logical page visited, and is maintained by the generated html_modelAccess service.

Connections Between Handlers
There are no explicit connections between handlers for different logical pages, but 
sometimes, for example with nested pages, one handler might need to access another. Two 
mechanisms are available for obtaining a reference to another handler:

■ using the scanner’s Handlers attribute

A scanner’s Handlers attribute is an array that holds a reference to every handler. You 
can therefore compute the required Handlers reference if you know the its array index.

■ using the scanner’s FindHandler method

You can use this method to find any handler based on its name.
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ExpressLogonHandler
The ExpressLogonHandler class is the other “page handler” class of WebEnterprise 
Designer applications. An application-specific subclass of the ExpressLogonHandler class 
is generated only if a logon page exists in the application. This class manages the process of 
user authentication for HTML applications.

The ExpressLogonHandler class is the superclass for the HTML application’s 
BaseLogonHandler class and its subclass, LogonHandler.

The HTML application’s SessionCreationURL attribute is set to the URL of the logon page, 
causing that page to be presented to any “new” (meaning unvalidated) client. When the 
page’s form is completed and submitted, the ExpressLogonHandler class’s 
HandleCondition method is invoked to validate the user’s authentication data and either 
start a WebEnterprise session or throw an exception.

For further details on SessionCreationURL, see “How the Logon Page is Activated” on 
page 172.

Customizing ExpressLogonHandler
Using a Logon page requires customization of the logon process. By default, no validation 
of the Logon page’s user authentication fields is performed—the client is always logged in.

Overriding the application’s LogonSession method performs this customization. You can 
do this by selecting the Logon Validation customization point in the Page Handler 
Customization Wizard. For detailed information on customizing the logon process, see 
Chapter 8, “Customizing Application Security.”

ExpressPageData
The ExpressPageData class holds the result set for a particular business class page for a 
single Web client. The result set data is saved as WebEnterprise session data, with the 
logical page name as the key. The ExpressPageData class keeps track of the current row and 
the rows visible on the rendered HTML page by means of the CurrentRow and 
FirstVisibleRow attributes. The CurrentRow attribute is used for operations that act upon a 
single row, such as update and delete.

When search or select requests are processed by a page handler, the old data held by the 
associated ExpressPageData object is invalidated (with the Invalidate method) and 
replaced with the requested data. Insert, update, or delete requests can modify data held by 
the ExpressPageData object.

Foreign Result Sets
Displaying a logical page containing nested or folder pages requires access to the 
ExpressPageData objects for the nested or folder pages. Access to these objects is achieved 
with the ExpressPageHandler class’s DisplayPage and GetForeignPageInfo methods. 

To retrieve data for nested or folder links, the DisplayPage method calls the GetForeignData 
method to access the page handler for the nested or folder page. The results are stored in 
the nested or folder page’s ExpressPageData object, which is attached to the parent page as 
an associated result set by the ExpressPageHandler class’s AddForeignData method.
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ExpressValueGenerator
The ExpressValueGenerator class is used to generate new keys for business classes when 
the insert command is used.

ExpressLookupInfo
The ExpressLookupInfo class is used to validate fields that have drop-down or radio-list 
validation. This class is the validation object used to retrieve and save the displayed and 
stored values. It is tied to an attribute of a business class in one of the included business 
models, and implements a lookup table object. The scanner holds one validation object for 
each unique stored and displayed attribute combination used by all fields in all pages in 
the application.

Normally, each field has its own validation object. However, if two fields use the same 
business class and the same stored and displayed attributes, they will each use a single 
copy of the validation object.

Modifying the Displayed Null Value
Override the GetDisplayedNullValue method if you want to display a string other than the 
default string “<NULL>” to represent a null selection.
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WebEnterprise Designer HTML Template Elements
This section describes various features of WebEnterprise and HTML that are used by 
WebEnterprise Designer templates. These features include:

■ links

■ variable references

■ URL parameters

For further information on these features, see the “Planning Web Pages” chapter in A Guide 
to WebEnterprise.

Links
Web pages use links to allow Web users to jump quickly from page to page. In the HTML 
application model, you define links to connect the pages. In addition, the commands that 
you specify for the individual pages are links to different modes of the page (the Insert 
command links to the Insert mode of the page, for example). 

A link is an anchor (for example <a HREF=”....”) with a URL (universal resource locator) that 
is embedded in an appropriate place in an HTML template. The two types of links 
previously mentioned are automatically formatted by WebEnterprise Designer. You can 
customize these or add your own to the page. This section discusses some elements of link 
formatting that are specific to WebEnterprise Designer.

A typical embedded URL reference in an HTML statement in a WebEnterprise Designer 
HTML template might look like this:

URL Parameters
Some of the URL parameters used in WebEnterprise Designer URL references are generic to 
WebEnterprise, and some are specific to WebEnterprise Designer. The URL parameters 
below that are identified as WebEnterprise parameters are described in detail in A Guide to 
WebEnterprise. 

■ ServiceName—(WebEnterprise) identifies the name of the Web access service

Syntax: &ServiceName=html_modelService

This parameter is used by the interface (whether fortecgi or the Forte Web server plug-
in). The fortecgi program or the plug-in looks up the specified service name in the 
fortecgi.dat file.

If the service name appears in the fortecgi.dat file, the Web access service object is 
enabled and registered; fortecgi or the plug-in forwards the Web request (the URL) to 
the named service.

If the service name does not appear in the file, then it is either unknown or not currently 
enabled. In this case, fortecgi or the plug-in returns a Request Failure error to the Web 
user with the message “Service not found.”

<a HREF=”$$(FORTE.ExecURL)?ServiceName=eCoolService&TemplateName=eC
ool/Display_$$(USER.TopPage).html&Action=MovieHandler.Last&Uniquifi
er=$$(FORTE.UniqueID)” target=”_fortedisplay”>

Example ServiceName=HTMLtutAppService
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■ TemplateName—(WebEnterprise) identifies the name of the WebEnterprise Designer 
template to be used to construct the page

Syntax: &TemplateName=html_model/page_mode_bus_class_page.html

This parameter is required and, on UNIX systems, is case-sensitive. Based on this value, 
the Web access service passes the current request to either the page handler or the 
ScannerService SO.

■ Action—(WebEnterprise Designer) specifies the action requested

The ExpressHandlerClass class’s ProcessAction method processes actions. This method 
compares the text value of the Action parameter with the known actions and executes 
the indicated method. By convention, these methods are named the same as the Action 
value with a “Do” prefix. For example the Next action invokes the DoNext method.

Syntax: &Action=handler.action

The handler prefix is optional. If unspecified, the current handler is assumed. However, 
sometimes the action must be executed by a handler other than the current one, which 
typically happens with nested pages. To execute the “Next” action on a nested page, the 
link must request the outer page (otherwise only the nested page would be displayed). 
However, when the outer pages handler gets the “Next” request, it must dispatch it to 
the nested handler. This is done by specifying the nested page in the Handler 
parameter.

The &Action=Next parameter of this URL causes the page to be redisplayed after 
executing the handler class’s Next function. (The Next function causes the result set to 
be scrolled to the next element.) 

There can be several Action parameters. When there is more than one, each action is 
performed in turn. 

■ LinkName—(WebEnterprise Designer) specifies the name of the link that requested the 
current page

The name is formed by concatenating the name of the HTML application with the name 
of the link (as seen in the Link Properties dialog title bar) separated by a period.

Syntax: LinkName=html_model.link_name

■ ReturnTemplate—(WebEnterprise Designer) used to remember the template requesting 
a function

Typically, the ReturnTemplate is displayed after the page needed by the requested 
function. For example, when requesting the Update action, the update HTML template 
is displayed. After the update is complete, the original page should be redisplayed. 

Syntax: &ReturnTemplate=html_model/page_mode_bus_class_page.html

Example &TemplateName=HTMLtutApp/Update_Customer.html

Example http://www.myServer.com/page.html?ServiceName=AppService

&TemplateName=myApp/Display_Movie.html&Action=Next

Example LinkName=HTMLtutApp.CustomerLink1

Example &ReturnTemplate=HTMLtutApp/Display_Home.html
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■ Selection—(WebEnterprise Designer) used to specify the fields on the page that are 
being used to provide constraints for a select operation against the business service

The Selection parameter is used with the Select action (&Action=Select) on a search 
page. The fields specified in the Selection parameter then also appear as parameters 
providing the values for the fields being constrained.

Syntax: &Selection=bus_class_page_qq_field

■ Uniquifier—(WebEnterprise Designer) specifies a unique value; used to defeat caching 
done by the browser in some cases

This parameter and its variable are used when the requested page has been used before, 
and therefore contains data, but a “fresh” page is desired. To retrieve the fresh page, 
specify a unique number with the parameter, so that the retrieved page is not the 
cached one.

For example, if the user activates the Next command, the page being requested is 
exactly the same page as the current page, but with different data. If browser caching is 
enabled, the browser will satisfy this request from the cache, which means displaying 
the same data, not the new data. Using the Uniquifier parameter with the 
FORTE.UniqueID variable creates a request that does not match any page in the 
browser’s cache. This forces the request to be passed on to the application, which 
processes the Next command, thereby advancing the result set to the next row. Then, 
when the page is populated with data, the next row will be displayed.

Syntax: &Uniquifier=$$(FORTE.UniqueID)

Example &Selection=CustomerOrder_qq_CustomerNumber

Example &Uniquifier=$$(FORTE.UniqueID)
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Variables
To use a result set in a template, you first use the HandleTag method to generate the result 
set. As each member of the result set is generated, it is assigned a name. This allows you to 
refer to any member in a result set using a Forte variable. Variable references contained in 
HTML templates have the following form:

result_set_name.result_set_member_name

The FORTE EXECUTE and FORTE ITERATE commands define the result set names. The 
variable names are defined by the application logic.

The FORTE result set WebEnterprise defines one special result set—the FORTE result set—that always exists and 
into which WebEnterprise places various useful variables, for example FORTE.ExecURL 
(described below). 

Other special result sets In addition to FORTE, WebEnterprise Designer uses three other result sets:

■ USER—holds various static values for a request

■ entry—used for all data that is being placed on the current page

■ listentry—the iteration result set for the data rows for the current page

For more information on result sets and Forte variables in WebEnterprise, see the chapter 
“Creating Pages Using Templates” in A Guide to WebEnterprise.

■ FORTE.ExecURL—(WebEnterprise) specifies the path to the Web server used by the 
application

WebEnterprise uses the value of $$FORTE.ExecURL to expand all generated URLs 
(including links in generated pages) to include the correct domain and host name for 
the Web server, and the location of either the fortecgi program or the Forte Web server 
plug-in.

EnableAccess starts the Web client’s access to the current Web access service.

A URL embedded in a template might appear as:

And the actual URL link would be expanded to:

■ FORTE.UniqueID—(WebEnterprise Designer) returns a unique number; used to defeat 
the caching mechanism

See the item “Uniquifier” in the section “URL Parameters” on page 41.

■ USER.TopPage—(WebEnterprise Designer) defines the outermost logical page being 
displayed

<a class="alink" HREF="$$(FORTE.ExecURL)?ServiceName=HTMLtutAppSe
rvice&TemplateName=HTMLtutApp/Search_Customer.html&ReturnTemplate
=HTMLtutApp/Display_$$(USER.TopPage).html&Uniquifier=$$(FORTE.Uni
queID)" target="_fortedisplay">

<a class="alink" HREF="http://www.forte.com/cgi-forte?ServiceName
=HTMLtutAppService&TemplateName=HTMLtutApp/Search_Customer.html&R
eturnTemplate=HTMLtutApp/Display_$$(USER.TopPage).html&Uniquifier
=$$(FORTE.UniqueID)" target="_fortedisplay">

Example &Uniquifier=$$(FORTE.UniqueID)
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With nested or folder logical pages, the TopPage is not always the same as the current 
logical page. This parameter is set by the Display_bus_class_page.html template to 
bus_class_page. The various Data_bus_class_page.html templates included by the 
Display page always refer to the TopPage parameter, rather than explicitly using the 
bus_class_page name.

■ entry.RequestStatus_busClassPage—the page’s request status

Each page has a request status formatted into this variable that describes the outcome 
of the request. For successful search requests, this variable contains a string that 
describes the current row number and the number of rows found by the search request. 
(for example, “row 1 of 5”).

■ entry.CurrentRow_busClassPage—the current row number for the indicated page

When a search request returns more than one row, this variable indicates which row a 
given action (for example, Update) will operate on.

■ entry.CurrentRowIndex_busClassPage—the index, within the visible rows, of the current 
row from the result set

For example, if the result set contains 10 rows, rows 3 through 7 are being displayed, and 
row 4 is the current row, then this variable contains the value 2, because row 4 is the 
second row from 3.

■ entry.FirstVisibleRow_busClassPage—the row number of the first row being displayed 
from the result set

For example, if the result set contains 10 rows, rows 3 through 7 are being displayed, and 
row 4 is the current row, then this variable contains the value 3, because row 3 is the first 
row from the result set being displayed.

■ entry.list_busClassPage—a list of data rows 

This variable contains a list of data rows that are iterated using the FORTE ITERATE 
command.

■ entry.Rows_busClassPage—number of rows in the result set

■ entry.VisibleRows_busClassPage—number of rows being currently displayed

■ listentry.qqRowNumber—value of the current iteration row of listentry

■ listentry.busClassPage_qq_fieldName—the value of an individual field on a particular 
page for the current iteration row of listentry

Example &TemplateName=HTMLtutApp/Display_$$(USER.TopPage).html
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Chapter 2
Customizing WebEnterprise
Designer Application Classes
In general, you customize an application’s logic by using the Page Handler Customization 
Wizard. The Page Handler Customization Wizard provides a set of common 
customizations.

Topics covered in this chapter include:

■ using the Page Handler Customization Wizard

■ creating customizable classes

■ deleting customizations and customizable classes

■ online customization examples

■ customizing generated handler classes

■ adding business rules to a handler

■ global customizations

Note that the examples and illustrations in this chapter use the example created in Getting 
Started with WebEnterprise Designer, and make references to the class and model names 
used there. Also, this chapter assumes some familiarity with Chapter 1, “WebEnterprise 
Designer Application Architecture.”
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Overview
Read this overview to learn some basic facts about customizing WebEnterprise Designer 
application classes. Before making customizations, make sure that the behavior you want 
cannot be accomplished by simply setting options within the HTML Application Model 
Workshop or Business Model Workshop and regenerating your application.

Before You Begin
The following are suggestions you should take into consideration before you begin your 
customizations.

■ Use the Page Handler Customization Wizard (see “Customizing With the Page Handler 
Customization Wizard” on page 51) if possible, rather than create customizations 
directly in generated projects.

■ You can choose to customize individual page handler classes, or make application-wide 
customizations by modifying classes by modifying the html_modelAccess or 
html_modelScanner classes.

■ Always try to make your customizations in such a way that they continue to work after 
you later make changes to and regenerate your HTML application model. Test 
frequently after making changes.

■ It is best not to create new classes in projects generated by WebEnterprise Designer. Try 
to keep to only generated classes in these projects (you can of course customize these 
classes—just do not add new ones). Add new classes in a separate supplier project.

■ Decide whether you need to customize a few classes or many. Your decision will 
determine whether or not to turn on the Always Generate Custom Classes toggle. When 
this is turned on, WebEnterprise Designer automatically generates a “Base” class and a 
leaf-level (customizable) class for each business class page in the model. This may 
speed development is you will customize most or all generated classes. 

Creating Customizable Classes
WebEnterprise Designer generates both customizable and base (read-only) classes for all 
components of the HTML application model except for page handler classes, for which 
only base classes are generated. This strategy generates the minimum number of classes 
required by the application, and therefore the smallest image size for deployed 
applications. 

To implement customizations that involve page handler classes requires first generating 
customizable classes for the page handlers. You do this automatically for an individual 
page when you start the Page Handler Customization Wizard for that page. Alternatively, 
you can create a full set of customizable classes for all pages in the model by enabling the 
Always Generate Custom Classes option on the Custom Generation Options dialog. (This 
dialog is displayed when you choose the File > Custom Generation Options... command).
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When you create customizable page handler classes—whether a single one or a full set—
WebEnterprise Designer automatically expands the class hierarchy, with a Base class above 
the leaf-level page handler class. All the components that were generated into the base 
class are copied to the leaf-level class. The base class is renamed to 
bus_class_pageBaseHandler, and the new, customizable leaf-level class is named 
bus_class_pageHandler. Figure 14 illustrates this principle.

Figure 14 Naming Conventions Before and After Creating Customizable Classes

If you decide you do not want the customizable class, you delete it using the Page Handler 
Customization Wizard (see “Deleting Customizations” on page 54). This collapses the 
three-class hierarchy back into the two-class hierarchy and renames the read-only Base 
class to its original name.

Creating a Single Customizable Page Handler Class
The Page Handler Customization Wizard allows you to customize individual classes. When 
you invoke the Page Handler Customization Wizard for the first time on a specific class, 
WebEnterprise Designer automatically expands the class hierarchy for the particular class, 
as shown in Figure 14. For more information, see “Customizing With the Page Handler 
Customization Wizard” on page 51.

Creating a Full Set of Customizable Page Handler Classes 
If you know you will be customizing many classes, it might be more convenient to generate 
the hierarchy at the onset of your development cycle. You do this by setting the Always 
Generate Custom Classes toggle in the Custom Generation Options dialog. When set, this 
option tells WebEnterprise Designer to create the full hierarchy automatically for every 
business class page in your model. When you use this option, note:

■ Turning it on turns it on for all the business class pages in the HTML application model; 
it can then be turned off only by deleting all the customizations on each class using the 
Page Handler Customization Wizard. You should not delete the individual classes 
manually from the generated project.

In other words, you create customizable classes for all business class pages in the model 
with one step, but you must remove individual customizable classes separately.

■ Turning it off will affect only new classes created from the time you turned it off, 
resulting in some Base classes having “Base” in their names and some not.

bus_class_pageHandler (customizable)

bus_class_pageBaseHandler (read-only)

Before: After:

renamed 
class

new class

ExpressClassHandler (read-only)ExpressClassHandler (read-only)

bus_class_pageHandler (read-only)
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� To create customizable subclasses for every business class page in your model:

1 In the HTML Application Model workshop, choose the File > Custom Generation 
Options… command.

The Custom Generation Options dialog appears.

2 Turn on the Always Generate Custom Classes toggle.

This toggle causes WebEnterprise Designer to generate customizable leaf-level classes 
for every class in the business model or page in the HTML application model.

3 Click OK.

4 Generate code by choosing the File > Generate Web Application Server Code 
command.

See “Deleting Customizations” on page 54 for information on deleting customizable 
classes.
Customizing WebEnterprise Designer Applications



Customizing With the Page Handler Customization Wizard 51
Customizing With the Page Handler Customization Wizard
The Page Handler Customization Wizard assists you in customizing your WebEnterprise 
Designer applications. When you start the Page Handler Customization Wizard on a 
business class page, you are presented with a list of categories that contain common 
customizations. When you double-click on one of the customizations, the Page Handler 
Customization Wizard automatically opens a Method Workshop window, displaying the 
appropriate method where you will place your customization code, as shown in Figure 15. 
The initial method code contains documentation of the method parameters and return 
code, and, if required, a super.method statement and a return statement.

Figure 15 Page Handler Customization Wizard Opening the Appropriate Method Workshop

In addition to locating your customization code for you, the Page Handler Customization 
Wizard has online help associated with each customization. You can access help by clicking 
the Help button while a customization is selected, as shown in Figure 16, or by browsing 
through the Help system Index to the List of all Page Handler Customizations.

Figure 16 Page Handler Customization Wizard’s Help on a Customization Topic

Information about 
the method

Double-clicking the customization 
opens the Method Workshop for the item

Help topic includes a
link to the method
being overridden, 
and shows the 
method code

Selecting the customization 

opens the Help text for the item
and clicking on the Help button
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You also use the Page Handler Customization Wizard to delete customizations. You can 
delete specific customizations, or entire subclasses. (You delete a subclass by deleting all its 
customizations, an operation that deletes the subclass, renames the Base class, and 
collapses the hierarchy to the “Before” structure in Figure 14 on page 49.) 

The following sections describe how to use the Page Handler Customization Wizard.

Customizing a Page Handler Class
You use the Page Handler Customization Wizard to customize the page handler classes that 
underlie the business class pages in your model. When you start the Wizard for a previously 
uncustomized page handler class, a customizable subclass is created for the page (this 
action is illustrated in the following procedure).

� To customize a page handler class using the Page Handler Customization Wizard:

1 Select the business class page you wish to customize.

2 Choose the Component > Customize… command.

The Page Handler Customization Wizard appears.

3 Click the arrow to the left of the categories to view specific customizations.

4 (Optional) Select the customization you wish to perform and press the Help key.

A help screen appears as shown in Figure 16 on page 51. 

5 Double-click the specific customization you wish to make (or click Customize).

If this is the first customization you are making to this class, WebEnterprise Designer 
displays the following dialog:

6 Click OK.

Click on arrow
to display
contents
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WebEnterprise Designer automatically expands the class hierarchy to include a 
customizable class for the selected business class page, and the Method Workshop 
opens, displaying an override of the appropriate method. The example shown here is 
from the “Creating a new key” customization point (under the category/subcategory 
Whole Object Operations/Inserting a new record).

7 Modify or add code appropriate to the customization you wish to make.

8 Choose the File > Compile command to compile the method.

9 (Optional) Return to Step 3 and add more customizations to the class.

10 Close the Method Workshop and the Page Handler Customization Wizard window.

Page Handler Customization 
Wizard is non-modal

Note that the Page Handler Customization Wizard window is not modal. In other words, 
you can view customization information about a class, leave the window open and select 
another window or business class, and the Page Handler Customization Wizard will display 
the appropriate information for the newly selected class.

Customizing a Generated HTML Template 
Forte generates the application’s HTML templates files (described in Chapter 3, 
“Customizing Generated HTML Templates”) into a subdirectory of the document root 
directory. You can edit these files by opening them with an HTML editor or text editor, or 
you can use the Page Handler Customization Wizard. The organization of the Wizard’s 
customization points guides you conveniently to the correct location for your 
customization. For example, find the file you wish to customize in the following Wizard 
categories:

■ HTML Files category—for page mode templates of the selected page

■ Application/HTML Files—for application-wide customizations, including customizing 
the logon page, the start page, or the page responsible for validations

Before you can edit generated files with the Customization Wizard, you must set the 
FORTE_WW_HTMLEDITOR and FORTE_WW_EDITOR environment variables with the full 
pathname of the editor of your choice. For example:

FORTE_WW_HTMLEDITOR c:\PROGRA~1\WINDOW~1\Accessories\wordpad.exe

For more information on setting these variables, see the online help topic for the variable. 
For information on using shortnames for file specification on Windows NT, see the help 
topic, “Use a shortname for the Default Browser field.”
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Deleting Customizations
Use the Page Handler Customization Wizard to delete specific customizations or all 
customizations in a class. 

Deleting Specific Customizations
A customization point that has been implemented has a method symbol next to it:

� To delete a customization:

1 Select the class that contains the customization and choose Component > Customize… 
to display the Page Handler Customization Wizard.

2 Select the customization you wish to delete and click the Delete button.

The Delete Customization dialog appears.

3 Check the Delete Selected Customization option and click OK.

WebEnterprise Designer deletes the selected customization.

A customization
was made here
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Deleting All Customizations in a Class
Use the Page Handler Customization Wizard to delete all customizations in a class. When it 
deletes all customizations, the Customization Wizard also deletes the customizable class, 
renames the base class to its original name, and collapses the class hierarchy (see the 
“Before” structure in Figure 14 on page 49)

� To delete all customizations (entire class):

1 If the Always Generate Custom Classes option is enabled, disable it.

Because the Customization Wizard will delete the customizable class after it deletes all 
its customizations, you must disable this option so that the Wizard will be able to delete 
the class. 

2 Select the class you wish to delete and choose Component > Customize… to display the 
Page Handler Customization Wizard.

3 Click the Delete button.

The Delete Customization dialog appears, with only the Delete All Customizations 
toggle active. (This happens only when you click Delete without selecting a specific 
customization to delete.)

4 Click OK.

The following dialog appears.

5 Click Defer or Generate Now, depending on whether you have more classes to delete 
(Defer) or not (Generate Now).
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Each time you delete all customizations in a class, WebEnterprise Designer regenerates 
the model. If you plan to delete all customizations on several classes, choose Defer to 
defer the model regeneration until you specifically request it. 

When you choose Generate Now, WebEnterprise Designer removes all customizations 
(if any) in the leaf-level class, and returns the class hierarchy to its original “Before” 
structure shown in Figure 14 on page 49.

Alternatively, you can defer all deletions and regenerate the model with the File > 
Generate Web Application Server Code command.

Note If you exit the workshop without regenerating the model, you will be prompted that the 
Delete All Customizations that you specified will not occur. If you ignore this reminder and 
exit without regenerating, the customized classes will not be deleted.

Making Application-Wide Customizations
The Page Handler Customization Wizard has an “Application” customization category. 
Application customizations are customizations that affect the application as a whole, 
rather than a specific page in the model, such as logon.

Deleting application 
customizations

When you delete all customizations for business class pages, application customizations 
are not deleted. You must select each application customization specifically and then 
delete it.
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A Roadmap to Customization Examples
WebEnterprise Designer provides many customization tools to help you customize your 
application. These are accessible through the Page Handler Customization Wizard.

Customization tools fall into these categories:

■ Page Handler Customization Wizard customization points

For the complete list, see “Page Handler Customization Wizard Customizations” on 
page 58.

■ customization examples 

The main customization examples are in Chapter 7, “Customization Examples,” but 
other chapters also provide examples, according to their subject. Use the Table of 
Contents to locate them.

■ customization techniques

Use the Table of Contents in this manual to help locate the sections in this chapter that 
describe the type of customization you wish to make.

■ WebEnterprise Designer example applications

For a complete description of example applications shipped with WebEnterprise 
Designer, see Getting Started with WebEnterprise Designer.

Page Handler Customization Wizard Help Files
At any point while you are using the Page Handler Customization Wizard, you can press the 
Help key to display online information about the currently selected customization.

Figure 17 Page Handler Customization Wizard Help

You can also access these item-specific customization examples directly by their titles in 
the List of all Page Handler Customizations help topic.

Select customization

Click Help button
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Page Handler Customization Wizard Customizations
The customizations available from the Page Handler Customization Wizard are:

Customization Section Customization 

Individual Field Operations Formatting a field

Adding custom field to the ResultSet

Decoding or validating a field

Updating a field

Whole Object Operations Adding constraints to the search criteria

Updating the object

Inserting a new record Creating a new empty record

Creating a new key

Database Operations Delete: Before sending a delete object request

Insert: Before sending an insert object request

Search: Before sending a retrieve object request

Update: Before sending an update object request

Processing Commands Clear: Clearing the result set

Current: Return the current page without making any changes

Delete: Deleting an object from the result set

First: Setting the current object to the first object in the result set

Goto: Setting the current object based on an index

Insert: Inserting a new object in the result set

Last: Setting the current object to the last object in the result set

Next: Setting the current object to the next object in the result set

Previous: Setting the current object to the previous object in the result set

Search: Filling the result set with new objects

SetCurrentFolder: Setting the current folder

Update: Updating the current object

Custom Commands your_command_name (as many as you have added)

Security Restricting access to all page modes

Restricting access to the search page mode

Restricting access to the display page mode

Restricting access to the insert page mode

Restricting access to the update page mode

HTML Files Under this category are all HTML file templates for the page
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Lookup Files Under this category are the lookup files for drop list and radio list 
validation for the page

Logon Validation This customization point opens the HTTPAccess.LogonSession method for 
adding security logic to your Logon page

Application Define HTML template for exceptions

Define subsidiary applications

Is subsidiary application

Modify session timeout

HTML Files AccessError page (AccessError.html)

Start page (Start.html)

Customization Section Customization 
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Customizing Manually
You can perform customizations that do not appear in the predefined list of common 
customizations in the Page Handler Customization Wizard. To do so, open the project that 
contains the class you wish to customize and then override the appropriate method or 
methods in that class. However, before you can customize a class, the class hierarchy must 
include the customizable leaf-level class. These are subclasses of the superclass whose 
name contains the word “Base.” These are not automatically generated by default. To 
create customizable classes, see either “Creating a Single Customizable Page Handler 
Class” on page 49 or “Creating a Full Set of Customizable Page Handler Classes” on page 49.

Customizable classes are never regenerated, so any changes you make to them will be 
preserved. 

The most common way to customize the behavior of a WebEnterprise Designer application 
is to override a method inherited from a superclass with TOOL code of your own.

Locating Where to Customize
Making customizations through the Page Handler Customization Wizard automatically 
places them where you want them. If none of the customization points provided by the 
Customization Wizard suits your needs, then this section will help you locate common 
places to add customizations. If the type of customization you want to make is not covered 
here, follow these suggestions:

■ Review the class interaction diagram in Chapter 1 (“Class Interaction Diagram” on 
page 28), The interconnections between objects can be useful in figuring out where to 
make a customization. The class descriptions following each class diagram can also be 
useful.

■ Look through the class function descriptions in Chapter 1 (starting with 
“ExpressHTTPAccess” on page 32). If processing similar to what you need is covered in 
that section, then you will probably see which method you need to override.

■ Run your application under the Debugger to just before where you want to change 
behavior. Set “Method Enter” breakpoints in the Debugger and continue execution of 
your application. Step or continue from there until you locate the best method to 
override.

View inherited elements In addition, you can examine inherited class elements to help you determine what and 
where to customize. 

Overriding Methods in a Superclass
Whenever this document instructs you to override a method, you must include a call to the 
method in the superclass (super.method) in your customized code. Omitting this call in 
most cases will cause the overridden method to fail to perform properly. In rare cases, you 
must not include a call to super.method—in these cases, the instructions will point this out 
explicitly. Customizations provided by the Page Handler Customization Wizard create 
initial code for the method that has a super.method method call, if one is required.

You override an existing method by creating a new method in the customizable class (for 
example CustomerOrderHandler) identical in name, parameters, and return values to the 
method in the superclass (CustomerOrderBaseHandler). Then, invoke the superclass 
method (to access its functionality) and add your own custom TOOL code.

Drag and drop When you want to create a method in a subclass that overrides a method defined in a 
superclass, drag the method from the Class Workshop for the superclass to the Class 
Workshop for the subclass. 
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� To override a method:

1 Choose the View > Inherited command in the Class Workshop to help you find which 
methods are defined in a superclass. 

2 Use the File > Open SuperClass command in the Class Workshop to open the Class 
Workshop for the superclass where the method is defined. 

3 Drag-and-drop the method from the superclass to your customizable subclass.

This will create a method in the subclass with the correct name, parameters, and return 
type. 

4 Open the method in the subclass and delete all its code, replacing it with the single 
statement:

For example, when overriding a method called NewSelectQuery, which has a parameter 
named assocID and returns a value, replace the code in the newly created subclass 
method with the following statement:

5 Add your custom code in this overridden method.

Note Depending on your customization, you could add a call to super after this.

If you were to override a superclass method by dragging the method into the subclass and 
then modifying the code, you would not need to call super.method. However, do not 
customize in this manner, because future versions of WebEnterprise Designer may change 
the implementation of the original method, causing your customized method to fail to 
compile or to execute improperly. Your call to super.method encapsulates the method’s 
behavior, making WebEnterprise Designer upgrades simpler.

Local and Global Customizations
Most customizations affect a particular business class page and are thus “local” in nature. 
However, you might need to make some customizations that will affect all business class 
pages (for example, log certain actions). The coding techniques for making local and global 
customizations are similar, but special steps must be taken to cause a change to affect all 
future generated business class pages. These steps are described in “Global Customization” 
on page 68.

Error Reporting
You can handle errors and raise exceptions in your customizations as you would in a non-
WebEnterprise Designer application (using the GetTextData method on the MsgCatalog 
class, the AddError method on the ErrorMgr class, and so on). See the TOOL Reference 
Manual and the Framework Library online Help for more information.

You will see that classes in the ExpressHandlers project make use of the 
ExpressHandlerError class. This class is not intended for you to customize or subclass; you 
call it directly in your custom code. Most uses of the ExpressHandlerError class are in raise 
statements, like the following:

In the above example, a new ExpressHandlerError object is instantiated and its 
GetException method returns an exception object.

return super.method_name(parameter_list);

return super.NewSelectQuery(assocID=assocID);

-- Raise used by WebEnterprise Designer code, 

-- not intended for you to override.

raise ExpressHandlerError(originator=self,

   error=Error.GEN_UNIMPLEMENTED).GetException;
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Working with Business Classes
This section discusses some basic concepts about working with business classes that you 
need to know if you want to change field values and add or remove rows from a result set.

Business Class Record Status
Records in the result set contained in the ExpressPageData object contain InstanceStatus 
attributes. The values of these attributes indicate what changes have been made to a record 
since it was loaded from the database. These status values are used to determine which 
queries to run on behalf of a record after it has been updated, inserted, or deleted. The 
following constants, defined in the BusinessClass class, describe each numeric value for 
InstanceStatus:

BusinessClass Attribute IDs (ATTR_)
Many methods require an integer parameter to indicate the attribute ID of the business 
class. The attribute IDs for each business class attribute are generated as constants in class 
business_classBaseQuery. The constants are named the same as the 
business_classClass.attribute name, but with the prefix “ATTR_”. For example, the attribute 
CustomerClass.CustomerNumber has a corresponding constant 
ATTR_CUSTOMERNUMBER defined in CustomerBaseQuery. (These classes are found in 
the business_modelService project generated from the supplier business model.)

Note that when two business classes contain an identically named field (often it is a 
database join field), the values of the generated ATTR_ constants in the two BaseQuery 
classes will not necessarily be identical. For example, do not assume the following have the 
same value:

CustomerBaseQuery.ATTR_CUSTOMERNUMBER

CustomerOrderBaseQuery.ATTR_CUSTOMERNUMBER

Since these constants are inherited, the examples will refer to them through the 
customizable leaf-level class. For example, the examples will refer to 
CustomerQuery.ATTR_NAME, rather than CustomerBaseQuery.ATTR_NAME, where it is 
defined.

Constant 
InstanceStatus 

Value Meaning

ST_READONLY 2 Record is read-only and cannot be modified. No Update/Insert/Delete 
queries will be run on behalf of this record.

ST_READWRITE 4 Record was loaded from the database and is updateable, but has not been 
changed by the user. Once changed, state will become ST_UPDATE.

ST_UPDATE 8 Record has been modified since being selected from database. Update 
statement will be run.

ST_INSERT 16 Record is newly created, contains values entered by the user, and is not yet 
in database. Insert statement will be run.

ST_DELETE 32 Record has been deleted (not yet deleted from database). Delete statement 
will be run.

ST_EMPTY 1 Empty record to be filled in by user—user has not yet typed any values into 
the record. (When values are entered, state will become ST_INSERT).
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Changing the Value of an Attribute
When you want to change the value of an attribute of a BusinessClass you should use the 
UpdateAttr method of the ExpressPageHandler class. When changing the value of an 
attribute of a BusinessClass there are several things you need to do. This logic is 
encapsulated in the UpdateAttr method.

Checking the Status of a BusinessClass Object
When a BusinessClass object is updated, its UpdateQuery attribute is set. The following 
example checks whether the BusinessClass object myCust has been updated and if its 
Address attribute has been modified (the object pageData is of type ExpressPageData):

Undoing Changes Made to a BusinessClass Object
It is possible to undo changes made to a BusinessClass object by using the BusinessClient’s 
Revert method:

myCust :  CustomerClass = pageData.Data[1];

if (myCust <> NIL) then

if ((myCust.UpdateQuery = NIL)

or (mycust.UpdateQuery.Values = NIL)) then

task.Part.LogMgr.PutLine(’Business class has not been 
updated.’);

else

task.Part.LogMgr.PutLine('Business class has been updated.');

if 
(myCust.UpdateQuery.GetUpdateAttr(attr=CUSTOMERQuery.ATTR_ADDRESS)

= NIL) then

task.Part.LogMgr.PutLine('Address field has not been 
updated.');

else

task.Part.LogMgr.PutLine('Address field has been updated.');

end if;

end if;

end if;

myCust : CustomerClass = pageData.Data[1];

if (myCust <> NIL) then

Client.Revert(myCust);

end if;
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Customization Techniques: ClassHandler Classes
WebEnterprise Designer provides a set of commands and behavior as a result of your 
specifications in the HTML Application Model Workshop. However, there may be times 
when you need to modify the generated behavior. 

This section shows examples and describes coding techniques you should employ when 
customizing handler classes. In these examples, business class page names, class names, 
and attribute names are used for illustration. You will need to change these to be 
appropriate for your handler class. Also, the “method” statements below should not be 
typed into the Method Workshop; they are provided for your information.

Creating a New Instance of a Business Class
You can customize your application to insert data into the result set, but rather than using 
“new()” to create an object, you should use the NewClass or NewClassForInsert methods to 
create an object that is initialized for the current business class page.

For example, if business class page CustomerOrder is based on class CustomerOrderClass, 
then create a new instance of CustomerOrderClass using the following code in a handler 
method:

The new CustomerOrderClass object will instantiate and log the attributes used by the 
associated business class page.

The differences between NewClass and NewClassForInsert are:

■ NewClass instantiates attributes used by the associated business class page, 
NewClassForInsert does not

■ NewClassForInsert uses NewKey to assign values to the key attributes of the business 
class

Getting the Result Set
Use the GetPageData method to get the current result set of the Web client issuing the 
request for the associated business class page.

Getting the Initial Query
Use the NewQuery method to get the query required to retrieve all the data that is 
requested by the associated business class page. This is an unrestrained query; therefore all 
rows in the database are returned unless constraints are applied on some of the attributes. 

record: BusinessClass = NewClass();
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Customization Techniques: Business Rules
Business rules are special data requirements that you want your application to enforce 
automatically, or particular actions the application must perform based on the state of the 
data.

Where to Implement
You can choose to implement business rules in the following places:

■ on the browser

■ in the Web application server

■ in the business services

Problems implementing 
on the browser

If you implement your business rules on the browser, the user gets immediate feedback 
rather than after submitting the request. However, anything done on the browser can 
potentially be defeated by the user. Therefore to ensure integrity, you should always 
implement your business rules in either the Web application server or in the business 
service. You may want to implement them on the browser as well, to provide a better user 
interface.

When to implement on the 
Web application server or
the business service

Whether you implement a rule in the Web application server or the business service will 
depend on the nature of the rule. When a rule is applicable to the business service (and 
could be reused by other applications, for example, enforcing that all user IDs be more 
than six characters), implement it in the business service. When the rule is specific to one 
specific application (for example, enforcing that user IDs for the Travel application start 
with the letter T), implement it in the Web application server. Usually, you will have a 
combination of rules in both locations.

Business Rules on the Browser
In general, when you implement business rules on the browser, you must custom code 
them for each HTML template. However, you can avoid this by creating a JavaScript 
function that gets included and invoked wherever it is needed. The “Example: Validating a 
Whole Form” on page 153 (in Chapter 7) demonstrates how to use JavaScript to implement 
business rules on the browser.
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Customization Techniques: Data
This section discusses a variety of customizations that concern processing data from a 
result set and presenting it on a page.

Formatting Fields
At the end of processing a request, all the data from the user’s result set that is to appear on 
a displayed HTML page is formatted into a WebEnterprise ResultSet object. To change the 
formatting of this data, use either of the following:

■ Page Handler customization: Formatting a field (Fields category)

See the customization list in “Page Handler Customization Wizard Customizations” on 
page 58.

■ Override handler method: FormatValue

This method is invoked on each field to be displayed. Parameters passed to it include 
the DataValue object to be displayed and the field’s field index and association ID. For 
information on field indexes and association IDs, see “Field Identification” on page 36.

Formatting Custom Fields
Custom fields are fields that you have added to the HTML template yourself. The generated 
application will not know about these fields; therefore, you have to add them to the 
WebEnterprise ResultSet object yourself. To do this, use either of the following:

■ Page Handler customization: Adding data for a custom field to a page (Fields category)

■ Override handler method: DisplayPage method

Add your data to the rset parameter. See A Guide to WebEnterprise for specifics on how 
to manipulate a ResultSet object like the rset parameter.

Decoding or Validating Fields
Processing a request from a Search, Update, or Insert form includes decoding the fields on 
the page that represent business class attributes. To change the format that data is 
accepted in these fields, or to perform data validation, use either of the following:

■ Page Handler customization: Decoding or validating a field (Fields category)

■ Override handler method: DecodeValue method

This method is invoked on each field. Parameters passed to it include the TextData 
object with the user-entered value and the field’s field index and association ID. For 
information on field indexes and association IDs, see “Field Identification” on page 36.
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Processing Custom Fields on an HTML Form Submission
The generated application will not know about fields you add to the HTML template 
yourself. You have to decode such custom fields from the WebEnterprise HTTPRequest 
object yourself. 

Processing an Insert or Update Form
To process values specified on an Insert or Update form, use either: 

■ Page Handler customization: Insert or Update (Database Operations category)

■ Override handler method: BeforeInsert or BeforeUpdate methods

Values will be found on the request parameter. See A Guide to WebEnterprise for 
specifics on how to manipulate an HTTPRequest object like the request parameter.

Processing a Search Form
There are two customization points you can use when processing custom fields on a Search 
form. 

If you want the custom fields to affect the generated query, then use either:

■ Page Handler customization: Search (Database Operations category)

■ Override handler method: BeforeSearch method

To change the way the request is processed, use either:

■ Page Handler customization: Search (Actions category)

■ Override handler method: DoSearch method
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Global Customization
You can add global customizations by subclassing directly from the ExpressHandlers 
project. Global customizations affect all classes generated from that point forward. You 
make global customizations when you wish to affect features throughout the application. 

You can add global customizations by creating a project that contains subclasses of specific 
classes in ExpressHandlers (the specific classes are listed below). Using options in the 
HTML Application Model Workshop, you specify that WebEnterprise Designer use these 
projects to provide the superclasses for the generated classes.

� To customize ExpressHandlers classes:

1 In the Repository Workshop, create a new project to contain your customized classes 
(CustomProject).

2 In the Project Workshop for CustomProject, choose the File > Supplier Plans command 
and add ExpressHandlers and HTTP as suppliers to the project.

3 Create subclasses of the following superclasses in CustomProject:

ExpressClassHandler
ExpressHTTPAccess
ExpressLogonHandler
ExpressLookupInfo
ExpressPageData
ExpressScanner
ExpressTestRunner
ExpressValueGenerator

4 Name each subclass with the same custom prefix (for example, “New,” as in 
NewClassHandler).

Each subclass must use the same suffix as its superclass. You must create subclasses of 
all eight of the above classes, even if you do not plan to customize all of them.

5 Using the Class and Method Workshops, add your customizations to any or all of these 
classes.

6 In the HTML Application Model Workshop, choose the File > Custom Generation 
Options command.

7 Enter your custom prefix name (for example, “New” in Step 4) in the Superclass Prefix 
for Global Customization property.

This property will initially be set to “Express.”

8 Click OK to apply your change and dismiss the dialog.

9 Choose File > Supplier Plans and add CustomProject as a supplier plan to the model.

Now when you generate code for the HTML application model, WebEnterprise Designer 
searches the supplier projects of the application and looks for classes with the prefix “New.” 
The generated HTML model classes will be subclasses of the CustomProject classes.

To use your customizations in future HTML application models, just perform steps 6-9, as 
described above.

Note Supplier plans added to the HTML application model will be added to the supplier plans 
for the generated project. These supplier plans are not automatically removed from the 
generated project if you remove the supplier plan as a supplier to the HTML application 
model. For example, if you change your model supplier plans to pick up customizations 
from a different project, then you must manually change the supplier plans in the 
generated project.
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Customizing Generated
HTML Templates
This chapter provides information on how to customize the HTML files generated from an 
HTML application model. These files are referred to as HTML templates.

HTML templates are .html files that contain embedded WebEnterprise tags. WebEnterprise 
Designer processes HTML templates to produce HTML documents displayed in a browser. 
Processing removes the tags, substitutes actual data values for dynamic data references, 
and sometimes includes other HTML templates.

Topics covered in this chapter include:

■ how WebEnterprise Designer uses HTML templates

■ what and where to customize (and what not to customize) in the HTML templates

■ how your customizations are preserved after regeneration

At the end of the chapter are two annotated, customized HTML files that illustrate 
principles of good customization.
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How WebEnterprise Designer Uses HTML Templates
When you generate code for an HTML application model, WebEnterprise Designer 
generates HTML templates into a subdirectory of the document root directory that has the 
same name as the HTML model. For example, the HTML templates for the HTMLtutApp 
tutorial reside in the %{FORTE_ROOT}/html/docs/HTMLtutApp directory.

The document root directory is the top-most directory of HTML template files used by 
WebEnterprise Designer, and is specified in a number of ways, the most common of which 
is with the FORTE_WW_DOCUMENT_ROOT environment variable. For more information 
on specifying the document root, see “Setting Document Root on the ScannerService 
Service Object Partition” on page 195.

For each logical page in the HTML application model, WebEnterprise Designer generates a 
set of related HTML templates to support it. These generated HTML templates are design-
specific, but some are common to all designs. 

Common Templates
This section describes the HTML templates common to all page designs, organized by 
different page types, including:

■ business class pages

■ link pages

■ logon pages

Business Class Page Templates
The following table lists the templates common to all business class pages. Templates you 
generally customize have a “Yes” in the Customize column.

The Main template (for example, Main_Customer.html in the HTMLtutApp application) 
has two main functions:

■ it is the template referenced by other pages

When a page calls another page, it references the URL of the Main template. The other 
templates are considered internal. 

■ it includes other templates as appropriate for the function being performed

If the function is to display data, the Main template includes the page’s Display 
template. The Display template in turn includes the Data template. If there are nested 
pages, the Display template includes the Data templates of all nested pages.

The Scripts template defines any JavaScript functions required by the page.

File Name Customize Description

Main_bus_class_page.html Usually not Top-level HTML definition of the page.

Data_bus_class_page.html Yes Provides the tags to be displayed for the page (but not nested 
data).

Display_bus_class_page.html No Display mode of the page, which includes data for this page 
and nested pages.

Insert_bus_class_page.html Yes Insert mode of the page.

Search_bus_class_page.html Yes Search mode of the page.

Update_bus_class_page.html Yes Update mode of the page.

Scripts_bus_class_page.html No Scripts for the page.
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Generated Maintenance Files and Directory

In addition to HTML templates, two text files are generated into the document directory 
that are used to keep track of important information regarding the generation:

A copy of the entire set of generated files is generated into the .base subdirectory, which 
maintains these copies throughout successive regenerations. See the section“Regenerating 
After Customizing” on page 76 for more details concerning the report.txt file and the .base 
directory.

Note You should not modify the files in the .base directory.

Lookup Files

When you specify drop list or radio list validation for a page’s field, you can also specify a 
Lookup class, and then further specify which of the class’s attributes is to be the displayed 
field and which is to be the field where user input is stored (the same attribute can serve as 
both). (For more information on setting up a drop or radio list, see the Forte online Help.)

For every field that uses validation, WebEnterprise Designer generates a file that contains 
the legal stored and displayed values:

If you specified a lookup class, then the lookup file is automatically populated from the 
database when the application starts. If you did not specify a Lookup class, then the file is 
generated without values and must be populated with data externally. In this case, you may 
use the Page Handler Customization Wizard to edit the file. Be sure to save a copy of this 
file, because it will be overwritten if you change the model and have to regenerate. 
Alternatively, you can populate this file at runtime.

For information on how to populate the generated file with data, see “Drop List or Radio 
List Example: Entering Lookup Information Manually” on page 161.

Start Page

The final file generated by WebEnterprise Designer is a start page for the application:

The start page allows the administrator to publish a simpler URL for the application.

Link Page Templates
If a link page is defined for the application, WebEnterprise Designer generates the following 
HTML templates:

File Name Customize Description

manifest.txt No Lists each generated file, one per line.

report.txt No Describes details of the generation with respect to the customization.

File Name Customize Description

bus_class_page_qq_field_name.inc Yes Contains stored and displayed values of the field.

File Name Customize Description

Start.html Usually not Defines a shortcut for a string used in deployment.

File Name Customize Description

Main_link_page.html No Top-level HTML definition of the page.

Display_link_page.html Yes Layout of the data display portion of the page.
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Logon Page Templates
If a logon page is defined for the application, WebEnterprise Designer generates the 
following HTML templates:

Page Design Templates
Different HTML templates are generated for different page designs. This section describes 
the template sets generated for two of the provided designs: simple and fancy. The other 
provided page designs (fancyMenu, fancyNoBorder, fancyNoCaption, and fancyNoFooter) 
are variations on the fancy page design. How they differ from the fancy page design will be 
made clear in the section on the fancy design.

Simple Page Design Templates
The simple page design creates a single HTML page and supports four modes of operation: 
search, display, insert, and update. When the current page is to be displayed in one of these 
modes, the Main template includes the template corresponding to that mode.

Files generated for the Simple page design are:

File Name Customize Description

Logon_logon_page.html Yes The page displayed when a non-validated user attempts access 
to any page in the application.

LogonFailed_logon_page.html Yes The page displayed when a user is denied access to the 
application.

Validate_logon_page.html No The page used to validate the logon. This page is never 
displayed; it redirects to the first page of the application or the 
logon failed page as appropriate.

File Name Customize Description

Main_bus_class_page.html Usually not Top-level HTML definition of the page.

Data_bus_class_page.html Yes Provides the tags to be displayed for the page (but not nested 
data).

Display_bus_class_page.html No Display mode of the page, which includes data for this page 
and nested pages.

Insert_bus_class_page.html Yes Insert mode of the page.

Search_bus_class_page.html Yes Search mode of the page.

Update_bus_class_page.html Yes Update mode of the page.

Scripts_bus_class_page.html No Scripts for the page.
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Fancy Page Design Templates
The fancy page design extends the simple design by using frames to divide the canvas into 
four sections:

■ a header frame at the top

■ a display frame in the middle divided into:

■ a menu frame on the left

■ a data frame on the right

■ a footer frame at the bottom

The header, footer, and menu are defined statically. The data frame contains dynamic data 
substituted in at runtime.

Files generated for the fancy design are:

Fancy Page Design Variations
All the other fancy page designs are based on the files just described, with certain 
modifications. These designs are:

■ fancyMenu has no header or footer templates

The Header_bus_class_page.html and Footer_bus_class_page.html templates are not 
included.

■ fancyNoBorder has no border around the panes

■ fancyNoCaption has no page titles

The fancy page design places a caption in the display pane over the data. The 
fancyNoCaption page design removes the caption and has only data. This is good for 
nested pages when the data is self-descriptive and needs no additional label.

■ fancyNoFooter has no footer template

The Footer_bus_class_page.html template is not included. The logo normally in the 
footer is moved to the upper right corner of the header.

File Name Customize Description

Main_bus_class_page.html Usually not Top-level HTML definition of the page.

Data_bus_class_page.html Yes Provides the tags to be displayed for the page (but not nested 
data).

Display_bus_class_page.html No Display mode of the page, which includes data for this page 
and nested pages.

Insert_bus_class_page.html Yes Insert mode of the page.

Menu_bus_class_page.html Yes Menu area for the page.

Search_bus_class_page.html Yes Search mode of the page.

Update_bus_class_page.html Yes Update mode of the page.

Header_bus_class_page.html Yes Header of the page.

Footer_bus_class_page.html Yes Footer of the page.

Scripts_bus_class_page.html No Scripts for the page.
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Customizing HTML Templates
You are free to make changes to the HTML templates generated by WebEnterprise 
Designer. You might want to customize the generated HTML for a variety of reasons, such 
as:

■ to change the font or other design elements

■ to change the layout or containment hierarchy

■ to add graphics or other HTML elements

WebEnterprise Designer allows you to customize any of the generated HTML templates; it 
preserves customizations during any subsequent generation of the HTML application 
model. This section describes how this process works, and gives guidance as to how to 
avoid damaging your HTML templates through customization.

Note If your customizations are limited to font and style changes, you should first look at 
creating custom page designs or styles, which is usually easier and more reusable. See 
Chapter 4, “Customizing Page Designs” and Chapter 5, “Customizing Page Styles,” for more 
information.

Customization Types
You can customize HTML templates for a single application or for many applications.

Single application When a specific change is required for an individual application, you 
generate the HTML templates and then customize one or more of them. This type of 
customization is the subject of this chapter.

Multiple applications When a change is required throughout one or more applications, 
you effectively create a custom page design. This type of customization is the subject of 
Chapter 4, “Customizing Page Designs.”

Where to Customize
In general, when you are customizing the Simple or Fancy page design, you will customize 
one of the page mode templates (data, search, insert, or update). 

Because there are separate templates for each mode of the logical page, it is possible to 
customize only a single mode. An example of this type of customization is when you do not 
want some field validations applied when the user is entering search criteria, but you do 
want them when the user is doing an insert or update. In this case, you would customize by 
removing the unwanted field validations from the page’s Search template.

If, on the other hand, you want to make changes in a single logical page, you must make 
the same changes to all the templates in the set.

You can customize the Main and Display templates, but there is usually no need to do so. 
An exception to this rule is when you want to affect the frame definition in the Fancy 
design (for example, by changing where the frame boundaries are, removing the header or 
the footer, and so forth). In that case, you might want to customize the Main template.

You might also want to customize the Header, Footer, and Menu templates of the Fancy 
design.

Within a template you can add, remove, or modify almost any of the normal HTML tags. 
The next section, “What Not to Customize,” offers guidelines on what to customize.
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What Not to Customize
There are some items you must leave alone when customizing HTML templates. 
WebEnterprise Designer templates are a combination of HTML tags, WebEnterprise tags, 
and plain text. The following table provides guidelines on customizing these three 
categories:

WebEnterprise tags WebEnterprise tags are HTML-like tags that start with “<?forte ...” and are usually 
embedded in an HTML comment, as in:

Note In this manual, as in A Guide to WebEnterprise, the tags are referred to in text in 
abbreviated form (for example, “the FORTE EXECUTE tag”), while the actual syntax 
requires a preceding question mark (as above). For a full description of Forte HTML tag 
syntax, see A Guide to WebEnterprise 

WebEnterprise variables WebEnterprise variables are plain text starting with “$$” and usually enclosed by 
parentheses, as in:

WebEnterprise variables are described in “WebEnterprise Designer HTML Template 
Elements” on page 41.

Hidden fields When customizing HTML templates, you must never remove or modify any hidden fields 
on forms. Hidden fields are identified with “HIDDEN” for input type, such as:

Type of Item Modify or Add Move Remove

HTML tags Always OK Usually OK Usually OK

Plain text Always OK Usually OK Usually OK

WebEnterprise tags Never OK Never OK Never OK

WebEnterprise variables Add OK OK OK

<!--<?forte iterate listentry entry.list_Movie start="1" max="1">-->

$$(listentry.Movie_qq_MovieID)

<input type="HIDDEN" name="ServiceName" value="movieService">
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Regenerating After Customizing
You will usually regenerate the HTML application model after you have made 
customizations to the HTML templates. When you do this, new HTML templates are 
generated. Your customizations are preserved in one of three ways: 

■ by keeping the customized file in preference to overwriting the newly-generated one

■ by merging the customized file with the newly-generated one (when this can be done 
without conflicts)

■ by merging the customized file with the newly-generated one, but leaving the 
customization commented out

Forte reports on what happened to each file during the regeneration by means of the 
report.txt file. The following scenarios describe the details of this process.

Scenario 1: HTML Changes Only
Consider the circumstance in which you have completely finished your model and decide 
to change one or more HTML templates. Perhaps you wish to change the background color 
of all the templates, or you might want to use a different font for several labels.

HTML template change Changes to colors, fonts, and so forth, on certain templates

HTML model change No changes that affect those pages

HTML code generation change Forte compares the newly-generated pages 
corresponding to the changed pages to the equivalent pages in the Base Level directory 
(the .base directory). It finds no differences between the new pages and the Base Level page 
equivalents. It leaves the Top Level pages unchanged (the HTML changes are preserved). 
The template is listed by name in the report.txt file, along with any other templates that fall 
into this category, following the heading:

In addition, the count of files treated in this way will be listed at the end of the report.txt 
file.

Scenario 2: HTML and Model Changes
Now consider the circumstance in which you have changed one or more HTML templates, 
and now you change the model. 

HTML template change Changes to colors, fonts, and so forth, on certain pages

HTML model change Attributes added or removed, links added or removed, both field 
and command labels edited

HTML code generation change Forte compares and finds differences between the new 
templates and equivalent templates in both the Base Level directory, and detects user 
modifications in the Top Level files. Forte merges the new model changes with the HTML 
changes. Base Level files are updated to reflect the new HTML model. The template is listed 
by name in the report.txt file, along with any other templates that fall into this category, 
following the heading:

NOTE: The following files had user customizations but no model changes. 

The user customizations have been left. No changes are needed.

WARNING: The following files had user customizations and model changes

but were merged without conflicts. The previously generated file (i.e.,

the root ancestor) is left in <fileName>.old. The user customized

file based upon the previous generation is left in <fileName>.cust. The

generated file from the current generation before merging is left in 
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In addition, the count of files treated in this way are listed at the end of the report.txt file. 
Pre-merged files are preserved and the following files are generated:

■ htmlTemplate.old files—old Base Level files (not merged)

■ htmlTemplate.cust files—old Top Level files (with HTML customizations, not merged)

■ htmlTemplate.gen files—Newly-generated files (not merged)

■ htmlTemplate.html files—Newly-generated files with user customizations merged in

Scenario 3: Conflicting HTML and Model Changes
Now consider the circumstance in which you have changed one or more HTML templates, 
and also changed the model in some conflicting way. For example, perhaps you changed all 
Part Number labels to “Part No” in the model, but to “PN” in the HTML files.

HTML template change Changes to labels

HTML model change Changes to labels, but different from the HTML changes

HTML code generation change Forte compares and finds differences between the new 
templates and equivalent Base Level templates and detects user modifications in the Top 
Level templates. Forte attempts to merge the files, but because there are conflicting 
changes, the merge results in an error. The template is listed by name in the report.txt file, 
along with any other templates that fall into this category, following the heading:

The count of files treated in this way are listed at the end of the report.txt file, and the same 
files are generated as listed in “Scenario 2: HTML and Model Changes.”

After generation an error dialog alerts the user to the presence of merge conflicts and 
directs the user to the report.txt file. The conflicts are indicated in the .html file with blocks 
of text as shown below:

The first comment line points out the conflict block. The generated text follows as regular 
HTML. The second comment line introduces a comment block that ends only the end of 
the user-customized block (that is, the user-customized HTML is left in the file as a 
comment).

<fileName>.gen. The merged file is left in <fileName>.html.  No changes 

are needed but you may wish to inspect the file to confirm that the

merge produced the desired result.

ERROR: The following files had user customizations and model changes 

that were merged with conflicts. These files will need to be reconciled.

The previously generated file (i.e. the root ancestor) is left in

<fileName>.old. the user customized file based upon the previous

generation is left in <fileName>.cust. The generated file from the

current generation before merging is left in <fileName>.gen. The

merged file is left in <fileName>.html with comments surrounding the

conflicting lines. These conflicts will need to be resolved manually.

<!-- >>>>>> BEGIN CONFLICT BLOCK -- GENERATED TEXT: -->

... generated information ...

<!-- ====== CUSTOMIZED TEXT: (left as comment)

... example of user-entered information ...

<!-- <<<<<< END CONFLICT BLOCK -->
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Customization Examples
This section contains two examples that illustrate where to put certain customizations, and 
what you should not modify or, in some cases, delete or even move.

The examples are:

■ “Example: Customizing a Field on a Search Page,” which follows

This customization shows how to remove a JavaScript validation from a Search page and 
replace it with a simple input field. This example is fully described in Chapter 7, 
“Customization Examples.” 

■ “Example: Customizing a Font Size on a Data Page” on page 81

This customization shows how to make the font of a field on a Data page two points and 
bold.

Conventions Used with the Examples
In these examples, the following conventions are followed:

■ bolded lines are customized lines

■ unshaded lines are lines that should not be modified

Unless otherwise noted, you can delete or comment out the unshaded lines (or move 
the whole block containing the line), but you should not edit the text of the code.

For a description of WebEnterprise variables and HTML URL parameters and links, see 
“WebEnterprise Designer HTML Template Elements” on page 41.
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Example: Customizing a Field on a Search Page
This example shows a sample Search page from the tutorial application (HTMLtutApp), 
which was customized to apply an IsAlphabetic validation to the Customer Name field of 
the Customer page. This validation was inconvenient for the Search page, where the user 
might want to use a wildcard. Therefore, on this Search page, the validation has been 
commented out and a simple input field inserted. 

This customization is described in “Example: Removing a JavaScript Validation from a Page 
Mode” on page 147.

<!-- Forte WebEnterprise Designer Search form definition for model 

HTMLtutApp using page design fancy and style cool.  Generated 
on 

20-Feb-1999 13:05:14 -->

<!--<?forte if CustomerHandler.RestrictSearchAccess>-->

<!--<?forte redirect "HTMLtutApp/AccessError.html&PageName=Customer

&PageMode=Search">-->

<!--<?/forte if>-->

<html>

<head>

<title>

Search Customer

</title>

<link href="/forte/styles/cool.css" rel="stylesheet" 
type="text/css">

</head>

Do not move or delete. <!--<?forte include "HTMLtutApp/Scripts_Customer.html">-->

<body class="modify">

<caption align="left">

<div class="captionform">

Find Customer

</div>

</caption>

<form method="POST" action="$$(FORTE.ExecURL)">

Do not move or <input type="HIDDEN" name="ServiceName" 
value="HTMLtutAppService">

edit these <input type="HIDDEN" name="TemplateName" 
value="$$(FORTE.ReturnTemplate)">

lines. <input type="HIDDEN" name="Action" 
value="CustomerHandler.Search">

<br>

<table  border="0" cellspacing="3" cellpadding="5">

<tr>

<th class="labelmodify" style="width:20%">

Customer Number

</th>

<td class="dataform" style="width:80%">

<input type="text" name="Customer_qq_CustomerNumber" 
size=40>

</td>
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</tr>

<tr>

<th class="labelmodify" style="width:20%">

Name

</th>

<td class="dataform" style="width:80%">

Start comment. <!--

Call to <script language="JavaScript">

JavaScript Select_Customer_qq_Name(’Customer_qq_Name’,’Name’,’qqNone’);

validation. </script>

End comment. -->

Add input field. <input type="text" name="Customer_qq_Name" size=40>

</td>

</tr>

<tr>

<th class="labelmodify" style="width:20%">

Address

</th>

<td class="dataform" style="width:80%">

<input type="text" name="Customer_qq_Address" size=40>

</td>

</tr>

<tr>

<th class="labelmodify" style="width:20%">

Phone

</th>

<td class="dataform" style="width:80%">

<input type="text" name="Customer_qq_Phone" size=40>

</td>

</tr>

</table>

<br>

<br>

<table border="0" width="1" cellspacing="3" cellpadding="5">

<tr>

<td class="buttons">

<INPUT TYPE="submit" VALUE="SEARCH">

</td>

</tr>

</table>

</form>

</body>

</html>
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Example: Customizing a Font Size on a Data Page
This next example is a sample Data page from the Movie application provided in the 
WebEnterprise examples directory. This example shows how you would make the Movie 
field a larger font than the default and also bold, rather than regular.

<!-- Forte WebEnterprise Designer Display form definition for model 

movieApp using page design fancy and style cool. Generated on 

16-Feb-1999 22:50:51 -->

Do not move this line. <!--<?forte iterate listentry entry.list_Movie start=”1” max=”1”>-->

Begin data display. <table width=”100%” border=”0” cellspacing=”3” cellpadding=”5”>

<caption align=”left”>

<div class="captionform">

Movie

</div>

</caption>

<tr>

Start definition of Movie field. <th class="labelform" style="width:20%">

MovieID

</th>

<td class="dataform" style="width:80%">

Begin modification. <font size="+2"> <bold>

$$(listentry.Movie_qq_MovieID)

End modification. </bold> </font>

</td>

End definition of Movie field. </tr>

Start definition of Title field. <tr>

<th class="labelform" style="width:20%">

Title

</th>

<td class="dataform" style="width:80%">

$$(listentry.Movie_qq_Title)

</td>

End definition of Title field. </tr>

Start definition of Rating field. <tr>

<th class="labelform" style="width:20%">

Rating

</th>

<td class="dataform" style="width:80%">

$$(listentry.Movie_qq_MPRating)

</td>

End definition of Rating field. </tr>

Start Critic Rating field. <tr>
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<th class="labelform" style="width:20%">

Critic Rating

</th>

<td class="dataform" style="width:80%">

$$(listentry.Movie_qq_CriticRating)

</td>

End Critic Rating Field </tr>

Start Description field. <tr>

<th class="labelform" style="width:20%">

Description

</th>

<td class="dataform" style="width:80%">

$$(listentry.Movie_qq_Description)

</td>

End Description field. </tr>

Start Web Address field. <tr>

<th class="labelform" style="width:20%">

Web Address

</th>

<td class="dataform" style="width:80%">

$$(listentry.Movie_qq_webaddress)

</td>

End Web Address field. </tr>

End data display table. </table>

Do not move this line. <?forte if $$(USER.TopPage)Handler.IsNestedPage(PageName="Movie")>

Begin commands for nested <table width="40%" align="center"  border="0" cellspacing="3" 

page (because they can not cellpadding="5">

appear in the command <tr>

panel of the main page). <td>&nbsp&nbsp&nbsp</td>

Begin Search command. <td>

<a class="alink" 
HREF="$$(FORTE.ExecURL)?ServiceName=movieAppService&TemplateName=mov
ieApp/Search_Movie.html&ReturnTemplate=movieApp/Display_$$(USER.TopP
age).html&Uniquifier=$$(FORTE.UniqueID)" target="_fortedisplay">

Search</a>

End Search command. </td>

<br>

<td>&nbsp&nbsp&nbsp</td>

Begin Update command. <td>

<?forte if MovieHandler.HasCurrentRow>

<a class="alink" 
HREF="$$(FORTE.ExecURL)?ServiceName=movieAppService&TemplateName=mov
ieApp/Update_Movie.html&ReturnTemplate=movieApp/Display_$$(USER.TopP
age).html&Uniquifier=$$(FORTE.UniqueID)&Action=MovieHandler.Current" 
target="_fortedisplay">
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Update</a>

<?forte else>

Update

<?forte if>

End Update command. </td>

<td>&nbsp&nbsp&nbsp</td>

Begin Insert command. <td>

<a class="alink" 
HREF="$$(FORTE.ExecURL)?ServiceName=movieAppService&TemplateName=mov
ieApp/Insert_Movie.html&ReturnTemplate=movieApp/Display_$$(USER.TopP
age).html&Uniquifier=$$(FORTE.UniqueID)" target="_fortedisplay">

Insert</a

End Insert command. </td>

<td>&nbsp&nbsp&nbsp</td>

Begin Delete command. <td>

<?forte if MovieHandler.HasCurrentRow>

<script language="JavaScript">

function confirm_delete(that,url,action)

{

ret = confirm("Delete this record?");

if (ret)

that.href = url + action;

else {

that.href = url;

}

}

</script>

<a class="alink" HREF="#1" 
NAME="1"onclick="confirm_delete(this,’$$(FORTE.ExecURL)?ServiceName=
movieAppService&TemplateName=movieApp/Display_Movie.html&ReturnTempl
ate=movieApp/Display_$$(USER.TopPage).html&Uniquifier=$$(FORTE.Uniqu
eID)’,’&=ActionMovieHandler.Delete’)" target="_fortedisplay">

Delete</a>

<?forte else>

Delete

<?forte if>

End Delete command. </td>

<td>&nbsp&nbsp&nbsp</td>

Begin First command. <td>

<a class="alink" 
HREF="$$(FORTE.ExecURL)?ServiceName=movieAppService&TemplateName=mov
ieApp/Display_$$(USER.TopPage).html&Action=MovieHandler.First&Uniqui
fier=$$(FORTE.UniqueID)"target="_fortedisplay">

First </a>

End First command. </td>

<td>&nbsp&nbsp&nbsp</td>

Begin Previous command. <td>

<a class="alink" 
HREF="$$(FORTE.ExecURL)?ServiceName=movieAppService&TemplateName=mov
ieApp/Display_$$(USER.TopPage).html&Action=MovieHandler.Previous&Uni
quifier=$$(FORTE.UniqueID)" target="_fortedisplay">
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Previous </a>

End Previous command. </td>

<td>&nbsp&nbsp&nbsp</td>

Begin Next command. <td>

 <a class="alink" 
HREF="$$(FORTE.ExecURL)?ServiceName=movieAppService&TemplateName=mov
ieApp/Display_$$(USER.TopPage).html&Action=MovieHandler.Next&Uniquif
ier=$$(FORTE.UniqueID)" target="_fortedisplay">

Next </a>

End Next command. </td>

<td>&nbsp&nbsp&nbsp</td>

Begin Last command. <td>

 <a class="alink" 
HREF="$$(FORTE.ExecURL)?ServiceName=movieAppService&TemplateName=mov
ieApp/Display_$$(USER.TopPage).html&Action=MovieHandler.Last&Uniquif
ier=$$(FORTE.UniqueID)"target="_fortedisplay">

Last </a>

End Last command. </td>

<?forte if MovieHandler.HasCurrentRow>

<td>&nbsp&nbsp&nbsp</td>

<td>

<form method="POST" action="$$FORTE.ExecURL" 

target="_fortedisplay">

<input type="HIDDEN" name="ServiceName" 

value="movieAppService">

<input type="HIDDEN" name="TemplateName"

value="movieApp/Display_$$(USER.TopPage).html">

<input type="HIDDEN" name="Action" 
value="MovieHandler.Goto">

<input type="submit" VALUE="Go to">

<input type="text" name="Position" size=5>

</form>

</td>

<?/forte if>

</tr>

End nested command panel. </table>

Do not move this line. <?/forte if>

<table border="0">

<tr>

<th>

Displays requested row. <div id="reqstatus">$$(entry.RequestStatus_Movie)</div>

</th>

</tr>

</table>

Do not move this line. <!--<?/forte iterate listentry>-->
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Customizing Page Designs
WebEnterprise Designer contains a set of page designs—simple, fancy, and several 
variations of fancy—that represent several common Web page layouts. You use these to 
determine the layout of pages in your WebEnterprise Designer applications.

This chapter provides information on WebEnterprise Designer page designs and how to 
customize them, including:

■ the internal structure of page designs

■ strategies and considerations for customizing page designs

■ a customization example

For information on WebEnterprise Designer styles and how to customize them, see 
Chapter 5, “Customizing Page Styles.”
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About Page Designs, Templates, and Pages
The production of a Web page by WebEnterprise Designer involves a number of steps and 
several intermediate representations of the page. The ultimate source that determines the 
layout the Web page when it is displayed in a browser is the page design.

Page designs determine:

■ whether HTML frames are used

■ whether headers and footers are displayed

■ how navigation menus are represented

■ the basic structure of all documents

The scope of a page design is the entire Forte installation. Changes to a design affect every 
HTML application that is subsequently generated from it. Designs reside in subdirectories 
of the Forte Express installation, under the ${FORTE_ROOT}/userapp/express/clx/designs 
directory.

Page Designs and Web Page Production
WebEnterprise Designer uses the following steps to render an HTML page:

1 When the page is defined in the HTML Application Model Workshop it is associated 
with a page design. 

This design specification is fundamentally a pointer to a directory. For example, when 
you specify that the application will use the simple design, this directs WebEnterprise 
Designer to use the files in the ${FORTE_ROOT}/userapp/express/clx/designs/simple 
directory for generation.

2 When you generate code for the HTML Application, the metadata for each page in the 
model, as well as the model itself, is input to the HTML Template Generator.

The metadata, as defined in the HTML Application Model, includes attributes that the 
generator uses to determine:

■ which HTML templates to generate 

■ the effect of Code Generation Directives within the design files

The output of this phase is a set of application-specific HTML templates stored under 
the HTML document root directory. (For information on the HTML document root and 
its setting, see “Setting Document Root on the ScannerService Service Object Partition” 
on page 195.)

3 When you run the HTML Application, the client requests a particular HTML template, 
which the WebEnterprise runtime system reads and scans for WebEnterprise template 
directives. 

The directives represent both methods to be called and references to dynamic 
application data. WebEnterprise resolves these references, substitutes data into the 
template, and returns a “pure HTML” document to the Web server and the user’s 
browser screen.
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When to Customize Page Designs
Sometimes you might want to customize an application’s generated HTML template. Such 
a customization affects only that one page in that particular application. This type of 
customization is covered in Chapter 3, “Customizing Generated HTML Templates.” If, 
however, your company wants all of its Web applications to possess a similar structure and 
“look and feel,” you can best accomplish this with WebEnterprise Designer by creating a 
custom page design, to be used as the basis for pages in all applications.

Creating a custom design is, however, not a trivial task. Designs contain a mixture of code 
generation directives, WebEnterprise template directives, and HTML. You must take care to 
ensure that changes to page designs result in valid HTML pages. This chapter offers 
guidelines and examples that will help you create custom designs.
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Page Design Elements and HTML Template Generation
When you generate an HTML application, Forte first generates the TOOL project and its 
contents, and then creates the required HTML templates. During the generation of HTML 
templates, the Forte generator processes each component of the HTML model sequentially, 
in the following order:

■ the model object itself 

■ each page defined in the model

■ any input validations or output-formatting JavaScript procedures

Design files are the main tools used to process the pages of the HTML model. Not only do 
the contents of the files direct the processing, but the file names themselves play a role in 
the process. 

This section begins with a description of the elements of page design file names, followed 
by a description of the functions of code generation directives that are the contents of the 
files.

Page Design File Names and Selectors
Design file names (that is, the names of files that reside in the specific design directory) 
play a crucial role in HTML template generation. Design file names have two important 
functions:

■ determining which design files are selected for generation

■ defining the names of the generated HTML template files

For a description of generated templates, refer to “How WebEnterprise Designer Uses 
HTML Templates” on page 70.

The best way to understand the design filename structure is to use an example, in this case, 
the fancy page design files, found in ${FORTE_ROOT}/userapp/express/clx/designs/fancy. 
The following sections describe each file in this directory, including descriptions of the 
different elements of the filenames. These elements are called selectors, because they select 
elements of the application.

_RC_IsAabModel_Start.html
_RC_IsAabModel_AccessError.html

These files select the Start and AccessError pages for processing. The selectors are:

Selector Use

IsAabModel Refers to the entire model and selects the file for generation.

_RC_ Refers to one component (rather than an array of components to be iterated); thus, 
every generated model results in a Start.html and AccessError.html template file.

Start Selects the Start page, which is the page users normally request when they enter the 
application, and which redirects them to the application’s starting page, as defined in 
the model.

AccessError Selects the page that is returned if the application is customized to restrict access to 
certain pages and that access is denied.

For information on customizing security in HTML applications, see Chapter 8, 
“Customizing Application Security.”
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_RC_IsFormWindow_Data__RR_Name_.html
_RC_IsListWindow_Data__RR_Name_.html

These files select each form and list page in the application for processing. The selectors 
are:

_RC_IsDataWindow_Main__RR_Name_.html
_RC_IsDataWindow_Header__RR_Name_.html
_RC_IsDataWindow_Footer__RR_Name_.html
_RC_IsDataWindow_Menu__RR_Name_.html
_RC_IsDataWindow_Display__RR_Name_.html
_RC_IsDataWindow_Search__RR_Name_.html
_RC_IsDataWindow_Insert__RR_Name_.html
_RC_IsDataWindow_Update__RR_Name_.html

These files select all data pages for processing. The selectors are:

Selector Use

_RC_ Refers to one component (rather than an array of components to be iterated).

IsFormWindow Selects the form pages in the model.

IsListWindow Selects the list pages in the model.

Data Selects the Data template, which governs the layout and display of a page’s data, 
whether the page is the only page displayed, a master page, or a detail page.

_RR_Name_ Is replaced by the name of the page in the model, for example, a list page named 
Customer generates a template file named Data_Customer.html.

Selector Use

_RC_ Refers to one component (rather than an array of components to be iterated).

IsDataWindow refers to Data pages. Each Data page (which includes both form and list pages) 
generates templates from each of these design files.

_Main_ The fancy design employs HTML frames in which the Main file defines the frame layout.

_Header_ Defines the frame positioned across the top of the page.

_Footer_ Defines the frame positioned across the bottom of the page.

_Menu_ Defines the frame on the left side of the page.

_Display_

_Search_

_Insert_

_Update_

Defines the large center frame, depending upon the page mode.

_RR_Name_ Is replaced by the name of the page in the model, for example, a list page named 
Customer generates a template file named Menu_Customer.html.
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_RC_IsLinkWindow_Main__RR_Name_.html
_RC_IsLinkWindow_Display__RR_Name_.html

These files select link pages for processing. The selectors are:

_RC_HasJavaScripts_Scripts__RR_Name_.html

This file defines the scripts file. The selectors are:

_RI_LookupFields_UniqueName_.inc

The file defines input validation lookup fields. Lookup template files are generated for 
each input validation lookup field defined in the application. The selectors are:

Note The files produced by code generation are merely “stubs,” without any of the actual Express 
Business Class data. When the application is actually executed, the database is queried and 
the actual lookup files are created and written to the application’s HTML template 
directory.

Selector Use

_RC_ Refers to one component (rather than an array of components to be iterated).

IsLinkWindow Selects link pages. Each link page generates two HTML templates.

_Display_ Defines the page that displays the link page (for example, the Display_Home.html 
template for the Home page in the HTMLtutApp tutorial).

_Main_ Defines a shorthand page that simply includes the Display page (in the same 
application, the Main_Home.html template).

_RR_Name_ Is replaced by the name of the page in the model, for example, a list page named 
Customer generates a template file named Main_Customer.html.

Selector Use

_RC_ Refers to one component (rather than an array of components to be iterated).

HasJavaScripts Selects each page that has a JavaScript script defined for it. There are two types of 
scripts: input validation scripts and output-formatting scripts.

Scripts Defines the page that displays the link page (for example, the Display_Home.html 
template for the Home page in the HTMLtutApp tutorial).

_RR_Name_ Is replaced by the name of the page in the model, for example, Scripts_Customer.html.

The specified JavaScript files are included by the Scripts_Customer.html file.

Selector Use

_RI_ Refers to an array of components. It is iterated, with each element’s _UniqueName_ 
attribute forming an output file.

LookupFields Refers to the lookup attributes defined for the validation.

_UniqueName_ Refers to the unique naming scheme of the lookup field’s file name 
(pagename_qq_field).
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Page Design Code Generation Processing
Page design files contain a mixture of code generation directives, WebEnterprise HTML 
template tags, and standard HTML V4.0 tags. When you generate code for an HTML 
application, the code generator selects and processes design files (as described in “Page 
Design File Names and Selectors” on page 88). This processing involves two activities that 
result in an HTML template:

■ code generation attribute references are replaced with the actual values of those 
attributes 

■ code generation conditional and looping directives are executed

All code generation attributes and directives are enclosed within a pair of “curly braces” 
(for example, {{attributes-and-directives}}). The code generator scans the page design file 
for these and then processes the enclosed directive. The code generation processor 
essentially has access to all attributes and properties that are defined within the HTML 
application model. For example, consider the following lines in the 
_RC_IsDataWindow_Display__RR_Name.html file:

These lines direct the code generator to fetch (%R) the current page object and print (%P) 
its Name attribute. The result could be:

This example illustrates the simplest of code generation directives; many are much more 
involved. The most powerful directives are those involving conditional and looping logic. 
These directives span multiple lines and, in the case of page design files, surround blocks of 
HTML template tags, HTML tags, and other code generation directives. 

Consider this block from _RC_IsListWindow_Data__RR_Name.html:

This code block contains the following notable items:

■ The code generation directives are enclosed within standard HTML 4.0 comments (that 
is, “<!-- comment -->”). 

This means that page design files can be edited with standard HTML editors.

■ The “%F(NestedLinks)[“ directive on the first line actually is not completed until the 
closing “]” on the last line. 

The effect of this block is to iterate through all (if any) of the nested links defined for the 
ListWindow, reproducing the lines between the <center> and </center> HTML tags. 

<title>

Display {{%R(page)[%P(Name)]}}

</title>

<title>

Display Movies

</title>

<!--{{%F(NestedLinks)[}}-->

<center>

<table width="80%" cellspacing="3" cellpadding="5" 
align="CENTER">

<!--<?Forte include 

 
"{{%R(page)[%E(Parent)[%P(Name)]]}}/Data_{{%E(Node)[%P(Name)]}}.htm
l">-->

</table>

</center>

<!--{{]}}-->
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The generated HTML template block might be:

Guidelines for Customizing Code Generation Directives
The general rule is: do not customize code generation directives! Code generation 
directives are complex entities and not easily modified. However, if you understand the 
purpose of a code generation directive, it may be possible to move or delete it. Take great 
care to identify the entire scope of a directive and deal with it as a whole, rather than 
treating a block within curly-braces as a unit.

If your customization requires change or movement of code generation directives, the best 
practice is to make incremental changes, regenerate the application, compare the new 
HTML templates with the old and, if acceptable, continue.

<center>

<table width="80%" cellspacing="3" cellpadding="5" 
align="CENTER">

<!--<?Forte include "Movie/Data_Showings.html">-->

</table>

</center>

<center>

<table width="80%" cellspacing="3" cellpadding="5" 
align="CENTER">

<!--<?Forte include "Movie/Data_Reviews.html">-->

</table>

</center>
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Example: Customizing a Page Design
In page design customizations, the most important consideration is whether the design will 
use HTML frames and, if so, what that frame layout will be. Begin your customization by 
selecting the existing design that most closely matches the new design you wish to create. If 
your design is not based on frames, use the simple design as a starting point. If your design 
is to be frame-based, use fancy or one of its variants.

This section illustrates techniques for creating customized page designs with an example 
that creates a design that does not use frames, but achieves a framelike appearance by 
using HTML tables. This design consists of two panes: one for the display of data, the other 
for a menu. We will name the design “brilliant.”

The remainder of this chapter describes how to create the brilliant page design. We will not 
describe every detail of the complete customization, but only the first major part of it, and 
then give guidelines for the rest. We will generate the HTMLtutApp tutorial application 
with the newly-created brilliant design.

� The general steps for creating a customized page design are:

1 Create a new design directory for the design files and populate it with copies of files of 
the closest style.

2 Create the bitmap and text that identify and describe the design in the HTML 
Application Model Wizard.

3 Clear the Document Directory of all existing generated HTML templates.

This is to prevent the code generator from merging the customizations with existing 
designs.

4 Make the necessary customizations.

In this simple example, we describe how to customize the display of form pages.

5 Generate the HTML and inspect it for errors.

6 Fine-tune the customized design.

Step 1. Create a New Design Directory
This section describes how to create a directory for the new design and how to populate it.

� To create and populate a new design directory:

1 Create a brilliant directory under the ${FORTE_ROOT}/userapp/express/clx/designs 
directory.

2 Copy all the files in ${FORTE_ROOT}/userapp/express/clx/designs/simple to the new 
brilliant directory.

Use the simple directory files as a starting point, because simple is not frame-based, 
and therefore closest of all the available designs to our proposed design. 
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Step 2. Identify the Design with a Bitmap and Text 
Two files within the design directory serve to identify the design in the Page Design 
Properties dialog:

■ a bitmap image of a thumbnail picture of a page created with the design

■ a brief textual description of the design

(You access the Page Designs properties dialog by clicking the Page Design browser button 
on either the HTML Application Properties dialog or on the Page Options page of the Page 
Wizard.)

For our example, even though the definition of the simple design is closest to the brilliant 
design, we want it to look more like the fancyMenu design. Therefore, we will use the 
fancyMenu bitmap for our image identifier. The identifiers of the fancyMenu design are 
shown in Figure 18:

Figure 18 Page Design Identifiers

� To identify a page design:

1 Copy the fancyMenu.bmp file from the fancyMenu directory to the brilliant directory.

2 Rename the fancyMenu.bmp file brilliant.bmp.

3 Create a text file named brilliant.txt in the brilliant directory.

4 Add the following text to the brilliant.txt file:

5 Save and close the brilliant.txt file.

Bitmap image of design

Textual description of design

A design using tables with two panes: menu and display.  The 
display 

pane has a caption followed by data.  Commands are placed in the 
menu.
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Step 3. Clear Existing Generated HTML Templates
WebEnterprise Designer’s HTML template generator is designed to identify and merge 
customizations made to the HTML templates. However, the process of customizing a page 
design not only defeats the generator’s merge logic, but can result in a large number of 
spurious errors. Therefore, before generating an HTML application that uses a modified 
page design, first delete the entire contents of the application’s HTML template directory.

� To clear generated HTML templates:

1 Delete the ${FORTE_ROOT}/html/docs/HTMLtutApp subdirectory.

This includes the .base subdirectory.

2 During the customization process, each time you modify a design used by an HTML 
application, clear the old generated HTML templates before generating a new set.

Once the design is stable, you can omit this step.

Step 4. Customize the Design Files
Depending upon the nature of the customization, this step can be straightforward or 
extremely complex. For example, removing the caption from the main pane is a simple 
customization that requires only that you delete several lines from each design file that 
displays captions (the Display, Update, Insert, and Search files).

In this section, you will customize the display of form pages. This is only the first part of the 
task of customizing an entire design. Customization of the other parts of this page design is 
left as an exercise for the reader.

To customize the display of form pages, you will:

1 Extract the navigation menu block from the form’s Data design file.

2 Place the extracted menu block in a new Menu file.

3 Modify the DataWindow Display design file, defining the pane table structure, and 
including the new Menu design file.

Step 4.1. Remove the Menu From the Data File
If you compare the list of files in the simple design directory with that of the fancy design 
(and its variants), you will notice that, unlike the fancy designs, simple has no Menu file 
(_RC_IsDataWindow_Menu__RR_Name_.html). This is because the navigation menu for 
the simple design is in the Data file (the _RC_IsFormWindow_Data__RR_Name_.html file). 

In this example, you will create a Menu file for the brilliant design. One way to do this is to 
take the menu block from the Data file and put it into a Menu file that you create. But this 
menu is not in the correct form. The simple menu is a horizontal line of menu items placed 
immediately below the form data. Our new design is modeled on the fancy design family, 
where the menu is a vertical array of items. 
Chapter 4Customizing Page Designs



Example: Customizing a Page Design96
Figure 19 Menu in simple and fancyMenu Designs

Therefore, you can either modify the simple menu block so that it creates a vertical menu, 
or, you can take advantage of the existing fancyMenu menu, which is already vertically 
aligned. In this example, we will use the second option, because the fancyMenu menu is 
closer to what we need.

First, however, you must remove the menu block from the 
_RC_IsDataWindow_Menu__RR_Name_.html file.

� To remove the menu block from the data file:

1 Open the _RC_IsFormWindow_Data__RR_Name_.html file in a text editor.

2 Find this menu block:

3 Remove this entire block from the file.

4 Save and close the _RC_IsFormWindow_Data__RR_Name_.html file.

simple Design fancyMenu Design

Menu

<table width="40%" align="center"  border="0" cellspacing="3" 

cellpadding="5">

<tr>

<!--{{%F(HTMLCommands)[}}-->

<!--{{%T(IsNext)[}}-->

<td>&nbsp&nbsp&nbsp</td>

.

.

.

{{%P(Label)}}</a>

</td>

<!--{{]}}-->

<!--{{]}}-->

</tr>

</table>
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Step 4.2. Modify the Menu Design File
In this section, you will create a Menu file for the brilliant design by copying the Menu file 
from the fancyMenu directory to the brilliant directory. You will then change the file from 
an HTML frame to an included part of a frameless page. This requires two changes. You 
will:

■ strip off all lines at the top and bottom that are required for frames

■ eliminate all the frame-related “target” attributes

� To create and modify the Menu design file:

1 Copy the _RC_IsDataWindow_Menu__RR_Name_.html file from the fancyMenu design 
directory and paste it in the brilliant directory.

2 Open the _RC_IsDataWindow_Menu__RR_Name_.html file in a text editor.

3 Strip off lines at the top and bottom that are required for frames.

Include everything from the first line through the <body> tag at the top, and the 
</body> and </html> tags from the end of the file. 

Remove the bolded lines:

4 Eliminate all the “target=”_fortedisplay” attributes on the menu’s anchor tags (<A>). 

These are all frame-related and will have unpleasant effects in a frame-less application. 
For example, remove the bold text from all lines like this:

5 Save and close the _RC_IsDataWindow_Menu__RR_Name_.html file.

<!-- Forte WebEnterprise Designer Menu form definition for model

{{%T(IsAabModel)[%P(Name)]%O[%E(Parent)[%P(Name)]]}} using page 

design fancyMenu and style {{%P(HTMLStyle)}}. Generated on 

20-Feb-1999 13:06:17 -->

<!--{{%A(page)}}-->

<!--<?forte assign USER.TopPage="{{%R(page)[%P(Name)]}}">-->

<html>

<head>

<link href="/forte/styles/{{%R(page)[%P(HTMLStyle)]}}.css"

rel="stylesheet" type="text/css">

</head>

Note this line for later <body class="menu">

<p class="captionmenu">

{{%R(page)[%P(Name)]}} Menu:

</p>

.

.

.

</body>

</html>

<a class="amenu" HREF="$$(FORTE.ExecURL)?ServiceName={{%R(...

&Uniquifier=$$(FORTE.UniqueID)" target="_fortedisplay">

{{%P(Label)}}</a>
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Step 4.3. Modify the Display Design File
The Display HTML template (the _RC_IsDataWindow_Display__RR_Name.html file) is the 
main HTML page for displaying data. It creates the panes in the browser’s page and places 
the menu on the left and the data in the rest. In this section, you will create an HTML table 
for the entire page, a table row that is the entire table, and then two table data elements 
(defined by the HTML <td> tag) within that row.

The first <td> in the table you will create contains the menu. We’ll use the class="menu" 
attribute (noted in the code of the fancyMenu menu’s <body> tag, which you excised in the 
previous section) to get the proper menu style elements (colors and font).

� To modify the Display file to create the required display and call the Menu file:

1 Open the _RC_IsDataWindow_Display__RR_Name.html file in a text editor.

2 Find the display block.

3 Remove the line that includes the Menu.

Remove the bold line:

4 Replace the deleted line with the following code:

5 Save and close the _RC_IsDataWindow_Display__RR_Name.html file.

Begin display block  <body class="display">

<!--<?forte execute {{%R(page)[%P(Name)]}}Handler.ProcessAction 

resultset="entry">-->

<!--<?forte assign USER.TopPage="{{%R(page)[%P(Name)]}}">-->

<!--<?forte include "{{%R(page)[%E(Parent)[%P(Name)]]}}/Data_

{{%R(page)[%P(Name)]}}.html">-->

End display block </body>

<table border=0 width="100%" cellspacing=0 cellpadding=0>

<tr>

<td valign=top width=155 rowspan=3 class="menu">

<!--<?Forte include

 
"{{%R(page)[%E(Parent)[%P(Name)]]}}/Menu_{{%R(page)[%P(Name)]}}.h
tml">-->

</td>

<td>

<!--<?Forte include 

 
"{{%R(page)[%E(Parent)[%P(Name)]]}}/Data_{{%R(page)[%P(Name)]}}.h
tml">-->

</td>

</tr>

</table>
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Step 5. Generate and Inspect
The next step is to generate the application and inspect for errors. Generation errors are 
written to the Launcher log, and are also noted in the generated HTML template, with 
syntax like:

� To verify your work by generating code:

1 Open the HTMLtutApp application in the HTML Application Model Workshop.

2 Choose File > Properties to open the HTML Application Properties dialog.

3 Click the browser on the Page Design field to display the available page designs.

The brilliant design appears in the list:

4 Select brilliant and click OK.

5 Click OK to apply the changes and close the HTML Application Properties dialog.

6 Generate the code for the application.

7 Inspect for errors by opening the Launcher window and running the application and 
looking for “BAD SELECTOR” messages.

Our example does, in fact, have errors. The launcher window has a series of error messages:

*** BAD SELECTOR USED IN VARIABLE REFERENCE 

Identifiers for the brilliant design

The template variable page is undefined.
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And when you run the HTMLtutApp application, the windows contain a number of “BAD 
SELECTOR” messages:

The problem is that the top of the _RC_IsDataWindow_Menu__RR_Name_.html file (which 
you copied from fancyMenu in “Step 4.2. Modify the Menu Design File” on page 97) 
contains a code generation directive that is essential to the directives contained within the 
menu block. This directive assigns a value to the code generation page object. The menu 
uses this object, but you deleted it from the menu design file, so you need to replace it. 

� To fix the error in the Menu file:

1 Open the _RC_IsDataWindow_Menu__RR_Name_.html file in a text editor.

2 Insert the following line (the assignment of the page object) at the top of the file.

(This line is also at the top of _RC_IsFormWindow_Data__RR_Name_.html, if you want 
to copy it from another file.)

3 Delete the ${FORTE_ROOT}/html/docs/HTMLtutApp subdirectory, including the .base 
subdirectory.

Remember, you have to do this every time you change a design template. See “Clear 
Existing Generated HTML Templates” on page 95 for information.

4 Attempt to regenerate and run the HTMLtutApp application.

When you click on the Generate Web Application Server Code button, nothing 
happens! This is because the code generator is sensitive to changes in the 
WebEnterprise Designer definition of the model, but is unaware of the external state of 
HTML templates and page designs. In order to force a code generation, you must 
change something in the HTML Application. 

5 Change the Title field of the HTML application in the property dialog, and then change 
it back again.

For example, change the title from “HTML Tutorial” to “HTML Tutorial1” and then 
change it back to “HTML Tutorial.”

6 Regenerate the application.

New HTML template files are created. The launcher window should show no errors.

“BAD SELECTOR” 
error messages

<!--{{%A(page)}}-->
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7 Run the HTMLtutApp application.

The application is displayed in the new brilliant design, that should also have no errors:

Step 6. Fine-Tune the Customized Design
The following steps are the minimum ones you must do to complete the new design:

■ using the Display page as a model, convert the other page modes (Search, Update, and 
Insert) to panes using tables

■ modify also the layout of list pages (this example only modified form pages)

Further fine-tuning could include incorporating the common features of your company’s 
Web applications, for example, by adding the company logo to headers and footers. 

Testing a customized design requires a fairly rich HTML application, exercising all the 
features of WebEnterprise Designer applications. Over time, as your own applications 
evolve in complexity and power, your customized design will improve until it is exactly 
what you want. 
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Chapter 5
Customizing Page Styles
WebEnterprise Designer contains two HTML style sheets—cool and steel—that govern the 
presentation aspects of application pages. In the WebEnterprise Designer Application 
Model Workshop, these are referred to as styles. This chapter provides information on these 
styles and how to customize them, including:

■ what HTML style sheets are

■ the characteristics of WebEnterprise Designer native styles 

■ how to customize styles and add them to the WebEnterprise Designer application 
environment
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HTML 4.0 and Style Sheets
WebEnterprise Designer creates Web pages that conform to the HTML 4.0 standard defined 
by the World Wide Web Consortium (W3C). The HTML 4.0 specification is available at 
http://www.w3c.org/TR/REC-html40. 

A recent aspect of the evolution of HTML is the separation, in HTML 4.0, of the 
presentation aspects of Web documents (which include such properties as font 
information, colors, and alignment) from the layout of the page. In HTML 4.0, the 
presentation aspects are contained in style sheets, which are combined with HTML 
documents to produce fully rendered pages in a browser. The tags and attributes of earlier 
versions (HTML 2.0 and HTML 3.2), including “<font>” and “bgcolor=”, are now listed as 
“deprecated” features, in favor of style sheets as the recommended mechanism for 
describing presentation.

The browsers supported by WebEnterprise Designer, Netscape Navigator (version 4.0 and 
above) and Microsoft Internet Explorer (version 4.0 and above), both support HTML 4.0 
documents, including style sheets conforming to the W3C Cascading Style Sheets, level 1 
specification (CSS1). The HTML templates generated for WebEnterprise Designer 
applications are designed to work in concert with CSS1 style sheets. This specification is 
available at http://www.w3c.org/pub/WWW/TR/REC-CSS1. 

WebEnterprise Designer and Style Sheets 
Each page defined in the HTML Application Workshop is associated with a page design and 
a style. The design governs the layout of the application’s page. When you generate the 
application’s Web server code, pages are processed through this design, resulting in HTML 
templates. This process and its opportunities for customization are the subject of 
Chapter 4, “Customizing Page Designs.”

WebEnterprise Designer styles are native style sheets used by the generated HTML 
templates to format their HTML elements. There are two native styles, cool and steel. Cool 
defines a colorful presentation using both serif and sans-serif fonts. Steel creates pages 
devoid of color that use only sans-serif fonts.

The style sheets themselves are part of the WebEnterprise Web server installation and are 
installed under the Web server root. When you specify them, you use URLs relative to the 
Web server document root. For example, you specify the cool style with 
/forte/styles/cool.css, and the steel style with /forte/styles/steel.css. The actual locations of 
these files might be one of the following:

■ c:\Netscape\Suitespot\forte\styles\cool.css—location of the cool style on the Netscape 
Web server root directory on NT

■ /usr/netscape/suitespot/forte/styles/steel.css—location of the steel style on the 
Netscape Web server root directory on UNIX

■ c:\InetPub\forte\styles\steel.css—location of the steel style on Microsoft IIS on NT

The rest of this chapter provides a description of style elements used in WebEnterprise 
Designer HTML templates and offers guidelines for creating your own styles to use with 
WebEnterprise Designer applications.
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Using HTML Style Elements with WebEnterprise Designer
An HTML template generated by WebEnterprise Designer refers to style sheets in two ways:

■ to name the style (CSS1) file to use to process the page

■ to use elements defined in the style sheet to format HTML elements of the page

Identifying the Style Sheet to Use
Use the HTML link tag in the document header to identify the style file to use for 
processing the page. For example:

This line specifies the cool.css style sheet file. (File specification for style sheets are relative 
to the Web server root directory; see “WebEnterprise Designer and Style Sheets” on 
page 104 for a discussion of this.) The browser asks the Web server to fetch the style sheet 
(unless it is already in the browser’s cache) and then uses its contents to format the HTML 
page.

Using HTML Attributes
The HTML 4.0 and CSS1 specifications provide several ways to apply styles to a document. 
WebEnterprise Designer employs two HTML 4.0 style sheet selectors: 

■ the class attribute, which assigns the style to all elements defined by the specified tag

■ the id attribute, which assigns the style to a single element

In HTML, the class and id attributes are element identifiers, and in particular, document-
wide element identifiers.

The class Attribute
You can use the class attribute with many HTML tags to specify a CSS1 style element. For 
example, consider this class attribute specification within an HTML <body> tag:

The class attribute in this case directs the browser to find the display element in the current 
style sheet and apply its attributes to the HTML <body> tag.

In this example, the current style sheet is the cool.css file. The display element in cool.css is 
specified as follows:

In the above code, the document’s background color is defined as white. A list of fonts is 
specified for the document; the browser will choose the first one it supports. In previous 
versions of HTML, you would specify these attributes with the following tags:

<link href="/forte/styles/cool.css" rel="stylesheet" 
type="text/css">

<body class="display">

HTML 4.0 specifications of: .display {

background color background-color: rgb(255,255,255); 

document font font-family: "Times New Roman", Times, Georgia, 

"Century Schoolbook", "Bookman Old Style", serif;

}

Pre-4.0 background color <body bgcolor = "FFFFFF"> 

Pre-4.0 document font <basefont face = "Times New Roman, Times, Georgia, Century 
Schoolbook, 

Bookman Old Style, serif">
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The Scope of the class Attribute

An important aspect of the class identifier is that the attributes of the style element 
identified by it (that is, display) apply to all HTML elements defined between the <body> 
and </body> tags (in this case, the entire document). If the class attribute were placed in 
the <table> tag, it would apply to all elements between the <table> and </table> tags.

Finally, one class may override another within its scope. Consider the following HTML tags:

If the display class defines the background color as white and the mytables class defines it 
as red, the document’s background color shifts from white to red and then back to white, as 
specified by the labels in the column at the right of the code.

The id Attribute
Like the class attribute, the id attribute is an element identifier. The difference between id 
and class is that id applies only to the current tag. For example:

In this line, id applies the statusline style elements only to the output string “Row 1 of 42." 
If other HTML tags are defined within the block defined within <div> and </div>, they are 
not governed by statusline. 

Using HTML Style Elements
Both WebEnterprise Designer styles (cool and steel) use a common set of CSS1 elements. 
These elements are:

<body class="display"> WHITE

<p>Table of Contents</p> WHITE

<table class="mytables"> RED

<tr> . . . </tr>> RED

</table> RED

<table> WHITE

<tr> . . . </tr> WHITE

</table> WHITE

</body> WHITE

<div id="statusline">Row 1 of 42</div>

Style type Style element Use for formatting:

General page-level styles display The display frame body of the page’s display mode.

modify The display frame body of the page’s Insert and Update 
modes.

menu The body of the menu frame.

footer The body of the footer frame.

header The body of the header frame.

Anchors (links) amenu The anchors (links) in the menu frame.

alink The anchors (except for Data or Field Label links) in the 
display frame.

adata The anchors in the display frame that are attached to data 
items (links whose Activate Link On property is set to Data).

alabel The anchors in the display frame that are attached to the 
label of data items (links whose Activate Link On property is 
set to Field Label).
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Figure 20 shows how some of these elements appear on a Web page.

Figure 20 Style Element Examples

Page captions captionform The caption above the retrieved data on data pages of form 
pages.

captionlist The caption above the retrieved data on data pages of list 
pages.

captionlogon The caption above the data entry fields on logon pages.

captionmenu The caption above the commands in the menu frame.

Column labels rowidlist The row ids on list pages.

labellist The field labels above the data columns on the data 
templates of list pages.

labelform The field labels on the data templates of form pages.

labelmodify The input field labels on the data templates of insert, update, 
and search mode pages.

Column data datalist The retrieved data on the data templates of list pages.

dataform The retrieved data on the data templates of form pages.

Form buttons buttons All buttons on all page modes of data pages (for example, 
the Insert and Search buttons).

buttonlogon The button on logon pages.

Status line (accessed by “id=”) #reqstatus The status line of the data display (Record 1 of n).

Style type Style element Use for formatting:

captionform

labelform dataform

captionlist

libelist

datalist
rowidlist

captionmenu

amenu

#reqstatus

alink

alink

header

footer

menu

display
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Customizing Page Styles
The first step in customizing a page style is to assess the scope of your project. You should 
ask yourself the following questions:

■ Will you be modifying elements only or adding new ones as well?

If you modify only existing elements, you only need make changes to the style sheet 
itself. If you add new elements, you must add them to both the generated HTML 
templates and to the style sheet they will use.

■ Will the new style be available to all applications, or will it be restricted?

If the use of the new style is restricted to specific applications, then you can simply 
customize each application’s HTML templates to use the new style. If any application is 
allowed to use the style, you must add the style to the list in the Style browser in the 
HTML Application Model Workshop. You might also want to add the elements to one or 
more page designs. 

■ Will the new style be usable with all available page designs or will it be restricted?

If you do not add support for the new style elements to all page designs, this can result 
in some invalid combinations of designs and styles. HTML templates using a particular 
style element will display correctly only if the style being used implements the element. 
You can either add the element to all styles or document any restrictions to design/style 
combinations in the textual descriptions that display in the Style and Page Design 
browsers.

The following sections provide customization guidelines under different scenarios arising 
from how you answer these questions. All discussions and examples refer to creating a new 
style, which is based on the cool style, and named the “marketing” style.

Outline of Basic Procedures
The general steps for creating and implementing a customized style are:

1 Create a new style sheet file by copying the most similar existing one, and rename it 
with the new style name.

Details are given in “Creating the New Style Sheet File” on page 109.

2 Determine whether you will add new elements to the style sheet or only modify existing 
elements.

If you are only modifying existing elements, refer to “Modifying Existing Elements” on 
page 109 for information.

If you are adding new elements, refer to “Modifying Existing Elements” on page 109.

3 Determine whether use of the new style is to be restricted or not.

If you are restricting the style to certain applications, refer to “Adding New Elements” on 
page 109.

If the style is to be made generally available, you will want to identify it in the HTML 
Application Model Workshop. Refer to “Identifying the Style with a Bitmap and Text” on 
page 111 for details.

4 Test the new style with different browsers and adjust accordingly.

Refer to “Considering the Browser” on page 112 for important information and 
guidelines regarding browsers.
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Creating the New Style Sheet File
The first step in creating the new marketing style is to create a marketing.css file in the 
WebEnterprise Designer styles directory. The styles directory depends on where your Web 
server directory is. See “WebEnterprise Designer and Style Sheets” on page 104 for a 
description of several possibilities, or see your system administrator for the exact location 
in your installation. 

� To create a new style sheet file:

1 Find the cool.css file in the Web_server_root/forte/styles directory.

2 Copy the cool.css file to a new marketing.css file in the same directory. 

Now application pages that use the marketing style will look just like cool style pages.

Modifying Existing Elements
When you make customizations that only modify existing elements, such customizations 
generally require changes only to the style sheet itself. Guidelines for this type of 
customization are as follows:

� To customize only existing elements in the new style sheet:

1 Create a new style sheet, as described in “Creating the New Style Sheet File,” above.

2 Modify a few elements in the new style sheet.

Refer to “Using HTML Style Elements with WebEnterprise Designer” on page 105 for 
information on the elements used in the WebEnterprise Designer style sheets. For a 
basic reference on HTML 4.0, see the HTML 4.0 specification at 
http://www.w3c.org/TR/REC-html40.

3 Test the style sheet by regenerating code and running the application.

If your changes do not appear, refer to “Browser Caching,” below for a solution.

4 Repeat Steps 2 and 3 until your new style is perfected. 

Remember to read “Considering the Browser” on page 112 for information related to 
testing and use of your new style.

Adding New Elements
If you choose to add new style elements, you must add them to both the style sheet and the 
generated HTML templates that refer to it. How you do this depends on whether or not you 
want the style to be available to all applications or not.

� To customize a restricted style:

1 Open the new CSS1 style sheet (marketing.css from “Creating the New Style Sheet File,” 
above).

2 Make your changes, including adding new elements.

For information on elements used by WebEnterprise Designer, refer to “Using HTML 
Style Elements with WebEnterprise Designer” on page 105. For a basic reference on 
HTML 4.0, see the HTML 4.0 specification at http://www.w3c.org/TR/REC-html40.

3 Save and close the marketing.css file.

4 Open each of the application’s HTML templates and change the <link> tag to your new 
style.

Example <link href="/forte/styles/marketing.css" rel="stylesheet" 

type="text/css">
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5 Modify the HTML, as appropriate, to use your new style elements.

See Chapter 3, “Customizing Generated HTML Templates,” for details on customizing 
HTML templates.

If, however, multiple applications can use the new style elements, then you might want to 
follow these procedures instead:

� To customize generally available styles:

1 Identify the new style to the HTML Application Model Workshop, as described in 
“Identifying the Style with a Bitmap and Text,” below.

This automatically customizes the <link> reference in the HTML templates of any 
application that uses this style.

2 Customize your new style sheet, as in the previous procedure.

3 Instead of modifying the individual templates of an application, modify one or more 
page designs. 

See Chapter 4, “Customizing Page Designs,” for details.

Bear in mind, however, that adding support for new style elements to a restricted number 
of designs or styles can result in some invalid combinations of designs and Styles. For 
example, if a new design uses a new style element that is only implemented in one new 
style, then application pages using the new design must use the new style. Obviously, 
HTML templates using a particular style element will only display correctly if the style in 
use implements the element. To avoid this restriction, you could add the element to all 
styles, or you can document the restrictions in the design and style description files (for 
example, the marketing.txt files described next in “Identifying the Style with a Bitmap and 
Text”).
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Identifying the Style with a Bitmap and Text
If you will be making the new style generally available to all applications, then you need to 
identify and describe the style in the HTML Application Model Wizard. Two files within 
the ${FORTE_ROOT}/userapp/express/clx/styles directory identify the style in the Style 
Properties dialog:

■ a bitmap image of a thumbnail picture of a page created with the style

■ a brief textual description of the style

(You access the Styles properties dialog by clicking the Style browser button on either the 
HTML Application Properties dialog or on the Page Options page of the Page Wizard.)

For example, Figure 21 shows the identifiers of the cool style in the Style Properties dialog:

Figure 21 Style Identifiers

To make your new style available to the workshop, you must add two files to that directory.

� To identify the marketing style:

1 Make a copy of the cool.bmp file in the ${FORTE_ROOT}/userapp/express/clx/styles 
directory.

2 Rename the cool.bmp file marketing.bmp.

3 Create a text file named marketing.txt in the same directory.

4 Add the following text to the marketing.txt file:

5 Save and close the marketing.txt file.

Now when you display the Style Property dialog, you will see three choices: steel, cool, and 
marketing. If you select the marketing style, the generated HTML templates will 
automatically contain a <link> tag referring to the marketing.css file.

Bitmap image of style

Textual description of style

The corporate standard style for external Web applications.
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Considering the Browser
This section discusses two important considerations regarding browsers and customized 
style sheets. 

Browser Caching
One difficulty with implementing a new style sheet is that browsers tend to cache the style 
sheet in their local memory. Even though you have modified the style sheet, the browser 
can choose to use its local, unmodified copy, instead. Browser preference settings affecting 
cache behavior do not apply to style sheets in the same way they apply to HTML 
documents. If you make style sheet changes, but the appropriate changes are not displayed 
when you run the application, examine the Web server log to see if the browser is re-
fetching the old style file. If so, shut down and restart the browser.

Browser Independence
An important objective of WebEnterprise Designer is that generated applications be 
browser-independent. That is, application pages should look much the same whether 
viewed with Netscape Navigator or Microsoft Internet Explorer.

The two style sheets included with WebEnterprise Designer achieve this objective. 
However, it has been our experience that the support for CSS1 in the browser products is 
not as robust as their support for HTML 4.0. Style sheet elements that appear correct 
might, in fact, not display correctly.

For example, CSS1 supports specification of colors by keyword (such as “white”, “red”, 
“blue”, and so forth). However, one of the browser products does not currently implement 
this correctly. For this reason, we have adopted the “rgb” (red, green, blue) syntax for color 
specification, which both products correctly implement. An example of this is from the 
cool.css file:

It is vital that applications in general, and style sheets in particular, undergo testing with 
both browser products.

.display (

background-color: rgb(255,255,255);
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Customizing Error Pages
When errors are detected during the processing of WebEnterprise Designer applications, 
they are displayed in the browser as an error page. You can customize the appearance of 
this error page or create your own.

This chapter provides information on how to:

■ modify the appearance of the default HTML exception page

■ create customized error pages

Most of the information in this chapter applies to WebEnterprise applications, as well as 
WebEnterprise Designer applications.
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WebEnterprise Exception Handling
WebEnterprise applications, including those created with WebEnterprise Designer, are 
based on a request-response model, in which the browser client requests Forte services, 
which are returned in HTML form (Web pages in the browser). When errors occur during 
the processing of these requests, Forte exceptions must be converted to an HTML 
representation and returned to the client.

WebEnterprise uses dynamic exception mapping to format exceptions. Standard template-
driven HTML Scanner technology allows the developer to control the appearance of error 
pages.

In addition, the WebEnterprise Designer Page Handler Customization Wizard contains 
customization points that permit arbitrary application-specific processing of exceptions.

Default Exception Processing
The default WebEnterprise exception processing steps are as follows:

1 Exceptions raised within the WebEnterprise runtime system are caught and processed 
at two distinct points:

■ exceptions raised during the processing of an HTMLScanner template request are 
processed within the HTMLScanner service object

■ all other exceptions are processed within the HTTPAccess service object

2 When WebEnterprise catches an exception, it maps the exception class to an error 
HTML template file to format the exception’s attributes. 

The default error HTML templates all reside in the ${FORTE_ROOT}/ html/errors 
directory. Exceptions are mapped to templates as follows:

3 WebEnterprise then generates an internal HTTPRequest, with the appropriate error 
template file as the requested template. 

4 WebEnterprise converts the exception’s attributes to HTTPRequest parameters, which 
are accessible to the HTML template within the FORTE pseudo-result set. 

Exception attributes are listed and described in the next section, “WebEnterprise 
Exception Result Set Variables.”

5 WebEnterprise then processes the template file using standard HTMLScanner 
procedures. 

6 The default error templates display all exception attributes.

An example error page is shown in Figure 22.

Error Mapped to error template

HTMLScannerException htmlscanner.html

HTTPAccessException httpaccess.html

All other exceptions generic.html
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Figure 22 Default Scanner Exception Page
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WebEnterprise Exception Result Set Variables
As described in the previous section, when WebEnterprise processes exceptions, it converts 
exception attributes to HTTPRequest parameters, which are then accessible from the 
HTML templates by means of the $$(FORTE.parameter_name) specification. (For 
information on the syntax of Forte variables, see A Guide to WebEnterprise.)

The sections that follow provide a table listing each exception class’s attributes and their 
associated HTMLScanner result set variable references. Attributes that are undefined are 
assigned a default value (generally “0” for a numeric attribute and “n/a” for text attributes).

HTMLScannerException Class Variables
The following table lists the attributes of the HTMLScannerException class and their 
corresponding result set variables. These are the variables used in the htmlscanner.html 
template.

Attribute Result set variable Description

Classname $$(FORTE.ExceptionClass) “HTMLScannerException”

Message $$(FORTE.Message) The error’s text

DetectingMethod $$(FORTE.DetectingMethod) The method raising the exception

MethodLocation $$(FORTE.MethodLocation) Additional identifying information

Severity $$(FORTE.Severity) The severity text description

$$(FORTE.SeverityGIF) The severity image file

CharOffset $$(FORTE.Charoffset) The byte offset in the line of the error

LineNumber $$(FORTE.LineNumber) The line number in the HTML template

SourceLine $$(FORTE.SourceLine) The text of the HTML template line

ExceptionTraceback $$(FORTE.ExceptionTraceback) The method’s traceback
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HTTPAccessException Class Variables
The following table lists the attributes of the HTTPAccessException class and their 
corresponding result set variables. These are the variables used in the httpaccess.html 
template.

Variables for All Other Exceptions 
The following table lists the attributes and corresponding result set variables used for errors 
that are neither HTMLScannerException nor HTTPAccessException errors. These are the 
variables used in the generic.html template.

Attribute Result set variable Description

Classname $$(FORTE.ExceptionClass) “HTTPAccessException”

Message $$(FORTE.Message) The error’s text

DetectingMethod $$(FORTE.DetectingMethod) The method raising the exception

MethodLocation $$(FORTE.MethodLocation) Additional identifying information

Severity $$(FORTE.Severity) The severity text description

$$(FORTE.SeverityGIF) The severity image file

ExceptionTraceback $$(FORTE.ExceptionTraceback) The method’s traceback

Attribute Result set variable Description

Classname $$(FORTE.ExceptionClass) The name of the exception class

Message $$(FORTE.Message) The error’s text

DetectingMethod $$(FORTE.DetectingMethod) The method raising the exception

MethodLocation $$(FORTE.MethodLocation) Additional identifying information

Severity $$(FORTE.Severity) The severity text description

$$(FORTE.SeverityGIF) The severity image file
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Customizing Error Pages
This section provides customization guidelines for WebEnterprise error pages. The 
different levels of customization discussed include:

■ modifying the default error pages

■ creating a custom error page

■ adding new result set variables

■ using the error page customization point in the Page Handler Customization Wizard

All but the last level are available to all WebEnterprise users; the last level is available only 
to WebEnterprise Designer users.

Modifying Default Error Pages
The simplest way to customize WebEnterprise error pages is to modify the HTML template 
files in the ${FORTE_ROOT}/html/errors directory. It is a straightforward task to adjust the 
HTML tags to produce an installation-specific or company-wide error page format.

For a basic reference on HTML 4.0, see the HTML 4.0 specification at 
http://www.w3c.org/TR/REC-html40.

Creating Custom Error Pages
If you want your application to log errors, delete sessions, or take other application-specific 
action beyond the default WebEnterprise exception handling procedure, you can use two 
additional levels of customization that are supported within WebEnterprise, namely:

■ creating your own error HTML template files

You can use the variables described in “WebEnterprise Exception Result Set Variables” 
on page 116 and customize the exception class mapping, as well.

■ creating your own result set variables 

With your own variables, you can include application-specific dynamic data on the 
error page.

While these customization levels are available to any WebEnterprise application, 
WebEnterprise Designer provides customization points that simplify the creation of 
custom error handlers. These are described in the next section.

Customizing a WebEnterprise Designer HTML Application
WebEnterprise Designer’s Page Handler Customization Wizard contains a customization 
point for customizing an application’s error pages. For complete information on the 
Customization Wizard, see “Customizing With the Page Handler Customization Wizard” on 
page 51.

� To customize an application’s error page using the Customization Wizard:

1 Open your application in the HTML Application Model Workshop.

2 Select the business class page you wish to customize.

3 Choose the Component > Customize… command to open the Wizard.

If this is the first customization you are making to this class, WebEnterprise Designer 
displays a dialog requesting permission to generate a customizable class for the page. 
Click OK.

4 Open the Application group by clicking on the arrow next to it.
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5 Select the “Define HTML template for exceptions” customization point and click 
Customize.

The Method Workshop opens, displaying the GetErrorTemplate method. This method 
overrides the HTMLScanner.GetErrorTemplate method defined. 

6 Add your code to implement application-specific error processing in GetErrorTemplate.

For information on GetErrorTemplate, click the Help button while this customization point 
is selected. Documentation is also provided as comments in the method body, as well. The 
Help topic description contains a link to a description of the 
HTMLScanner.GetErrorTemplate method. 

The following sections provide an expanded version of the Help documentation.

The GetErrorTemplate Method
The GetErrorTemplate method provides a means of modifying the HTML template that 
should be used when an exception is generated during processing a user request.

The arguments to the GetErrorTemplate method are:

Return Value

GetErrorTemplate returns a TextData object that contains the specification of the HTML 
template file to be used to format and return the error. As with all HTML template 
specifications, this file is assumed to reside within the WebEnterprise document root. This 
makes it simple to access an application-specific error page.

Customization point for creating a customized error page

GetErrorTemplate (e=GenericException, request=HTTPRequest, customParameter=array of NamedElement)

Returns Framework.TextData

Parameter Required Input Output
e ● ●

request ● ●

customParameters ● ●

Argument Description

e : GenericException The actual exception object thrown by the application.

request : HTTPRequest The HTTPRequest object being processed when the exception was 
thrown.

customParameters : Array of NamedElement An optional array of name-value pairs. If this is returned, the 
elements are added to the error’s HTTPRequest parameters and 
are therefore available to the error HTML template as resultset 
variables.
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WebEnterprise also provides the ability to directly access HTML documents (including 
HTML templates) that reside under the installation’s html directory. Any template 
specification that begins with the token “/forte/” is re-mapped to the 
${FORTE_ROOT}/html directory.

For example, the template name “/forte/errors/htmlscanner.html” resolves to 
${FORTE_ROOT}/html/errors/htmlscanner.html. Using this syntax, a site can easily create 
site-wide HTML template directories.

Example: Application-Specific Error Template
This example maps HTMLScanner exceptions to an application-specific (Movie) error 
template and all other exceptions to the standard generic error template.

Example: Application-Specific Template with Custom Data
This example extracts the user name associated with the session (previously attached to the 
session during Logon) and adds it to the customParameters object. This will cause it to be 
added to the result set variables. A custom error HTML template (not illustrated here) will 
then display the user name on a standard application error page. (See Chapter 8, 
“Customizing Application Security,” for details on capturing and storing user 
authentication information.)

// GetErrorTemplate(e: GenericException, request: HTTPRequest, 

// output customParameters: Array of NamedElement) : TextData 

//

errorTemplate : TextData = new;

customParameters = nil;

//

if e.IsA(HTMLScannerException) then

errorTemplate.SetValue(’Movie/Error_Scanner.html’);

else

errorTemplate.SetValue(’/forte/errors/generic.html’);

end if;

//

return errorTemplate;

// GetErrorTemplate(e: GenericException, request: HTTPRequest, 

// output customParameters: Array of NamedElement) : TextData

//

// Every exception will be processed with the same template

//

errorTemplate : TextData = new;

errorTemplate.SetValue(’Movie/Errors.html’);

//

// Assume that the LogonSession method returned the username in the

// credentials object, where it was added to the SessionData.

//

customParameters = new;

p : NamedElement = new;

p.Name = ‘ApplicationUsername’;

if request.CurrentSession <> NIL then

 p.Object = TextData(request.CurrentSession.GetSessionData(

TextData(value=’Logon-Credentials’)));
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The user name is available in the Movie/Errors.html template as the result set variable 
$$(FORTE.ApplicationUsername).

Customizing HTTPAccessExceptions
As noted above, the HTMLScanner.GetErrorTemplate method performs mapping for 
exceptions raised during HTML template processing. This phase includes exceptions raised 
in Business Services. Overriding GetErrorTemplate effectively customizes these exceptions.

Some WebEnterprise exceptions occur outside of the HTMLScanner template processor, 
for example, errors occurring during non-template requests (“pagename” requests), HTTP 
parsing errors, and communications failures. Such errors can raise exceptions that require 
a slightly different customization.

These exceptions are caught, mapped, and formatted within the HTTPAccess subclass 
service object. By default, the HTTPAccess.GetErrorTemplate method applies exactly the 
same mapping logic as HTMLScanner.GetErrorTemplate. However, customizing the 
HTMLScanner method has no effect on the exceptions processed within HTTPAccess. 
Unless you also customize HTTPAccess.GetErrorTemplate, HTTPAccess exceptions will be 
processed through the default htmlscanner.html, httpaccess.html, and generic.html 
templates.

You customize HTTPAccess exception processing by customizing the GetErrorTemplate 
method in the HTTPAccess subclass. Since this method has the same signature as the 
HTMLScanner method, you can customize in several ways:

■ copy your customized GetErrorTemplate method from your HTMLScanner subclass to 
your HTTPAccess subclass

■ override the HTTPAccess.GetErrorTemplate method and have it directly call your 
HTMLScanner.GetErrorTemplate

■ override the HTTPAccess.GetErrorTemplate method, implementing different custom 
exception logic

As a suggestion, you might use a general purpose HTTPAccess.GetErrorTemplate 
method in every WebEnterprise application, but a different 
HTMLScanner.GetErrorTemplate method for each application.

Caution When customizing exceptions with GetErrorTemplate, check for the existence of objects 
before you use them. This is particularly true when the HTTPAccess.GetErrorTemplate calls 
a customized HTMLScanner.GetErrorTemplate. For example, exceptions caught in 
HTTPAccess might not have their HTTPRequest.CurrentSession attribute set (because the 
error occurred before the session was associated with the request). The GetErrorTemplate 
method that processes the exception must be careful to test CurrentSession for a NIL value 
before using it.

else

p.Object = TextData(value=’No session’);

end if;

customParameters.AppendRow(p);

//

return errorTemplate;

Example // MovieAccess.GetErrorTemplate(e: GenericException, request: 

HTTPRequest,

// output customParameters: Array of NamedElement) : TextData

//

return MovieScannerService.GetErrorTemplate(e, request, 

customParameters);
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Errors in Error Customization
What happens if errors occur during the mapping and formatting of exceptions? What if 
the error template object returned by GetErrorTemplate is syntactically incorrect or refers 
to a file which does not exist? What if my customized GetErrorTemplate refers to the 
request.CurrentSession object, but it is NIL because no session exists?

In these cases, the “last chance exception processor” is invoked. The last chance exception 
processor catches and dismisses the exception raised during exception processing. It then 
creates an HTML error response containing the original exception’s attributes. The format 
of this error page is fixed.

If, after customizing your error pages, exceptions are not returned using customized pages 
(or, for that matter, the default pages in ${FORTE_ROOT}/html/errors), then it is likely that 
there is an error in the error customization. Since the last chance exception processor’s 
mission is to hide these errors, you can diagnose the problem by tracing handled 
exceptions (that is, by enabling trc:lo:25 in the partition where either or both the 
HTMLScanner and HTTPAccess service objects exist). The exception caused by 
customization should then appear in the trace log.
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Customization Examples
This chapter describes a number of desirable customizations for WebEnterprise Designer 
applications. These examples illustrate how information described in the previous chapters 
of this manual might be used in real-life situations.

The customizations in this chapter include:

■ adding a Lookup reference page

■ passing data with a command link

■ automatically populating data on an Insert page

■ adding a drop list for entering and formatting dates

■ removing a JavaScript validation from a page mode

■ displaying the record just inserted

■ validating a whole form

■ making a single field mandatory

■ entering lookup information for drop lists or radio lists manually

■ removing <Not Selected> and <None> from drop lists and radio lists
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Introduction
The examples in this chapter are based on Tech Notes for WebEnterprise Designer that are 
available on the Forte Cybersupport Web site. Check this Web site frequently for new 
information.

All customizations in this book start with the HTMLtutApp tutorial application, described 
in Getting Started with WebEnterprise Designer. We recommend you create your own 
tutorial application. Alternatively, you can import a finished version of the tutorial by 
following the instructions provided in Appendix A of Getting Started with WebEnterprise 
Designer.

The examples are as follows:

■ “Example: Adding a Lookup Reference Page” on page 126

Creates a link to a list of customers from the Insert mode of the Customers page. 
Selecting a customer from the lookup page passes the Customer Number value back to 
the Insert page.

■ “Example: Passing Data with a Command Link” on page 134

Similar to the previous example, but instead of a lookup page, uses a variable to pass the 
record value of the selected record to the Insert page.

■ “Example: Automatically Populating Data on an Insert Page” on page 139

Yet another way to pass a value to the Insert page. This example creates a new Customer 
page and uses a WebEnterprise Designer variable to pass the value to the Insert page.

■ “Example: Adding a Drop List for Entering and Formatting Dates” on page 143

Creates three drop lists and uses stored values for date entry.

■ “Example: Removing a JavaScript Validation from a Page Mode” on page 147

Removes an inappropriate field constraint from a Search mode template.

■ “Example: Displaying the Record Just Inserted” on page 151

Moves the most recently inserted record to the top of the result set list, so that it is 
displayed immediately after it is entered.

■ “Example: Validating a Whole Form” on page 153

Uses a JavaScript script to validate a form. Also provides a JavaScript boilerplate for 
further use.

■ “Example: Making a Field Mandatory” on page 158

Uses TOOL customization to force a user to enter data in a field.

■ “Drop List or Radio List Example: Entering Lookup Information Manually” on page 161

Shows how to enter displayed values and stored values in drop lists or radio lists without 
referring to a business class.

■ “Drop List and Radio List Example: Removing <Not Selected> and <None>” on page 165

Shows how to remove unwanted default values from drop lists and radio lists and 
specify new ones.
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Methods for Editing Generated Files
The Page Handler Customization Wizard provides convenient and organized access to any 
files generated for your HTML application model, including TOOL files and HTML 
template files. When the method you want to customize does not have a customization 
point defined for it in the Customization Wizard, you have to customize manually, using 
the Method Workshop.

Using the Page Handler Customization Wizard
Complete information on using the Wizard is provided in “Customizing a Generated HTML 
Template” on page 53. Before you can edit generated files with the Customization Wizard, 
you must set the FORTE_WW_HTMLEDITOR environment variable with the full pathname 
of the editor of your choice. For example, if you were using the HTML editor FrontPage:

FORTE_WW_HTMLEDITOR D:\frontpage\bin\fpeditor.exe

For information on setting these variables, see the online Help topic for the variable. For 
information on using shortnames for file specification on Windows NT, see the help topic, 
“Use a shortname for the Default Browser field.”

Customizing TOOL Methods Manually
Chapters 1 and 2 of this manual offer general guidance concerning which methods to 
customize for many types of customizations. Once you know which method to override or 
customize, then you edit the method in the Method Workshop. If your customization is to a 
page handler class, you must first create a customizable version of the class. (Refer to 
“Creating Customizable Classes” on page 48.)

For example, “Step 2. Override the BeforeInsert Method” on page 145 describes a TOOL 
method customization that creates a BeforeInsert method in the CustomerOrderHandler 
class that overrides the ExpressClassHandler.BeforeInsert method. You can use the 
following alternative to the Customization Wizard:

� To customize a method of an ExpressHandlers class in a HTMLtutAppHandlers class:

1 In the Project Workshop for ExpressHandlers, open the Class Workshop for the 
ExpressClassHandlers class.

2 Locate the BeforeInsert method in the Class Workshop.

3 In the Project Workshop for HTMLtutAppHandlers, open the CustomerOrderHandler 
class.

4 Drag the BeforeInsert method (in Step 2) into the Class Workshop for the 
CustomerOrderHandler class.

5 Open the new BeforeInsert method.

6 Proceed with the customizations described in “Step 2. Override the BeforeInsert 
Method” on page 145.

Customizing Generated HTML and Text Files Manually
Chapter 3, “Customizing Generated HTML Templates,” describes all generated page 
handler templates. These are all found in the ${FORTE_ROOT}/Document 
Root/html_model directory. You can edit the HTML files with the Page Handler 
Customization Wizard, but if you want to edit them manually, you can use either an HTML 
editor or a text editor to edit files with an .html extension.
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Example: Adding a Lookup Reference Page
In the HTMLtutApp tutorial application, adding a new order to a customer record is 
somewhat clumsy and counter-intuitive. You navigate to the customer you wish to add an 
order to, but when you choose Insert, the page displays with all fields empty. Thus, there is 
no connection between the customer record you are viewing and the Insert page. This 
example offers a solution.

What This Example Does
This modifies the HTMLtutApp tutorial application, adding a lookup link from the Insert 
mode of the CustomerOrder page to a customer list. Selecting a customer from this list 
automatically passes the selected customer’s number back to the Insert page.

The lookup link on the Insert page looks like this:

Figure 23 Lookup Link on Customer Order Insert Page

Clicking on the lookup link displays a master list of customers:

Figure 24 Customer List Page

Clicking on the Use link associated with the desired customer redisplays the Customer 
Order Insert page with the selected customer’s number showing in the appropriate field.

Figure 25 Customer Number Returned with the Insert Page

Lookup link

Use links
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Creating a Lookup Link
This section describes how to add a lookup link to the HTMLtutApp tutorial application. 
The general steps of this procedure are as follows:

1 In the HTML application model, create a CustomerList page based on the Customer 
class and link it to the Customer Order page; specify that the new page will start in 
Search mode.

2 Run the application and capture the URL of the Insert mode of the CustomerList page.

3 Customize the Insert template of the CustomerOrder page, adding a lookup link to the 
URL captured in Step 2, and a Forte variable for the selected order’s CustomerNumber 
value.

4 Add a link to the Data template of the CustomerList page to its Insert page, and pass the 
CustomerNumber of the selected customer with the link.

5 Remove the link between the CustomerOrder class and CustomerList class so that it 
only appears on the Insert mode of the CustomerOrder page.

Step 1. Add a Reference Page to the HTMLtutApp Model
This section describes how to modify the HTMLtutApp model as the first step in creating a 
lookup link.

� To set up the HTMLtutApp model for a lookup link:

1 Start the HTML Application Model Workshop for the HTMLtutApp application.

2 Create a new list page based on the Customer class.

3 Enter CustomerList for the HTML Page Name, and make the title Customer List.

The Page Options page of the Page Wizard should look like this:

4 Create a link between the CustomerOrder page and this page.

5 Double-click on the link to display the Link Properties dialog.
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6 Name the link Customer List and set the Called Page Options to start on the Search 
Page.

The Link Properties dialog should look like this:

7 Click OK to apply your changes and dismiss the dialog.

Your model should look like this:

Step 2. Capture the Search Page URL
In this section, you run the application and capture the URL of the search mode of the 
CustomerList page. 

� To capture the URL of the Search page mode:

1 Run the HTMLtutApp application.

2 From the Home page, click the Customers link to get to the Tip-a-Canoe Customers 
page.

3 From the Customers page, click the Orders for this Customer link to get to the Customer 
Orders nested page.

Lookup Link
additions
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4 Under the Customer Order portion of the page is the new Customer List link; click on it.

The search mode of the CustomerList page should appear, as shown here.

5 In the data section of the page, right-click to bring up the menu, and choose Open 
Frame in New Window.

This step is necessary, because the HTMLtutApp application uses a page design with 
frames. If you do not perform this step when copying the URL, later, when you run the 
application, you will get the frameless version.

6 Copy the URL (to the clipboard) in the new window and exit the application.

Step 3. Create a Link with the Captured URL
In this section, you use the URL string you copied in the previous section to create a link in 
the CustomerOrder Insert template. You will also add a variable for the CustomerNumber.

Before beginning this section, please review “Methods for Editing Generated Files” on 
page 125.

� To customize the CustomerOrder page:

1 Using the HTML-editing option of your choice, open the Insert_CustomerOrder.html 
file.

2 Find the section defining the Customer Number field.

The original code looks like this:

3 Add a Forte variable for the CustomerNumber field:

Begin definition of <tr>

Customer Number field <th class="labelmodify" style="width:20%">

Customer Number

</th>

<td class="dataform" style="width:80%">

<input type="text" name="CustomerOrder_qq_CustomerNumber" 
size=40>

</td>

End definition </tr>

value=”$$(FORTE.CustomerNumber)”
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4 Also add an HREF line with the saved URL from the previous section.

The URL will look like this (this is all one unbroken string):

When you paste the URL into the HTML code, substitute the beginning of the string up 
to the first question mark:

with the Forte ExecURL variable:

5 And also substitute the final variable:

with the Forte UniqueID variable:

6 Then add a label (View Customer) for the link at the end of the line.

Your final code should look like this (changes in bold):

7 Close the Insert_CustomerOrder.html file and save your changes.

8 Test your work by repeating Step 1 to Step 4 of the procedure “To capture the URL of the 
Search page mode:” on page 129.

http://your_web_server/web.forte?ServiceName=HTMLtutAppService

&TemplateName=HTMLtutApp/Search_CustomerList.html&ReturnTemplate=
H

HTMLtutApp/Display_CustomerList.html&Action=Clear&Action=Search

&Selection=CustomerList_qq_CustomerNumber

&CustomerList_qq_CustomerNumber=1

&LinkName=HTMLtutApp.CustomerListLink4&Uniquifier=$$(FORTE.Unique
ID)"

http://your_web_server/web.forte?ServiceName...

$$(FORTE.ExecURL)?ServiceName...

Uniquifier=32

Uniquifier=$$(FORTE.UniqueID)

<tr>

Begin definition of <th class="labelmodify" style="width:20%">

Customer Number field Customer Number

</th>

<td class="dataform" style="width:80%">

New Forte variable added

<input type="text" name="CustomerOrder_qq_CustomerNumber" 
size=40 value=”$$(FORTE.CustomerNumber)”>

Modified URL link 
(this is one line

<a href="$$(FORTE.ExecURL)?ServiceName=HTMLtutAppService&Template
Name=HTMLtutApp/Search_CustomerList.html&ReturnTemplate=HTMLtutAp
p/Display_CustomerList.html&Action=Clear&Action=Search&Selection=
CustomerList_qq_CustomerNumber&CustomerList_qq_CustomerNumber=1&L
inkName=HTMLtutApp.CustomerListLink4&Uniquifier=$$(FORTE.UniqueID
)"> 

Add link label View Customer

</a>

End definition </td>
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9 In the Customer Orders nested page, click on the Insert command in the command list 
(left panel).

The Insert mode page shown in Figure 23 on page 126 shows the new View Customer 
link you just created.

10 Click on the View Customer link.

The CustomerList page opens in Search mode:

11 Exit the application.

Step 4. Pass the Selected Field Value
In this section, you modify the Data template of the Customer List page, adding a link to 
the CustomerOrder Insert page and passing the Customer Number of the selected 
customer as a parameter, so that it displays in the Insert page.

� To customize the Data template of the Customer List page:

1 Using the HTML-editing option of your choice, open the Data_CustomerList.html file.

2 Find the first HREF statement.

The original HREF statement looks like this:

Modify the first HREF statement as follows (changes are in bold):

First HREF instance <a class="rowidlist" HREF="$$(FORTE.ExecURL)?ServiceName=HTMLtutA
ppService&TemplateName=HTMLtutApp/Display_$$(USER.TopPage).html&Acti
on=CustomerListHandler.SetCurrentRow&Position=$$(listentry.qqRowN
umber)&Uniquifier=$$(FORTE.UniqueID)" 

target="_fortedisplay"> $$(listentry.qqRowNumber)</a>

First HREF instance specifies 
the target of

<a class="rowidlist" HREF="$$(FORTE.ExecURL)?ServiceName=HTMLtutA
ppService&TemplateName=HTMLtutApp/Insert_CustomerOrder.html&ReturnT
emplate=HTMLtutApp/Display_CustomerOrder.html&Uniquifier=$$(FORTE
.UniqueID)&CustomerNumber=$$(listentry.CustomerList_qq_CustomerNu
mber)"

the new “Use” link target="_fortedisplay">Use</a>
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To summarize the changes:

■ &TemplateName=HTMLtutApp/Insert_CustomerOrder.html identifies the template 
as the Insert mode of CustomerOrder

■ &ReturnTemplate=HTMLtutApp/Display_CustomerOrder.html specifies the Display 
mode of the same page as the return template

■ &Uniquifier=$$(FORTE.UniqueID) defeats the caching mechanism and retrieves a 
“fresh” page

■ &CustomerNumber=$$(listentry.CustomerList_qq_CustomerNumber) passes the 
selected CustomerNumber value as a parameter

■ Use—Adds a new label for each row

For more information on Forte tags, see Chapter 3, “Customizing Generated HTML 
Templates.”

3 Exit the Data_CustomerList.html file and save your changes.

Testing Your Work Before the Final Step
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly. After testing, you will perform the final step, in “Step 5. Remove the 
CustomerOrder-CustomerList Link,” which follows this section.

� To test the work you have done so far:

1 Run the HTMLtutApp application.

2 Navigate to the Customer Orders page and click on the Insert command in the 
command list (left panel).

3 In the Insert mode of the Customer Orders page, click on the View Customer link.

This takes you to the CustomerList page in Search mode.

4 Click on the Search button.

This takes you to the CustomerList page in Display mode, shown in Figure 24 on 
page 126.

5 Click on the Use link of any customer record.

You are returned to the Insert mode of the Customer Orders page, as shown in Figure 25 
on page 126, with the selected customer’s Customer Number showing.

6 Add an order number and date.

Enter the date in the format dd-mmm-yyyy hh:mm:ss (for example, 05-Mar-1999 
00:00:00).

7 Click the Insert button.

You are returned to The Customer Order page.

8 Click on Last Order in the command list.

Your new order appears. (You may have to reload the page to display all the fields.)
Customizing WebEnterprise Designer Applications



Example: Adding a Lookup Reference Page 133
9 Exit the application.

Step 5. Remove the CustomerOrder-CustomerList Link
In this section, you remove the link you created in Step 1. You do this because you use the 
lookup link only when you are inserting a new customer order, as set up in Step 3. 
Therefore, you only want the link to appear on the Insert mode of the CustomerOrder page. 
(If the link remains, it is visible on all modes of the CustomerOrder page.)

� To finish the customization:

1 Open the HTML Application Model Workshop for the HTMLtutApp application.

2 Delete the link between the CustomerOrder page and the CustomerList page.

Your model should look like Figure 26.

Figure 26 HTMLtutApp Model Modified for a Lookup Link

Usage Recommendations
To use this link properly, always select the customer first, by using the Customer View link, 
then add the other customer order data on the Insert page. If you fill in the other fields 
before using the Customer View link, all your data will be lost when you return to the Insert 
page, except for the customer number.

Page used for Lookup Link
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Example: Passing Data with a Command Link
This customization is similar to the previous one (“Example: Adding a Lookup Reference 
Page” on page 126), in that you customize the application to pass a value from a selected 
record to an Insert page. In this example, there is no lookup list to select from; instead, the 
primary key value of the selected order is passed to the Insert page, so that the new record 
will automatically be inserted into the selected order.

What This Example Does
This example modifies the HTMLtutApp tutorial application to add data to a command 
link. As in the uncustomized HTMLtutApp tutorial, the user can choose a customer from 
the Customer page, then navigate to the master-detail page that displays orders for that 
customer. At this point, the user can browse through the orders until she comes to the one 
she wants to insert a line item to:

Figure 27 Selected Customer on Master-Detail Page

The user clicks on the Insert command under the Product Description section (the nested 
LineItem page) to invoke the LineItem Insert page, which displays with the order number 
showing:

Figure 28 LineItem Insert Page Showing Passed Value

Thus, the new line item will be added to the order selected by the user.

Insert command for Line Item

Selected customer order
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Creating the Customization
This section describes how to customize the HTMLtutApp tutorial application to add data 
to a command link. The general steps of this procedure are as follows:

1 Make sure the Insert and Update commands are defined for the page in question.

2 Add a variable to the Data mode of the page to hold the value.

3 Enclose the whole link definition in a “forte iterate” loop to single out one instance of 
the data.

4 Populate the appropriate field on the Insert page with the incoming data.

Step 1. Add Insert and Update Commands (If Required)
The Insert mode of the LineItem page must have Insert and Update commands defined for 
it. These are already defined in the HTMLtutApp tutorial application, as described in 
Getting Started with WebEnterprise Designer. However, if you have not finished the tutorial, 
or are modifying your own application, make sure the page in question has these 
commands.

� To add the Insert and Update commands to a page (if necessary):

1 In the HTML Application Model Workshop for the HTMLtutApp application, open the 
Page Wizard for the LineItem page by double-clicking on the page.

2 Click Next until the Commands page displays.

3 If there are no Insert and Update commands on the page, add them.

The Commands page should look like this (other commands can be missing, but it 
should at least have the Insert and Update commands):

4 Click Finish to apply your changes and close the Page Wizard.

5 Generate code for the model.
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Step 2. Add a Variable to Hold the Value
In this section, you will add code to the Data_LineItem.html template that adds a variable 
to hold the order number data to the Insert command link.

Before beginning this section, please review “Methods for Editing Generated Files” on 
page 125.

� To add a variable to the Insert command link of the LineItem page:

1 Using the HTML-editing option of your choice, open the Data_LineItem.html file.

2 Find the section that defines the link to the Insert mode of the page.

The original code looks like this:

3 Add a variable to hold the order number data.

where:

■ ORDERNUMBER is a local variable

■ listentry.LineItem_qq_OrderNumber is a Forte variable that stores the value of 
ORDERNUMBER

The customized code should look like this (changes in bold):

4 Continue on to the next section without closing the Data_LineItem.html file.

Step 3. Single Out One Instance of the Data
Because LineItem is a list page that could have multiple line items, you need some way to 
single out a single instance of the data. In this section, you will do this by using a “forte 
iterate” loop to the Insert link definition. 

� To add a forte iterate loop:

1 Enclose the code you entered in the previous section in a “forte iterate” loop.

The syntax of the forte iterate loop is:

<td>

Start link definition <a class="alink" HREF="$$(FORTE.ExecURL)?ServiceName=HTMLtutAppSe
rvice&TemplateName=HTMLtutApp/Insert_LineItem.html&ReturnTemplate=H
TMLtutApp/Display_$$(USER.TopPage).html&Uniquifier=$$(FORTE.Uniqu
eID)" target="_fortedisplay">

End link definition  Insert</a>

</td>

Example &ORDERNUMBER=$$(listentry.LineItem_qq_OrderNumber)

<td>

Start link definition <a class="alink" HREF="$$(FORTE.ExecURL)?ServiceName=HTMLtutAppSe
rvice&TemplateName=HTMLtutApp/Insert_LineItem.html&ReturnTemplate
=HTMLtutApp/Display_$$(USER.TopPage).html&Uniquifier=$$(FORTE.Uni
queID)&ORDERNUMBER=$$(istentry.LineItem_qq_OrderNumber)” 
target="_fortedisplay">

End link definition  Insert</a>

</td>

Begin forte iterate loop <!--<?forte iterate listentry entry.list_LineItem start=”1” 
max=”1”>-->

Your application logic here

End forte iterate loop <!--<?/forte iterate listentry>-->
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Your final modified code should look like this (changes in bold):

2 Close the Data_LineItem.html file and save your changes.

Step 4. Populate the Order Number with Incoming Data
In this section, you modify the Insert template of the LineItem page to display the value 
stored in the CUSTOMERORDER variable that you added to the link in “Step 2. Add a 
Variable to Hold the Value” on page 136. 

� To customize the Insert mode of the LineItem page to display the data:

1 Using the HTML-editing option of your choice, open the Insert_LineItem.html file.

2 Find the section that defines the OrderNumber field.

The original code looks like this:

3 Add code to populate Customer Number with values:

where ORDERNUMBER is the variable defined in Step 3 of the previous section.

Your code should look like this (changes are in bold):

4 Close the Insert_LineItem.html file and save your changes.

<td>

Begin forte iterate loop <!--<?forte iterate listentry entry.list_LineItem start=”1” 
max=”1”>-->

Start link definition <a class="alink" HREF="$$(FORTE.ExecURL)?ServiceName=HTMLtutAppSe
rvice&TemplateName=HTMLtutApp/Insert_LineItem.html&ReturnTemplate
=HTMLtutApp/&ORDERNUMBER=$$(listentry.LineItem_qq_OrderNumber)”Di
splay_$$(USER.TopPage).html&Uniquifier=$$(FORTE.UniqueID) 
target="_fortedisplay">

End link definition  Insert</a>

End forte iterate loop <!--<?/forte iterate listentry>-->

</td>

Begin table definition <tr>

of Order Number field <th class="labelmodify" style="width:20%">

Order Number

</th>

<td class="dataform" style="width:80%">

<input type="text" name="LineItem_qq_OrderNumber" size=40>

</td>

End definition </tr>

value=$$(FORTE.ORDERNUMBER)

Begin table definition <tr>

of Order Number field <th class="labelmodify" style="width:20%">

Order Number

</th>

<td class="dataform" style="width:80%">

<input type="text" name="LineItem_qq_OrderNumber" size=40

New variable value=$$(FORTE.ORDERNUMBER)>

</td>

End definition </tr>
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Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly.

� To test the customization:

1 Run the HTMLtutApp application.

2 On the Home page, navigate to the Tip-a-Canoe Customers page.

3 Browse through the customer records and click the Orders for this Customer link for 
some customer.

4 On the Customer Orders nested page, click the Insert link below the Product 
Description.

The LineItem Insert page should display with the correct Order Number showing:

5 Add an Item Number, a PN, and a Quantity.

To test your work accurately, use values for Item Number and PN that exist in your 
database. For example (from the tutorial database):

Item Number: 1
PN: 90003
Quantity: 3

6 Click the Insert button to return to the Customer Orders page.

7 Reload the page to populate the rest of the fields. If you entered the values suggested in 
Step 5, your page should look like this:

New row
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Example: Automatically Populating Data on an Insert Page
This example describes a technique different from the previous example (“Example: 
Passing Data with a Command Link” on page 134) for passing a customer number value 
from a selected Customer to the Insert mode of a CustomerOrder page. This example 
creates an additional CustomerOrder page, then uses a variable created by WebEnterprise 
Designer to pass the value to the Insert and Update modes of this page.

What This Example Does
In the uncustomized HTMLtutApp tutorial, if a user wants to add an order to a particular 
customer, he invokes the Insert mode of the Customers page, which displays with all fields 
blank. If he does not remember the number of the particular customer he selected, he must 
return to the Customers page for the information.

In this customization, you add a new CustomerOrder page, called NewOrder, to the 
application and link it to the Customers page. When you run the application and navigate 
to the Tip-a-Canoe Customers page, you activate the link to the new page, which goes to 
the Insert mode of the page and passes the customer number value with the link. Figure 29 
shows an example display:

Figure 29 Insert Mode of NewOrder Page

Creating the Customization
This section describes how to customize the HTMLtutApp tutorial application to pass a 
CustomerNumber field value to the Insert mode of a CustomerOrder page. The general 
steps of this procedure are as follows:

1 Add a new business class page, the NewOrder page, to the model, based on the 
CustomerOrder business class; link it to the Customers page.

2 Customize the generated NewOrder Insert template to populate the CustomerNumber 
field with an incoming value.

Use a variable automatically created by WebEnterprise Designer to hold the value.

Step 1. Add a NewOrder Page to the HTMLtutApp Model
This section describes how to modify the HTMLtutApp model as the first step in 
automatically populating an Insert page.

� To modify the HTMLtutApp model:

1 Open the HTMLtutApp application in the HTML Application Model Workshop.

2 Create a form page based on the CustomerOrder class.

Selected customer’s number
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3 On the Page Options page of the Page Wizard, enter:

Business Class: CustomerOrder
HTML Page Name: NewOrder

(It does not matter what you enter in the Page Title field because you will only access 
the Insert mode of this page, which does not display the page title.)

4 Click Next until you reach the Field Properties page.

5 Add spaces to the field labels as shown and click Finish:

6 Add a command link between the Customer page and the NewOrder page.

7 Open the Link Properties dialog and enter or set these values:

Label: Add Customer Order
Display: CustomerOrder record(s) associated with selected Customer
Activate Link On: Separate Label
Start on: Insert Page

The Link Properties dialog should look like this:

Add spaces in the field labels
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8 Click OK to apply these values and close the dialog.

Your model should look like this:

Figure 30 HTMLtutApp Model with Additional CustomerOrder Page

9 Generate the application code.

At this point, you can test the application and insert orders by clicking the Add Customer 
Order link. However, none of the fields are populated with values yet, so you have to enter 
them manually. The next step shows you how to populate the Customer Number field with 
the value from the selected customer.

Step 2. Add a Variable to Hold the Value
As part of the generated HTML code, WebEnterprise Designer creates the variable you will 
use to hold the CustomerNumber value. This variable is NewOrder_qq_CustomerNumber, 
which is created in the Data template of the Customer page as part of the coding required 
to satisfy the link’s display option (CustomerOrder record(s) association with Customer). 
The code in Data_Customer.html page looks like this:

You will use the NewOrder_qq_CustomerNumber variable to populate the Customer 
Number field on the NewOrder Insert page with the Customer Number value of the 
customer selected on the Customer page.

Before beginning this section, please review “Methods for Editing Generated Files” on 
page 125.

Added CustomerOrder page

<td>

<!--<?forte if CustomerHandler.HasCurrentRow>--><a class="alink" 
href="$$FORTE.ExecURL?serviceName=HTMLtutAppService&;templateName=H
TMLtutApp/Main_NewOrder.html&;StartingPage=Insert&;ReturnTemplate=H
TMLtutApp/Display_NewOrder.html&;Action=Clear&;Action=Search&;Selec
tion=NewOrder_qq_CustomerNumber&;NewOrder_qq_CustomerNumber=$$(list
entry.Customer_qq_CustomerNumber)&;LinkName=HTMLtutApp.NewOrderLink
3&;Uniquifier=$$(FORTE.UniqueID)" target="_top">Add Customer 
Order</a>

<!--<?forte else>-->Add Customer Order<!--<?/forte if>-->

</td>
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� To populate the Customer Number value in the NewOrder Insert page:

1 Using the HTML-editing option of your choice, open the Insert_NewOrder.html file.

2 Find the table definition for the CustomerNumber field.

The original code looks like this:

3 Add code to populate Customer Number with values:

where NewOrder_qq_CustomerNumber is the variable defined in the 
Data_Customer.html template.

Your code should look like this (changes are in bold):

4 Close the Insert_NewOrder.html file and save your changes.

5 Regenerate the application’s code.

Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly.

� To test the customization:

1 Run the HTMLtutApp application.

2 On the Home page, navigate to the Tip-a-Canoe Customers page.

3 Browse through the customer records and choose one.

4 Click on the Add Customer Order link.

The Insert NewOrder page should display, as in Figure 29 on page 139, with the 
Customer Number of the selected customer showing.

Begin table definition of <tr>

Customer Number field <th class="labelmodify" style="width:20%">

Customer Number

</th>

<td class="dataform" style="width:80%">

<input type="text" 
name="CustomerOrder_qq_ReqCustomerNumberze=40>

</td>

End definition </tr>

value=$$(FORTE.NewOrder_qq_CustomerNumber)

Begin table definition of <tr>

Customer Number field <th class="labelmodify" style="width:20%">

Customer Number

</th>

<td class="dataform" style="width:80%">

<input type="text" name="LineItem_qq_OrderNumber" size=40

New variable value=$$(FORTE.NewOrder_qq_CustomerNumber)>

</td>

End definition </tr>
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Example: Adding a Drop List for Entering and Formatting Dates
In the uncustomized HTMLtutApp tutorial application, one of the fields on the Customer 
Orders page requires a date value, but the application provides no help on the Insert page 
regarding date format. If a user enters the date in any other than a DD-MMM-YYYY 
HH:MM:SS format, she will get an error.

This customization solves this problem by creating drop lists with month, day, and year 
values for entry of new customer orders.

What This Example Does
In this customization, when the user invokes the Insert mode of the Customer Order page, 
it is displayed with drop lists in the Requested Date field for month, day, and year:

Figure 31 Requested Date Field Formatted with Drop Lists

The user fills in the other fields, then uses the drop lists to specify the requested date. When 
she clicks the Insert button, the Customer Order~LineItem page is displayed, showing the 
new order with the correct date format:

Figure 32 Inserted Customer Order Showing the Date

Drop lists for date elements

Correct date format
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Creating Date-Formatting Drop Lists
This section describes how to customize the HTMLtutApp tutorial application to substitute 
drop lists for the date definition in the Insert template of the CustomerOrder page. The 
general steps of this procedure are as follows:

1 Customize the Insert template of the CustomerOrder page, replacing the table 
definition of the Requested Date field with HTML code that builds three drop lists for 
Month, Day, and Year.

2 Customize the BeforeInsert method to:

■ build the DateTimedata object with the values from the drop list

■ modify the RequestedDate attribute in the underlying business class 
(CustomerOrderClass)

■ continue the normal WebEnterprise Designer processing

Step 1. Define Drop Lists for Date Elements
In this section, you will make changes to the Insert_CustomerOrder.html page to include a 
drop list for the three parts of the date, and provide appropriate data for each list.

Before beginning this section, please review “Methods for Editing Generated Files” on 
page 125.

� To define drop lists for the Requested Date field:

1 Using the HTML-editing option of your choice, open the Insert_CustomerOrder.html 
file.

2 Find the table definition for the RequestedDate field.

The original code looks like this:

3 Replace the definition line (beginning <input type=”text”) with HTML code defining 
three drop lists.

Your code should look like this (changes are in bold):

Begin table definition of <tr>

Requested Date field <th class="labelmodify" style="width:20%">

Requested Date

</th>

<td class="dataform" style="width:80%">

<input type="text" name="CustomerOrder_qq_RequestedDate" 
size=40>

</td>

End definition </tr>

Begin table definition of <tr>

Requested Date field <th class="labelmodify" style="width:20%">

Requested Date

</th>

<td class="dataform" style="width:80%">

Begin Month drop list 
definition

<select name="Month" size="1">

Begin Month values <OPTION value="Jan">Jan

<OPTION value="Feb">Feb

<OPTION value="Mar">Mar

<OPTION value="Apr">Apr
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4 Save and close the Insert_CustomerOrder.html file.

Step 2. Override the BeforeInsert Method
You want to prevent the user from inserting a blank value for the Requested Date field. 
Therefore, you will make changes to the page handler’s BeforeInsert method. 

In this section, you use a customization point in the Page Handler Customization Wizard to 
create a BeforeInsert method for the CustomerOrderHandler class (which will override the 
ExpressClassHandler.BeforeInsert method). You then customize the method as described.

� To override the BeforeInsert method for this customization:

1 Open the HTMLtutApp model in the HTML Application Model Workshop.

2 Start the Page Handler Customization Wizard for the CustomerOrder page, as described 
in “Customizing a Generated HTML Template” on page 53.

3 Open the Whole Object Operations category, then the Database Operation subcategory.

4 Double-click on the “Insert: Before sending an insert object request” customization 
point.

If this is the first customization you are making to this class, WebEnterprise Designer 
displays a confirmation dialog to expand the class hierarchy to include a customizable 
class for this class page. Click OK.

The Method Workshop opens, displaying an override of the BeforeInsert method.

<OPTION value="May">May

<OPTION value="Jun">Jun

<OPTION value="Jul">Jul

<OPTION value="Aug">Aug

<OPTION value="Sep">Sep

<OPTION value="Oct">Oct

<OPTION value="Nov">Nov

<OPTION value="Dec">Dec

End Month definition </select>

Begin Day drop list definition <select name="Day" size="1">

Begin Day values
<option>01<option>02<option>03<option>04<option>05<option>06

<option>07<option>08<option>09<option>10<option>11<option>12

<option>13<option>14<option>15<option>16<option>17<option>18

<option>19<option>20<option>21<option>22<option>23<option>24

<option>25<option>26<option>27<option>28<option>29<option>30

<option>31

End Day definition </select>

Begin Year drop list definition <select name="Year" size="1">

Year values <option>1999<option>2000<option>2001

End Year definition </select>

</td>

End definition </tr>
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5 Add the following code to the end of the method body:

6 Compile the method, close the Method Workshop and the Customization Wizard.

Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly.

� To test the customization:

1 Run the HTMLtutApp application.

2 On the Home page, navigate to the Tip-a-Canoe Customers page.

3 Browse through the customer records and click the Orders for this Customer link for 
some customer.

Remember the customer number this customer.

4 Click the Insert command in the left pane of the page.

The Customer Order Insert page is displayed and should show the new date drop lists. 

5 Enter the customer number from Step 4, and a fictitious order number.

Do not enter an order number from the tutorial database (1002-1006), because it will 
raise an error.

6 Use the drop lists to enter a date and click the Insert button.

The nested Customer Order~LineItem page is displayed.

7 Navigate to the new order and reload the page.

The new order should resemble Figure 32 on page 143.

TheMonth : Textdata = request.findNameValue(‘Month’);

TheDay : Textdata = request.findNameValue(‘Day’);

TheYear : Textdata = request.findNameValue(‘Year’);

TheDate : Textdata = new(Value=TheDay.value);

TheDate.concat('-');

TheDate.concat(TheMonth.value);

TheDate.concat('-');

TheDate.concat(TheYear.value);

InsertDate : DateTimedata = new (value=TheDay.value);

Client.LogAttr(source, 
attr=CustomerOrderQuery.ATTR_REQUESTEDDATE);

CustomerOrderClass(source).REQUESTEDDATE.Setvalue(InsertDate);
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Example: Removing a JavaScript Validation from a Page Mode
WebEnterprise Designer allows JavaScript for field validations, and provides several sample 
validations for your use. Users can also create their own JavaScript validations. All 
JavaScript validations must exist in the $FORTE_ROOT/userapp/http/cl0/scripts/validate 
directory. The tutorial chapter in Getting Started with WebEnterprise Designer describes 
how to add a JavaScript validation as a possible enhancement to the HTMLtutApp 
application.

When you generate code for an application that has a field validation, WebEnterprise 
Designer performs the following actions:

■ generates a Scripts_bus_class_page.html file that contains all JavaScript functions for the 
page, including:

■ invoking the selected JavaScript

■ adding a selected field to the Web page

■ modifies the Insert, Search, and Update templates of bus_class_page page to call the 
JavaScript functions (from the Scripts_bus_class_page.html file)

Sometimes you do not want the validation applied to all the pages by default. This 
customization shows you how to remove the validation from a specific page mode 
template.

What This Example Does
This example modifies the HTMLtutApp application by applying the IsAlphabetic 
validation to the Customer Name field of the Customer page. This validation is a JavaScript 
script that enforces that only alphabetical characters can be entered into the field. This is a 
reasonable restriction when inserting or updating a name field, but presents an 
inconvenience on the search page, where Forte normally allows the percent sign (%) as a 
wildcard character. If the IsAlphabetic validation is enforced on the Search page, this 
character will raise an error

Figure 33 IsAlphabetic Validation Error

This customization shows you how to avoid this problem by deleting the unwanted 
validation from the Search template of the Customer page.

Entering a wildcard character
raises an error
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Creating the Customization
This section describes how to add a validation to a field in the HTMLtutApp tutorial 
application, and then how to remove it from the Search template of that page. The general 
steps of this procedure are as follows:

1 Add the IsAlphabetic JavaScript validation provided by WebEnterprise Designer to the 
Name field of the Customer page.

2 Modify the Search template of the Customer page, commenting out the line that 
invokes the validation script and substituting a plain field definition.

Step 1. Apply the JavaScript to a Customer Page Field
In this section, you apply the IsAlphabetic validation to the Name field of the Customer 
page.

� To set a validation on the Name field of the Customer page:

1 Open the HTMLtutApp application in the HTML Application Model Workshop.

2 Double-click on the Customer page to open the Page Wizard.

3 Click Next until you reach the Field Validation page.

4 Select Name in the field name window.

5 Select JavaScript from the Validation Option’s drop list.

6 Select IsAlphabetic from the Script Name’s drop list.

The Field Validation page should look like this:

7 Click Finish to apply your changes and close the Page Wizard.

8 Generate the application’s code.

At this point, you can run the application and test the validation by attempting to type a 
non-alphabetic character in the Name field on an insert, update, or search page. Hint: the 
validation’s warning message pops up when you attempt to leave the field after typing 
something in, including tabbing to the next field, or clicking the cursor anywhere outside 
the field.
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Step 2. Remove the JavaScript Validation 
from a Template
This section describes how to remove the JavaScript validation from the Search template of 
the Customer page. Before beginning this section, please review “Methods for Editing 
Generated Files” on page 125.

� To remove the validation from the search template:

1 Using the HTML-editing option of your choice, open the Search_Customer.html file.

2 Locate the table definition for the Name field.

The original code looks like this:

3 Comment out the JavaScript call.

4 Add a new line to add the Name field to the Search page.

Your modified code should look like this (changes in bold):

5 Close the Search_Customer.html file and save your changes.

6 Regenerate the application’s code.

Note The complete Search_Customer.html file is provided as an example in “Example: 
Customizing a Field on a Search Page” on page 79 of Chapter 3, “Customizing Generated 
HTML Templates.”

Begin table definition of <tr>

Name field <th class="labelmodify" style="width:20%">

Name

</th>

<td class="dataform" style="width:80%">

Call to <script language="JavaScript">

JavaScript validation Select_Customer_qq_Name(’Customer_qq_Name’,’Name’,’qqNone’);

End call </script>

</td>

End definition </tr>

Begin table definition of <tr>

Name field <th class="labelmodify" style="width:20%">

Name

</th>

Begin comment <!--

<td class="dataform" style="width:80%">

<script language="JavaScript">

Select_Customer_qq_Name(’Customer_qq_Name’,’Name’,’qqNone’);

</script>

End comment -->

Field definition added <input type="text" name="Customer_qq_Name" size=40>

</td>

End definition </tr>
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Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly.

� To test the customization of the JavaScript validation:

1 Run the HTMLtutApp application.

2 Navigate to the Tip-a-Canoe Customers page.

3 To test that the validation still works on a page not customized, click Insert in the 
command list.

4 Enter some non-alphabetic characters and press the Tab key.

The validation’s warning message should appear:

Figure 34 Validation Working on Insert Page

5 To test that the validation was removed from the search page, return to the Customers 
page and click Search in the command list.

6 Enter a non-alphabetic character in the Name field, for example J%, and press the Tab 
key.

If you entered J%, you are automatically returned to the Customers page, showing that 
two records were returned (there are two customers with names beginning with “J” in 
the HTMLtutApp database). This demonstrates that your customization of the search 
page is working, and the validation was removed.
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Example: Displaying the Record Just Inserted
When a user inserts a new record, by default WebEnterprise Designer places it at the end of 
the result set. When the display page is redisplayed, the record just entered is at the end of 
the list and frequently not visible. In many cases, it would be more convenient for the user 
to see the record he just entered immediately displayed on the display page. This 
customization causes this to happen.

What This Example Does
This example uses the HTMLtutApp tutorial application, customizing the DoInsert method 
to specify that the first visible row will be the newly-inserted record.

Thus, when you enter a new record:

Figure 35 Entering a New Customer Record

after you click the Insert button, this record is immediately displayed on the Customer 
display page:

Figure 36 New Record Displayed

Creating the Customization
This section describes how to use the Customization Wizard to override the 
ExpressClassHandler.DoInsert method in the page handler class of the Customer page to 
specify that the most recently-entered record displays immediately after insert. 

Before beginning this customization, please review “Customizing With the Page Handler 
Customization Wizard” on page 51. Alternatively, you can read the online Help topic found 
under the Help index entry “Customize:Page Handler.” 
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� To code this customization with the Customization Wizard:

1 Open the HTMLtutApp application in the HTML Application Model Workshop.

2 Start the Page Handler Customization Wizard for the Customer page.

3 Open the Processing Commands category.

4 Double-click on the “Insert: Inserting a new object in the result set” customization 
point.

If this is the first customization you are making to this class, WebEnterprise Designer 
displays a confirmation dialog to expand the class hierarchy to include a customizable 
class for this class page. Click OK.

The Method Workshop opens, displaying an override of the DoInsert method.

5 Add the following code to the end of the method body:

The whole method body should look like this (changes in bold):

6 Compile the method and close the Method Workshop.

7 Close the Page Handler Customization Wizard.

8 Regenerate code for the application.

Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly.

� To test the DoInsert method customization:

1 Run the HTMLtutApp application.

2 Navigate to the Tip-a-Canoe Customers page.

3 Click the Insert command in the command list (left pane).

The Insert Customer page appears.

4 Enter valid data in all the fields, for example:

Customer Number: 4
Name: Alfred E. Newman
Address: 123 Main St.
Phone: 456-1234

5 Click Insert.

The Customer display page should appear, showing this record, as shown in Figure 36 
on page 151.

pagedata.FirstVisibleRow = pagedata.data.items;

super.DoInsert(request=request, response=response, 

parameters=parameters, rset=rset, pageData=pageData);

pagedata.FirstVisibleRow = pagedata.data.items;
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Example: Validating a Whole Form
By default, WebEnterprise Designer allows a user to leave fields blank when submitting an 
insert, update, or search. This section and the one that follows present customizations that 
prevent a user from leaving a particular field blank when submitting an insert. The example 
in this section uses a JavaScript script and other modifications to the HTML template. 

Note This example validates multiple fields when the form is submitted (when the user presses 
the appropriate command button). To validate an individual field at data entry time (when 
the user tabs out of the field after entering data), see “Example: Making a Field Mandatory” 
on page 158.

What This Example Does
This customization example modifies the HTMLtutApp tutorial application to force a user 
to enter data in the PN (part number) and Description fields when inserting a new record 
in the Tip-a-Canoe Products page. 

Figure 37 Restricted Fields on Insert Page

For example, if a user leaves one of these field blank, when she clicks the Insert button, an 
error message pops up, specifying the constraint:

Figure 38 Restricted Field Error Message

Creating a Field Constraint with JavaScript
This section describes how to add a constraint to a field by using modifications to an HTML 
template. The modifications include adding JavaScript code and modifying the existing 
HTML code. The general steps of this procedure are as follows (all modifications are to the 
Insert mode template of the Part2 page):

1 Add the JavaScript script to the HTML page.

2 Add a value attribute to the field descriptions.

3 Modify the Insert button

Restricted fields (cannot be null)
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JavaScript Boilerplate
The JavaScript code used for this example is based on the following a JavaScript boilerplate 
script. You can use this boilerplate as a starting point for your own validation script.

Step 1. Add the JavaScript Validation to the Template
In this section, you add a JavaScript validation script to the Insert_Part2.html template.

Before beginning this section, please review “Methods for Editing Generated Files” on 
page 125.

� To add a JavaScript validation script to restrict non-null field entry:

1 Using the HTML-editing option of your choice, open the Insert_Part2.html file.

2 At the top of the file, immediately after the <head> tag, enter the following JavaScript 
code (modifications to the boilerplate script are in bold):

Start script <SCRIPT LANGUAGE="JavaScript">

Start Field Validation validation function fieldvalidation(form) {

Contains allblanks function allblanks(form)

//Add functions as needed. Each function corresponds to a field

function1(form)

}

Boilerplate for specifying function allblanks(form) {

a function affected by the if((function1(form)) {

validation. form.submit()

}

Begin condition if field fails if((function1(form) == false{

compose(form)

}

}

Creates error window function compose(form) {

Text of error message var text = "You forgot to fill in correctly the following 
field(s):"

if(function1(form) == false) {

Rest of text for function1 text += "\n your Message"

}

alert(text)

}

Defines the function1 fn function function1(form) {

that checks that a if (form.FieldName.value == "") {

specific field is not blank. return false

False returned if field }

is empty. else {

Otherwise True returned return true

}

}

End script </SCRIPT>

<SCRIPT LANGUAGE="JavaScript">
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3 Save your work, but do not close the file.

This script will be invoked every time the user submits an insert form. If all fields pass the 
validation, the form is submitted; otherwise, the error message is displayed.

function fieldvalidation(form) {

allblanks(form)

ispartnumber(form)

isdescription(form)

}

function allblanks(form) {

if((ispartnumber(form) && isdescription(form))) {

form.submit()

}

if((ispartnumber(form) == false || isdescription(form) == 
false)) {

compose(form)

}

}

function compose(form) {

var text = "To correctly insert the Part you must enter the 
correct 

value in the following field(s):"

if(ispartnumber(form) == false) {

text += "\n Part number"

}

if(isdescription(form) == false) {

text += "\n Description"

}

alert(text)

}

function ispartnumber(form) {

if (form.Part2_qq_PartNumber.value == "") {

return false

}

else {

return true

}

}

function isdescription(form) {

if (form.Part2_qq_Description.value == "") {

return false

}

else {

return true

}

}

</SCRIPT>
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Step 2. Add a Value Attribute to the Field Descriptions
In this section, you add a value attribute to each field that will be validated and initialize it 
to “. We will later access this attribute in our JavaScript script.In this example, you add the 
attribute to the PN and Description fields.

� To add a value attribute to the validated fields:

1 Further along in the Insert_Part2.html template, find the section describing the fields.

2 Add the value attribute as follows (modification is in bold):

3 Make the same change for the Description field.

4 Save your work, but do not close the file.

Step 3. Modify the Insert Button
In this section, you make changes to the Insert button so that it calls the JavaScript script 
before the form gets submitted.

� To modify the Insert button:

1 Towards the end of the Insert_Part2.html template, find the line section specifying 
values for the Insert button.

2 Add code that calls the validation script.

You code should look like this (changes in bold):

3 Save your work and close the Insert_Part2.html template file.

Begin table definition of <tr>

PN field <th class="labelmodify" style="width:20%">

PN

</th>

<td class="dataform" style="width:80%">

<input type="text" name="Part2_qq_PartNumber value="" 
size=40>

</td>

End definition </tr>

Begin table definition of <tr>

PN field <td class="buttons">

<INPUT TYPE="button" VALUE="INSERT"

Add call to script onClick="fieldvalidation(this.form)">

</td>

End definition </tr>
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Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly.

� To test the customization of the JavaScript validation:

1 Run the HTMLtutApp application.

2 Navigate to the Tip-a-Canoe product list page.

3 Click the Insert command in the command list (left pane) to display the Insert page.

4 Enter data in every field except the PN or Description field.

For example:

5 Click the Insert button.

The error message window should pop up, as shown in Figure 38 on page 153.
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Example: Making a Field Mandatory
By default,WebEnterprise Designer allows a user to leave fields blank when submitting an 
insert, update, or search. This section describes a customization that prevents a user from 
leaving a particular field blank when submitting an insert. The implementation described 
in this example uses a TOOL customization. 

Note You could also write a JavaScript function to accomplish the same thing. You would install 
it in the validation scripts directory (${FORTE_ROOT}/userapp/http/clx/scripts/validate), 
and then select it as a JavaScript validation option in the Validation Options page of the 
Page Handler. 

What This Example Does
This customization examples modifies the HTMLtutApp tutorial application to ensure that 
a user enters data in the Customer Number field when inserting a new record in the Tip-a-
Canoe Customers page. 

Figure 39 Restricted Field on Insert Page

For example, if a user inserting a record leaves the Customer Number field blank, when she 
clicks the Insert button, an error page is displayed, specifying the constraint:

Figure 40 Restricted Field Error Page

Restricted field (can not be null)

Original message: 
Invalid value for Customer Number field
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Creating a Field Constraint with TOOL
This section describes how to add a constraint to a field by customizing TOOL code. In this 
particular example, you will customize code to prevent the user from inserting blank values 
into the Customer Number field of the Customer page. 

You will use a customization point in the Page Handler Customization Wizard to create a 
BeforeInsert method for the CustomerHandler class (which will override the 
ExpressClassHandler.BeforeInsert method). 

� To create a field constraint with TOOL:

1 Open the HTMLtutApp application in the HTML Application Model Workshop.

2 Start the Page Handler Customization Wizard for the Customer page.

3 Open the Individual Field Operations category.

4 Double-click on the “Decoding or validating a field” customization point.

If this is the first customization you are making to this class, WebEnterprise Designer 
displays a confirmation dialog to expand the class hierarchy to include a customizable 
class for this class page. Click OK.

The Method Workshop opens, displaying an override of the BeforeInsert method.

5 Add the following code to the beginning of the method body:

The GetFieldName method returns the name of the Customer Number field of the 
Customer page.

6 Compile the method, close the Method Workshop and the Customization Wizard.

if ((GetFieldName ( assocID=assocID, fieldIndex=fieldIndex) = 

‘Customer_qq_CustomerNumber’) and (value=NIL or value.value='')) 
then

e : GenericException = new;

e.SetWithParams (SP_ER_ERROR, 

Error message text. 'Invalid value for Customer Number field');

task.ErrorMgr.AddError(e);

raise e;

end if;
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Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly.

� To test the TOOL customization:

1 Run the HTMLtutApp application and navigate to the Customer page.

2 Click the Insert command in the command list (left pane).

3 Enter data in every field except the Customer Number field.

For example:

4 Click the Insert button.

The error message page should display, as shown in Figure 40 on page 158.
Customizing WebEnterprise Designer Applications



Drop List or Radio List Example: Entering Lookup Information Manually 161
Drop List or Radio List Example: 
Entering Lookup Information Manually

Drop lists and radio lists require a stored value and a display value for each option in the 
list. When you specify this type of validation on a page field (in the Page Wizard), you can 
use the attributes of a business class (a “Lookup class”) to supply these values. These values 
are created at runtime. When you generate code for the application, WebEnterprise 
Designer generates a file that is populated with the stored and displayed values.

If you leave the Lookup class, display field, and stored field unspecified, WebEnterprise 
generates a Lookup file without values, and you must populated the file with data 
manually. This example describes how to do this.

What This Example Does
This customization modifies the HTMLtutApp tutorial application by adding a drop list to 
the Picture field of the Product List (Part2) page, so that the user can select a title from a 
drop list rather than having to type in a long file specification string.

Figure 41 Customized Drop List

Note The next customization, “Drop List and Radio List Example: Removing <Not Selected> and 
<None>” on page 165, shows you how to remove the <Not Selected> option from the drop 
list.

Creating the Customization
This section shows you how to customize a drop list that is not linked to the attributes of a 
business class. The general steps of this procedure are as follows

1 Add the drop list validation to the gifAddress field of the Part2 business class page.

2 Generate code so that WebEnterprise Designer generates a lookup file.

3 Modify the lookup list in the lookup file, adding displayed and stored values for each 
option.

Step 1. Add a Drop List Validation to the Field
In this section, you set up for the customization by adding a drop list validation on the 
gifAddress (Picture) field of the Part2 page.

� To add a drop list validation to the gifAddress field:

1 Open the HTMLtutApp application in the HTML Application Model Workshop.
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2 Double-click on the Part2 page to display the Page Wizard.

3 Click the Next button repeatedly until you reach the Field Validation page.

4 Select the gifAddress field in the field name pane.

5 From the Validation Option drop list, select Droplist.

6 Leave Lookup Class, Displayed Field, and Stored Field unspecified. The Page Wizard 
Field Validation page should look like this:

7 Click Finish to apply your changes and close the Page Wizard.

Step 2. Generate the Lookup File
Now, you must generate the lookup file.

� To generate a lookup file:

1 Regenerate the application’s code.

2 Test the validation by running the application.

3 Navigate to the Tip-a-Canoe Products page.

4 Click on the Insert, or Update command in the command list (in the tutorial, you 
removed this field from the Search page; otherwise, you could choose Search, too).

The appropriate page mode appears. The Picture field on the Insert or Update pages 
should contain three values:

These are the default values defined in the lookup file when there is no lookup class 
defined for the validation.

5 Exit the application.

Step 3. Customize the Lookup File with Your Values
In this section, you will modify the generated lookup file and add the values for your list. 
You can use the Page Handler Customization Wizard to access the file. For information, see 
“Methods for Editing Generated Files” on page 125.
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There are five graphic files provided for the HTMLtutApp tutorial. You will use the fully-
defined file specification for the files as the stored values. The displayed values will be 
labels for the five pictures.

� To customize the lookup file:

1 Using the Page Handler Customization Wizard, open the Part2_qq_gifAddress.inc file.

The file is found in the Lookup Data Files category of the Wizard. This category only 
exists when the application contains a drop list or radio list validation. Open the file by 
selecting it and clicking the Customize button.

The original code looks like this:

2 Modify the NumValues value to the number of values you will have.

For this example, specify five values:

3 Specify whether the lookup list will have a <NULL> value or not.

For this example, we do not want a <NULL> value, so comment out the null value 
line(s):

4 Replicate the storedValues, and displayedValues lines, so that the total number of paired 
lines matches the NumValues number (in this case, five pairs total).

5 Modify the elements’ indices so that they start at 0 and end in NumValues - 1.

6 Modify the values assigned to storedValues and displayedValues, entering appropriate 
values to the array.

In this example, the storedValues strings are the file specifications for the five graphic 
product files. All files are stored in the /forte/examples/wedtut/images directory.

Note Graphics files for WebEnterprise Designer applications are assumed to be stored under 
the Web server root directory, so their specifications are relative to this directory.

The displayedValues strings will be labels for the files, as follows:

Declare total number of values NumValues = 2;

in the list.

Initialize stored value array storedValues = new Array(NumValues); 

Initialize displayed value array displayedValues = new Array(NumValues);

Null value stored value storedValues[0] = ’qqNULLqqZa047!#$%^_yJk523qqNULLqq’; 

Null value displayed value displayedValues[0] = ’&lt;NULL&gt’;

First non-null value stored 
value

storedValues[1] = ’your stored value’; 

First non-null value displayed 
value

displayedValues[1] = ’your displayed value’;

NumValues = 5;

// storedValues[0] = ’qqNULLqqZa047!#$%^_yJk523qqNULLqq’; 

// displayedValues[0] = ’&lt;NULL&gt’;

File name displayedValues string

canoea.gif Medium Canoe

canoef.gif Large Canoe

paddle1.gif Small Paddle

paddle2.gif Large Paddle

2paddles.gif Pair of Paddles
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Your modified code should look like this (changes are in bold):

7 Close the Part2_qq_gifAddress.inc file and save your changes.

Note Save a copy of the Part2_qq_gifAddress.inc file in another directory. If you make changes 
to the model and regenerate code, this file is replaced with the uncustomized version. 
After regeneration, replace the new file with your saved version.

Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly.

� To test your manually customized lookup file:

1 Start the HTMLtutApp tutorial application.

2 On the home page, click the Product List link to access the Products page.

3 Click Insert to display the Insert mode of the Products page.

4 Enter the following values on the Insert page:

PN: 90005
Description: Basswood Oars
Price 29.99

5 Select the Pair of Paddles option from the Picture drop list.

6 Click the Insert button to redisplay the Tip-a-Canoe Products page.

7 Navigate to the last record.

Your page should look like this:

storedValues[0] = ’/forte/examples/wedtut/images/canoea.gif’; 

displayedValues[0] = ’Medium Canoe’;

storedValues[1] = ’/forte/examples/wedtut/images/canoef.gif’; 

displayedValues[1] = ’Large Canoe’;

storedValues[2] = ’/forte/examples/wedtut/images/paddle1.gif’; 

displayedValues[2] = ’Small Paddle’;

storedValues[3] = ’/forte/examples/wedtut/images/paddle2.gif’; 

displayedValues[3] = ’Large Paddle’;

storedValues[4] = ’/forte/examples/wedtut/images/2paddles.gif’; 

displayedValues[4] = ’Pair of Paddles’;

New record with picture
Customizing WebEnterprise Designer Applications



Drop List and Radio List Example: Removing <Not Selected> and <None> 165
Drop List and Radio List Example:
Removing <Not Selected> and <None>

By default, the WebEnterprise Designer drop list and radio list include <Not Selected> and 
<None> as options. In fact, <Not Selected> is the default option for the drop list, and 
<None> is the default for the radio list. This example describes how to remove these 
options, in case you do not want them in your drop list or radio list.

What This Example Does
This example builds on the customization described in the previous section (“Drop List or 
Radio List Example: Entering Lookup Information Manually” on page 161), removing the 
<Not Selected> default from the drop list on the Insert and Update modes of the Product 
List page. The resulting drop list looks like this:

Figure 42 Customized Drop List

Creating the Customization
You can remove the default options in one of two ways:

■ modify the default option specification in the generated page mode files

■ modify the default option parameter in the Scripts_bus_class_page.html file

You use the same procedures to remove the <None> default from a radio list. The only 
difference is whether in the HTML model you specify a radio list or a drop list field 
validation.

This section describes both techniques. Although the drop list validation used for this 
example was customized manually (in “Drop List or Radio List Example: Entering Lookup 
Information Manually” on page 161), the techniques described here work the same for a 
drop list or radio list that uses values from a Lookup business class.

Drop list without the 
<Not Selected> default option
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Technique 1: Customizing the Page Mode Template
In this section, you customize the Insert and Update templates of the Product List page, 
changing the default selection string into either a nonsensical string or a legal string (that 
is, one of the stored values in the list). If you use a nonsensical value, the default option is 
not displayed; if you use a legal value, that one becomes the default value.

Before beginning this section, please review “Methods for Editing Generated Files” on 
page 125.

� To remove the <Not Selected> option from a drop list:

1 Using the HTML-editing option of your choice, open the Insert_Part2.html file.

2 Locate the table definition for the Picture field.

The original code looks like this:

The “qqNone” is passed to the script as a parameter for the default value to be selected 
in the drop list or radio list.

3 You could either:

■ remove the Select_Part2_qq_gifAddress('Part2_qq_gifAddress','Picture','goaway' 
parameter completely

■ add any string value, for example:

■ add a valid selection that you want to highlight, for example, replace “qqNone” with 
one of the stored values used in “Step 3. Customize the Lookup File with Your Values” 
on page 162:

4 Close and save the Insert_Part2.html file.

5 Repeat Steps 1 through 4 for the Update_Part2.html file.

6 Close the Page Handler Customization Wizard.

7 Go to “Testing Your Work” on page 168 for a description of what your results should look 
like.

Begin table definition of <tr>

Picture field <th class="labelmodify" style="width:20%">

Picture

</th>

<td class="dataform" style="width:80%">

Call to <script language="JavaScript">

JavaScript validation
Select_Part2_qq_gifAddress(’Part2_qq_gifAddress’,’Picture’,’qqNon
e’);

End call </script>

</td>

End definition </tr>

Select_Part2_qq_gifAddress(’Part2_qq_gifAddress’,’Picture’,’go
away’);

Select_Part2_qq_gifAddress(’Part2_qq_gifAddress’,’Picture’,

’/forte/examples/wedtut/images/paddle2.gif’);
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Technique 2: Customizing the Scripts File
This section describes how to implement the same customization of the previous section, 
but modifying the Scripts_Part2.html file instead of the page mode templates.

� To remove the <Not Selected> option from a drop list:

1 Using the HTML-editing option of your choice, open the Scripts_Part2.html file.

2 Locate the line containing the “qqNone” string.

The original code looks like this:

3 Comment this section out:

4 Close and save the Scripts_Part2.html file.

5 Close the Page Handler Customization Wizard.

if (Selected_Value == 'qqNone’) 

document.writeln(‘<option selected value=””>&lt;Not 
Selected&gt;’);

//if (Selected_Value == 'qqNone’) 

//document.writeln(‘<option selected value=””>&lt;Not 
Selected&gt;’);
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Testing Your Work
Now it is time to test your work to verify that you made no mistakes and the customization 
works correctly. 

� To test your drop list customization:

1 Run the customized HTMLtutApp application.

2 From the Home page, click on the Product List link to access the Tip-a-Canoe Product 
List page.

3 On the Product page, click on either the Insert or Update command in the command 
list.

If you substituted a nonsensical string in your customization, the results should look 
like this:

Drop list: No <Not Selected> option, and no default

Radio list: No <None> option, and no default

If you substituted a valid stored value string in your customization, the results should 
look like this:

Drop list: No <Not Selected> option, and the default is the displayed value for the 
paddle2.gif file

Radio list: No <None> option, and the default is the displayed value for the paddle2.gif 
file

No default (displayed value
is first item in list)

Specified default value displayed
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Customizing Application Security
WebEnterprise Designer provides a number of application security models, ranging from 
open access to all pages to restricted page-based access to authenticated users.

This chapter provides information on all types of security customization, including:

■ WebEnterprise session management

■ how to implement a logon procedure to restrict access to authenticated users

■ how to grant application page access based on the authenticated user

■ how to share WebEnterprise session management across several HTML applications

■ other common WebEnterprise security customizations, such as session timeout
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Security and HTML Applications
WebEnterprise Designer’s implementation of security is based on the session management 
feature of WebEnterprise. For complete information on this feature, see A Guide to 
WebEnterprise. 

Normally, the HTTP requests issued by Web browsers are stateless, meaning each request is 
atomic and does not require any knowledge of past (or future) requests. Many simple read-
only Web applications are built in this manner,

More sophisticated applications, such as those created with WebEnterprise Designer, 
require knowledge of the browser client’s state, including such information as intermediate 
data in a multiple-request operation, the username and access rights of the browser client, 
and so forth.

Storing state information for 
standard Forte vs. Web 
applications

In standard Forte window-based applications, you can store state information on both the 
client (using local objects) and the server (using transaction or session dialog duration 
service objects). However, in a Web application, you cannot use either of these 
mechanisms. Instead, you use WebEnterprise session management to enable the 
application to associate all of the browser’s application requests into a session, which 
contains this information. See A Guide to WebEnterprise for more details on session 
management.

Embedding session ids in 
cookies vs. URLs

Sessions are tracked in one of two ways: using Web “cookies” containing a unique session 
id, or embedding the session id directly in all the application URLs. WebEnterprise will 
attempt to use cookies but, if the client’s browser has disabled cookies, will instead modify 
all URLs with session ids. This “cookie detection” happens automatically when a client first 
requests a page from an HTML application; no special action is required.

Managing shopping cart 
applications

One type of sophisticated application, generally known as a “shopping cart” application, 
permits users to enter data into the system. Such applications do not restrict access to the 
individual HTML pages, but must track a sequence of HTML requests together as a 
transaction. When the transaction is completed (for example, by submitting a purchase 
form), the request includes identifying data (such as name, address, and credit card 
information) to ensure that the submission is valid.

The session management used in default WebEnterprise Designer applications supports 
the creation of these shopping cart-style applications. All application pages are accessible 
to all clients. No user logon process is required. Information required to place an order (for 
example, name, address, credit card number, and so forth) can be entered on an order form 
and submitted.

Managing secure 
Web applications

Another type of sophisticated application permits access to specified HTML pages only to 
validated users. Typically, these applications present a logon page, which is presented to 
the user before he can enter the application. The user supplies an “identity” (usually a 
username and password), which, when validated, grants access to the application’s HTML 
pages. The identity becomes a property of each Web request and can be used by the 
application to restrict access to certain pages or activities.

This chapter describes how to customize an HTML application to build this third type of 
“secure” application, including:

■ creating a logon page

■ integrating an application with your own user authentication system

■ granting different levels of application access to different users

■ sharing a WebEnterprise security environment across several HTML applications
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Authenticating Users
When a WebEnterprise Designer application does not have a logon page defined for it, all 
generated HTML templates are defined with the SESSION_AUTOCREATE session property. 
A WebEnterprise session is then automatically created whenever a Web client requests an 
HTML template. This “Web session” is persistent, binding subsequent Web requests from 
that browser client together, until it eventually expires (based on the value of the 
SessionTimeOut attribute). In this scenario, all application pages are accessible without 
any logon or authentication procedure.

For information on the SessionTimeOut attribute, see online help or A Guide to 
WebEnterprise. You can override the default (for WebEnterprise Designer, 60 minutes) in 
WebEnterprise Designer applications with the application-wide “Modify session timeout” 
customization point of the Page Handler Customization Wizard.

Creating the Logon Page
You create your application’s logon page with the HTML Application Model Workshop’s 
Page Wizard.

� To create a Logon page:

1 In the HTML Application Model Workshop for your application, click the New HTML 
Page button.

The Page Wizard appears.

2 Select Logon Page in the page type list and click Next.

The Logon Page Options page is displayed.

3 Modify the fields on the Logon Page Options page as desired.

For information on all the fields on this dialog, press the Help key.

Notice that the default logon page contains two user-supplied fields. If your site's 
security framework requires additional (or fewer) logon fields, you will need to 
customize the generated Logon.html file accordingly. See Chapter 3, “Customizing 
Generated HTML Templates,” for details.

4 Click Finish to create the logon page.

User-supplied
validation fields
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Code Generated for the Logon Page
When you generate code for an application that contains a logon page, WebEnterprise 
Designer generates a LogonHandler TOOL class in the html_modelHandlers project, and 
three HTML templates for the logon page:

■ Logon_logon_page.html 

This template contains the HTML form that is presented to the un-authenticated user 
when they attempt to access any page in the application. You can customize your logon 
page by editing this file.

■ Validate_logon_page.html

This template is requested when the user submits the Logon form. It contains the 
WebEnterprise tag that causes the user authentication data to be validated. 

This page is never actually displayed and need not be edited.

■ LogonFailed_logon_page.html 

If the user’s supplied authentication data fails validation, then this HTML page is 
returned to the user. You can supply an application or company-specific error page by 
editing this file.

If the user is successfully validated, the application’s start page is returned to his or her 
browser. The user then has access to all of the HTML pages in the application. (See below 
for how to add further granularity to your application’s security model.)

How the Logon Page is Activated
For background on this subject, review “ExpressHTTPAccess” on page 32 and 
“ExpressLogonHandler” on page 39.

Creating a logon page has the following effect on the HTML application: Every HTML page 
in the application (except the logon page) is marked with the WebEnterprise 
SESSION_REQUIRED property. This means that the page will not be returned unless the 
client already has a valid WebEnterprise session. If a request is received for one such page 
and there is no valid session (if the request has neither a valid session cookie or session id 
in the URL), then WebEnterprise redirects the request to the Logon_logon_page.html page, 
which is returned to the browser. The Web address of the logon page becomes the 
WebEnterprise SessionCreationURL of the application.

For additional information about the SessionCreationURL attribute, see online help.

� To activate the logon page:

1 The browser user requests the HTML application’s start page (Start.html). 

2 If logon security is implemented in the application, the logon page is returned. 

3 The user enters the appropriate user identification information and submits the form 
(clicks the Logon button).

4 The application validates the information and, if authenticated, creates a 
WebEnterprise session. 

5 The application’s starting page is returned to the browser.

If the user information fails validation, no session is created and the LogonFailed page is 
returned.
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Integrating the Application with an Authentication System
When the user fills out and submits the logon page, the 
ExpressLogonHandler.HandleCondition method is invoked. This method calls the 
application’s html_modelAccess.LogonSession method to authenticate the data entered on 
the logon page. If the logon is successful, then:

■ WebEnterprise creates a WebEnterprise session and attaches it to the Web response

■ if LogonSession returns a “credentials” object, then it is attached to the WebEnterprise 
session using the name “Logon-Credentials.” 

During processing of subsequent requests, these credentials can be retrieved by means 
of the HTTPSession.GetSessionData method.

By default, the LogonSession method returns a value of TRUE, indicating that the user is 
permitted to create a session and access the application’s pages. Adding security to your 
HTML application requires you to customize the LogonSession method. 

Your html_modelAccessService.LogonSession method captures the parameters entered on 
the logon page and passes them to your own user authentication subsystem (such as an 
LDAP service, the Windows NT user authentication system, or an X.500 server) for 
validation. LogonSession should return the boolean TRUE if the user’s logon is validated, 
and FALSE if not. You can optionally return a “credentials” object containing any user-
specific data (username, group, and so forth) that your application requires.

Use the Page Handler Customization Wizard to customize the logon page.

� To customize an application’s logon page using the Customization Wizard:

1 Open your application in the HTML Application Model Workshop.

2 Select the logon page.

3 Choose the Component > Customize… command to open the Wizard.

The Page Handler Customization Wizard appears.

4 Select the “Logon Validation” customization point and click Customize.

The Method Workshop opens, displaying the LogonSession method. This method 
overrides the HTTPAccess.LogonSession method. 

5 Add your TOOL code to authenticate the user information and, optionally, place 
persistent user information into the credentials object.

Customization point for logon page
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Example: Adding LogonSession Code
For this example, assume that a SecuritySO service object exists containing an Authenticate 
method that can validate a username-password pair with an external authentication 
subsystem. This method also returns a “Rights” object that contains credential 
information. The Rights object might, for example, denote various levels of permitted 
access that restricts some page access to certain users. 

The LogonSession method might look like this:

LogonSession(request: HTTPRequest, output credentials: Object): 
boolean

//

// LogonSession

// The LogonSession method is used to validate a new session.

// LogonSession should return TRUE if the logon information is

// valid, signalling that the session may be created. FALSE

// should be returned if the logon information is invalid and

// the session creation request should be rejected.

//

// request

// The request parameter holds the HTTPRequest object of

// the HTTP request that is attempting to create a new

// session.

// Default logon forms will have ‘Username’ and ‘Password’

// parameters.

//

// credentials

// The credentials parameter is used to return 
authentication

// information. It will be attached to the session using 
the

// descriptor ‘Logon-Credentials’ if the session is

// successfully created. Subsequent requests may use the

// GetSessionData method of the HTTPSession object using

// the ‘Logon-Credentials’ descriptor to retrieve the

// credentials object.

// return value

// TRUE - logon validated; session may be created.

// FALSE - login rejected.

//

//

begin

credentials = NIL;

//

// First retrieve the data entered on the Logon page

//

userName : TextData = request.FindNameValue(‘Username’);

passWord : TextData = request.FindNameValue(‘Password’);
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// Now call our authentication subsystem to validate the user

// (actual implementation is site-specific)

//

if SecuritySO.Authenticate(userName, passWord, credentials) = FALSE 
then

return FALSE;

end if;

//

// The credentials object will be stored with the HTTPSession.

// It can be retrieved via

// GetSessionData(IntegerData(value=’Logon-Credentials’))

//

return TRUE;

end method;
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Restricting Access to Application Pages
This section shows what you can do with authentication credentials for a WebEnterprise 
Designer client after you have captured them.

A common application requirement is granting different levels of application access to 
different users or groups of users. This section explores a technique for solving this 
problem. Building on the example in the previous section, the example in this section will 
restrict “update” and “insert” access to users who are managers.

Use the Page Handler Customization Wizard to customize the appropriate page of the 
application.

� To restrict access to a page:

1 Open your application in the HTML Application Model Workshop.

2 Select the page you wish to restrict access to.

3 Choose the Component > Customize… command to open the Wizard.

The Page Handler Customization Wizard appears.

4 Select the “Restricting access to the insert page mode” customization point and click 
Customize.

The Method Workshop opens, displaying the RestrictInsertAccess method in the page 
handler class of the selected page. This method overrides the 
ExpressHandler.RestrictInsertAccess method. The customizable section of this method 
is near the bottom and looks like:

Customization points for
restricting access to pages

if (not restrict) then

//

// Add custom code here to compute restrictions:

//

// restrict = . . .

end if;
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Assume that the “credentials” object saved in the above section is a TextData object with 
values of either “Manager” or “Worker”. To permit access only to managers, replaces the 
above block with the following code:

5 Add the identical customization for the “Restricting access to the update page mode” 
customization point. 

Only managers can now modify the application page.

You can customize each application page in this manner to restrict access to individual 
page modes (namely, search, display, insert, and update) or to all page modes. Users who 
request a page that is denied to them receive an appropriate error page.

if (not restrict) then

credential : TextData =

TextData(response.CurrentSession.GetSessionData(

TextData(value=’Logon-Credentials’)));

if (credential.Compare(source=‘manager’,ignorecase=TRUE) <> 
0) then

restrict = TRUE;

end if;

end if;
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Sharing a Security Environment Across HTML Applications
WebEnterprise Designer supports designs that span multiple HTML applications. One 
HTML model can include another, thus providing links between related applications. The 
WebEnterprise Help system describes how to include one HTML application in another 
(refer to the topic “New Included HTML Application Model”).

WebEnterprise supports several different security designs for included applications. 
Consider an HTML Model “MainModel” that includes a second HTML Model, 
“SubsidiaryModel.” Assume that MainModel implements a logon page that restricts access 
to the application. For queries within MainModel, full WebEnterprise security will be in 
effect. But what happens when a user clicks on the link from a MainModel application page 
to the SubsidiaryModel page? It depends.

A Web application that 
includes another application 
has security leaks

The default WebEnterprise Designer security model grants open access to all pages to all 
users. Therefore, unless you employ one of the mechanisms described below, users 
jumping to a SubsidiaryModel page are not bound by MainModel’s WebEnterprise security 
environment. When the user jumps back to the MainModel application, the requested 
pages are again governed by the existing MainModel session.

Alternative 1: Give both 
applications a logon page

One alternative is to define logon pages in both SubsidiaryModel and MainModel. In this 
case, each HTML application then implements its own independent session management. 
When users first accesses a MainModel page, they are required to logon. When they 
subsequently jump to a SubsidiaryModel page, they are again required to logon, this time 
starting a SubsidiaryModel session. When they return to a MainModel page, they resume 
running within their existing MainModel session. 

Note In this security model, because the two applications each implement their own session 
management environment, they can use different authentication subsystems and enforce 
security in completely different ways.

Alternative 2: Let all 
applications share the session

A more sensible security model lets the SubsidiaryModel (and any other included 
applications) share the WebEnterprise session initiated by the main application, 
MainModel. MainModel defines a logon page, performs authentication, and implements 
session management for itself and all applications sharing its session management 
environment.

Sharing session management between a main HTML model and one or more secondary 
models requires customization of each HTML model, as described next.
Customizing WebEnterprise Designer Applications



Sharing a Security Environment Across HTML Applications 179
Customizing Subsidiary HTML Models to Share Security
Follow these procedures with each subsidiary model.

� To customize subsidiary models to share the security environment:

1 In each subsidiary application, create a logon page. 

This page will never be returned to the user, so there is no need to customize the 
generated LogonSession method. 

2 Customize each subsidiary application’s logon page using the Page Handler 
Customization Wizard. 

Use the “Is subsidiary application” customization point under the Application group. 
This action creates an html_modelAccess.IsPrimarySession method, which does not 
require any change.

Customizing the Main HTML Model to Share Security
Follow these procedures to customize the main HTML application model.

� To customize the main model to share the security environment:

1 Implement an authenticated logon page in the MainModel, using the procedures 
described in “Authenticating Users” on page 171.

2 Customize the main application’s logon page using the Page Handler Customization 
Wizard. 

Use the “Define subsidiary applications” customization point under the Application 
group. This creates an html_modelAccess.ConnectManagedSessions method.

3 The lower part of the method contains a block of code that you must now modify to add 
each subsidiary application to the ManagedSessions array. 

For example, if the main application will manage two subsidiary applications, Sub1 and 
Sub2, then add their Access service objects to ManagedSessions, as shown: 

ManagedSessions = new;

//

// User code should be added here to populate the managedSessions 
array

// with references to the ExpressHTTPAccess service objects of the 

// subsidiary applications.  Replace subsidiaryAccessService with 

// subsidiary application’s AccessService service object.  Add 
additional

// lines as necessary to specify other subsidiary applications.

//

ManagedSessions.AppendRow( Sub1AccessService );

ManagedSessions.AppendRow( Sub2AccessService );

super.ConnectManagedSessions;
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Restrictions
Ensure that all HTML applications that share a common session manager are also all 
accessed through the same Web server. The Fortecgi Location and, if specified, Plug-in URL 
properties for all linked HTML applications must reference the same Web server URL.

The ConnectManagedSessions method overridden in “Customizing the Main HTML Model 
to Share Security,” above, must execute after each of the subsidiary Access services has 
completed initialization. The ConnectManagedSession template contains a method call to 
delay for 20 seconds before referencing the subsidiary Access services:

In some networked configurations, this delay might be insufficient. If the referenced 
objects are not completely instantiated, then a distributed access exception will be raised. 
In that case, you should increase the length of the delay appropriately.

Summary
The above implementation will cause a single session manager to be created, shared by the 
three HTML applications. A single logon page is presented to the user, governing access to 
all application pages.

//

// This is so that the managed applications’ ExpressHTTPAccess 
service

// have a chance to complete their startup.

// On some systems you may need to increase the delay to allow 
sufficient

// time for the managed applications’ startup to complete.

//

task.delay(20000); // 20-second delay
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Session Timeout
In this section, you will learn how “session timeout” works in a WebEnterprise Designer 
application, and how you can customize this feature.

How Session Timeout Works
WebEnterprise creates a session when a user at a browser first accesses a WebEnterprise 
Designer application. Objects required to track the session, including current database 
result sets, are then associated with the session and reside within Forte services.

Web applications generally do not have a “Logout” procedure; the user simply moves on to 
a different Web site, or closes their browser, or goes home. In each case, the Web 
application receives no notification that the user is done with the application. Web 
applications, then, must decide for themselves when a user’s session can be deleted.

How WebEnterprise stops 
applications that time out

WebEnterprise defines a SessionTimeOut for each application (or, set of applications when 
the security environment is shared). Each client request updates a timestamp in its 
HTTPSession object. WebEnterprise periodically scans all managed sessions, identifies 
those that have been inactive for longer than the SessionTimeOut value, and deletes the 
session and any data associated with it.

For information on the SessionTimeOut attribute, see online help for either 
HTTPSession.SessionTimeOut or SessionMgr.SessionTimeOut. For additional information, 
see A Guide to WebEnterprise. 

Consider the case of a user sitting at a browser window using a WebEnterprise Designer 
application. She has successfully gone through the Logon process and is navigating 
through the application. She has entered a Search page and selected a data set, the first 10 
rows of which are displayed on her screen. She goes to lunch, returning an hour later. She 
sits at her workstation and clicks the application’s Next button. What happens?

How a user resumes a 
timed-out application

While she was enjoying her Curried Prawns, WebEnterprise realized that her session “timed 
out” and deleted her HTTPSession object. It now receives a request that contains the 
previously-valid session id. But, not finding it in its cache of sessions, WebEnterprise does 
what it always does when a request without a valid session is received: it returns the logon 
page. Our user, perceptively realizing that she must start over, re-enters her username and 
password, is authenticated, enters search criteria, and resumes her work.
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Finding the Ideal Setting for Session Timeout
The “ideal” setting for SessionTimeOut varies from application to application. If it is set too 
low, users may find their session invalid when they answer a short phone call. Requiring 
the user to logon again after a short distraction will not endear the user to the application.

On the other hand, each active session does entail a cost, namely, the memory required to 
store the HTTPSession object and any data associated with the session. For WebEnterprise 
Designer applications, the data sets associated with business queries may be substantial. 
The WebEnterprise partition may find itself running out of memory if it must manage a 
large number of active sessions, each with a large amount of session data.

You can adjust the memory profile of WebEnterprise Designer applications in a variety of 
ways:

■ boost the partition’s available Forte memory by setting the FORTE_GC_SPECIAL 
environment variable

■ reduce the amount of session data by restricting the number of rows fetched into the 
intermediate result set

By default, WebEnterprise Designer fetches and caches 100 rows of data.

■ when designing application pages, select very long fields in pages that are used 
infrequently

■ customize the application to reduce session timeout

See the next section for information on this suggestion.
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Example: Customizing Session Timeout
The default session timeout for WebEnterprise Designer applications is one hour. In 
practice, however, due to the frequency with which session expiration is checked, an 
inactive session could remain in memory for slightly less than two hours before it is deleted 
(if the user issued a request shortly after a check, it would not be a candidate for the next 
check, since, by that time, 60 minutes had not yet passed; therefore, it would not be deleted 
for yet another 60 minutes).

� To change the session timeout:

1 Start the Page Handler Customization Wizard for the logon page, as described in 
“Integrating the Application with an Authentication System” on page 173.

2 Open the Application category and select the “Modify session timeout” customization 
point and click Customize.

The Method Workshop opens, displaying a customizable SetSessionManagement 
method. This method overrides the ExpressHTTPAccess.SetSessionManagement 
method. 

3 Locate the line of code that defines the SessionTimeout value:

timeOut is an IntervalData object. Change the value string to a different, valid 
IntervalData value. When the application is next executed, all sessions will observe the 
new session timeout interval.

timeOut.SetValue(’00:00:00:01:00:00’);
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Other Security Customizations
A WebEnterprise Designer application’s security framework is primarily defined within a 
single method: ExpressHTTPAccess.SetupSessionManagement. If your application requires 
security customizations not described in this chapter, then it may be necessary to override 
and modify this method. For details on WebEnterprise security and session management, 
see A Guide to WebEnterprise.
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Chapter 9
Partitioning and Deploying a
WebEnterprise Designer

Application
This chapter provides information about the elements of a distributed WebEnterprise 
Designer application and how to partition and deploy a WebEnterprise Designer 
application.

Topics in this chapter include:

■ WebEnterprise Designer application projects 

■ WebEnterprise Designer application service objects

■ how to make a default partitioning configuration

■ how to test the application in a distributed environment

■ how to deploy a WebEnterprise Designer application

■ how to start a WebEnterprise Designer application

For complete information on Forte partitioning and deployment, see A Guide to the Forte 
4GL Workshops and the Forte 4GL System Management Guide.
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About Partitioning a WebEnterprise Designer Application
After generating your code for your HTML application and making any desired 
enhancements, use the Partition Workshop to:

■ test the application in a distributed environment

■ partition the final application for deployment and make the appropriate application 
distributions

The following sections provide background information about the projects and the service 
objects in the HTML applications, and the default partitioning scheme Forte provides for 
WebEnterprise Designer applications.

About HTML Application Projects and Service Objects
As described in Getting Started with WebEnterprise Designer, when you generate the code 
for your HTML application model, two or more Forte projects are created:

Use the “Handlers” project 
to partition the application

The “Handlers” project generated from the HTML application model is the main project for 
the application. The “Services” project generated from the business model functions as a 
supplier project to the main project. Therefore, when it is time to test your application in a 
distributed environment or partition the application for deployment, you must partition 
the “Handlers” project.

WebEnterprise Designer applications frequently consist of multiple business models and 
multiple HTML models. A Services project is generated for each business model, and a 
Handlers project is generated for each HTML model. Whenever an HTML model references 
a business model, the generated Handlers project will include the generated Services 
project as a supplier. If an HTML model includes another HTML model, then the generated 
Handlers project for the first model will include the generated Handlers project for the 
second model as a supplier. 

When you partition your HTML application using the Partition Workshop, Forte creates a 
default configuration for the application based on the application’s service objects. Both 
the “Handlers” and “Services” projects contain service objects that affect this default 
configuration. 

Briefly, the service objects in your HTML applications are: 

Project Name Description

html_modelHandlers The main project for the application.

business_modelServices A supplier project for the “Handlers” project. There is one “Services” project for 
each business model that is a supplier to the HTML application model.

Service Object Partition Visibility
Dialog 
Duration Description

html_modelAccessService Forte Web 
Access 
Server

Environ-
ment

Session

(can be 
changed)

The application contains one AccessService 
service object per model, which provides the 
primary link between a Web browser and 
the Forte application. It responds to HTTP 
requests from the Web client by returning 
the appropriate Web page.

html_modelScannerService Forte Web 
Access 
Server

User Session The application contains one ScannerService 
service object per model, which responds to 
HTTP requests from AccessService by 
opening the HTML template file in the 
request and processing the Forte tags to 
generate a Web page. The Scanner will 
always be in the same partition as the 
AccessService with which it is associated.
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A pair of service objects is generated for each model in the application. The service objects 
of included HTML models are by default partitioned with the corresponding service objects 
of the main model, though they can be put in other partitions.The following two sections 
provide further information about these service objects.

business_modelServices Service Objects
See A Guide to Forte Express and Customizing Forte Express Applications for complete 
information about the business_modelServices service objects service_nameService and 
service_nameDBService.

One business_modelService service object and one business_modelDBService service object 
are generated for each business model. These are generated into the 
business_modelServices project. The HTMLtutApp application’s one business model 
supplier is the HTMLtutorial business model, whose generated service project is therefore 
the HTMLtutorialServices project. Two service objects are generated into this project, 
namely:

■ HTMLtutorialService

■ HTMLtutorialDBService

About replicating 
these services

These service objects work together to manage database interaction. You can replicate 
these services, which is desirable for any of the following requirements:

■ You want to distribute processing in the deployment environment.

■ You want to provide different replication options (load balancing or failover) for 
different service objects.

■ You want your application to interact with more than one database.

Each service is bound to a particular database session, so you must create a separate 
service for each database you wish to access. You can then assign the corresponding 
service objects to the nodes that have the appropriate resources.

Creating new services You create new services in the Business Model Workshop, using the Component > New 
Service command (described in A Guide to Forte Express). Each time you create a new 
service, Express adds a Service service object and a DBService service object to your 
application. 

If you have multiple business models in your application, you must consider your 
application usage patterns to determine how best to partition the business model services. 
Technote 10467, which you can access from Forte’s Support and Services Web page, 
provides a discussion of this subject.

service_nameService Application 
Server

Environ-
ment

Message The application contains one Service service 
object for each Forte Express service defined 
in the Business Model Workshop. You can 
change the replication of this service object 
to provide load balancing and/or failover.

service_nameDBService Application 
Server

User Session The application contains one DBService 
service object for each Service service 
object. The DBService service object will 
always be in the same partition as the 
Service service object with which it is 
associated.

Service Object Partition Visibility
Dialog 
Duration Description
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html_modelHandlers Service Objects
See Chapter 1, “WebEnterprise Designer Application Architecture” for information on the 
superclasses on which the html_modelHandlers services are based, namely HTMLScanner 
and HTTPAccess. These are found in the HTTP library. For complete information on all 
WebEnterprise Designer and WebEnterprise projects and libraries, see Forte online help.

One html_modelAccessService service object and one html_modelScannerService service 
object are generated for an HTML application. These are generated into the 
html_modelHandlers project. These service objects work together to field HTTP requests 
from the client browser by way of the Web server. The html_modelAccessService and 
html_modelScannerService are bound together, and will always be in the same partition. 
The ScannerService is user-visible and therefore can be referenced only by the 
AccessService in the same partition. The AccessService retains a reference to a session 
object for each user, which includes the user’s result set. The ScannerService refers to the 
result set when processing a page.

Partition AccessService on 
Forte server platforms only

When you partition your HTML application, you must assign the partition that contains 
the AccessService service object to a Forte server node. You cannot assign the AccessService 
service object to a client node.

The AccessService can be 
replicated for failover and 
load balancing

The AccessService service object can be replicated for load balancing or failover. (Failover 
happens whether you replicate or not if Autostart is enabled; you might want to replicate 
for failover if Autostart is disabled, however.) If the replicates are partitioned to different 
nodes, they can all use the same unique port number (the WebEnterprise Listening Port 
number) assigned to the application when it was created.

When there are multiple AccessService service object replicates partitioned to the same 
node, each replicate must be assigned a unique port number. This is achieved by specifying 
a range of port numbers with the FORTE_WW_PORTS environment variable. If 
FORTE_WW_PORTS is set, the HTTPAccess service object randomly selects a port number 
from the range and uses it as the listening port number. When a user first accesses a 
WebEnterprise Designer application from a browser, the request is routed to one of the 
replicates. A cookie is sent back to the browser with the necessary information to get back 
to the same replicate. Subsequent requests will include that cookie, so that the user will be 
routed to the replicate that includes her session object.

The syntax for this environment variable is:

FORTE_WW_PORTS startrange-endrange

The startrange and endrange numbers should be set to integer values between 1025 and 
65535, and must designate ports that will not be in use on the node when the deployed 
application is run. For example: 

setenv FORTE_WW_PORTS 6100-6300

The ScannerService service object is bound to the AccessService service object. Each 
replicate of the AccessService service object has its own copy of the ScannerService service 
object.

Compile the partitions We recommend that the partitions that contain the AccessService and the ScannerService 
service objects be compiled, to provide improved performance for the partition. 

Caution If you compile the partition that contain an AccessService and a ScannerService service 
object, you must be sure to install the compiled HTTP library in the deployment 
environments where your Forte HTML application will be running. The partition that 
contains these service objects needs to access the HTTP library, and if that partition is 
compiled, the HTTP library that it uses must also be compiled. See the WebEnterprise 
Installation Guide for information about the compiled HTTP libraries that are provided as 
part of the WebEnterprise product.
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If you have multiple HTML models, there will be a pair of service objects for each model. If 
you are running the application on a machine with native threads, you may choose to 
include the AccessService and ScannerService service objects from multiple models in the 
same partition.

Relationship Between the Service Objects
The interactions between the four service objects in the HTML application are shown in 
Figure 43, below:

1 The AccessService service object receives HTTP requests for pages from fortecgi or a 
Forte Web server plug-in on the Web server. 

2 The AccessService service object invokes a method on the ScannerService service 
object, requesting the appropriate page and passing any parameter values relevant to 
the page.

3 The ScannerService opens the requested HTML page template and processes the Forte 
tags to create the page, and executes methods, which may request data from the 
database.

4 Database requests are sent to the business service application server where the 
DBService provides the database session used by the Service service object to access the 
database. 

5 Result sets are returned to the ScannerService, which processes them and populates the 
page template with the result set. The entire result set is cached in the service in case 
the user needs to browse through the result set.

6 The ScannerService sends the requested page information back to the AccessService 
service object. 

7 The AccessService service object delivers the HTML information to the Web server, 
which passes it to the client Web browser and displays the page.

Figure 43 illustrates:

Figure 43 Relationship between AccessService, ScannerService, Service, and DBService
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On the application server partition, the DBService service object is a user-visible DBSession 
service object, private to the partition. The Service service object is an environment-visible, 
shared object in the application. The user-visible service object can be accessed only 
through the environment-visible service object—other partitions cannot access it directly. 
The DBService service object is protected from inappropriate access, because no other 
partitions can access it. 

The same relationship that exists between the two business model service objects also 
exists between the HTML model service objects. The ScannerService service object is user-
visible and private to the partition, and the AccessService service object is environment-
visible and shared. 

Creating a Default Partitioning Configuration
When Forte partitions an application, it assigns all compatible service objects to the same 
partition. Forte assigns the Express business model service objects to one partition and the 
WebEnterprise service objects to another. 

Exceptions to 
default configuration

The default partitioning will be altered if any of the following conditions are true:

■ any of the service objects have replication turned on

Replication is discussed in A Guide to WebEnterprise.

■ external resource managers for the service objects differ in type or location

This could occur if pages are built from multiple business models that have different 
resource managers. (See the Forte 4GL System Management Guide or Getting Started 
with WebEnterprise Designer for information on setting a resource manager for a 
business model.) In this case, the Partition Workshop assigns each server partition to 
the node where the required external resource is installed.

See A Guide to the Forte 4GL Workshops for information on the Partition Workshop and 
partitioning in general.

� To partition an HTML application:

1 In the Repository Workshop, select the html_modelHandlers project and click the 
Partition button.

Alternatively, you can choose the Plan > Run > Partition command. Or, you can open 
the html_modelHandlers project and click the Partition button or choose Run > 
Partition from there.

The Partition Workshop is displayed with the default configuration for the HTML 
application. Figure 44 shows the default configuration for the WebEnterprise Designer 
tutorial example.
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Figure 44 Default Configuration for HTMLtutApp

The client partition is
a development-only tool

The client partition (html_modelHandlers_Cl0_Client) is used to keep the server partitions 
running in the development environment and launch, if selected, the browser window. In a 
deployed environment, it has no function. Because of this, the process of deploying and 
running a WebEnterprise Designer application is different from other Forte applications. 
The WebEnterprise Designer process is described in “Deploying the Application” on 
page 193.

Unassigned service objects If you have any DBService service objects in the application that cannot be supported in 
the current environment (for example, because the appropriate database resource is not 
defined in the environment), both the DBService service object and its corresponding 
Service service object will be unassigned. To run your application in this environment, you 
must either update the DBService service object definition so it can be assigned to a 
partition, or you must define the appropriate resource manager in your environment. (See 
A Guide to Forte Express for information about updating the DBService service object 
definition.) You can then assign the partition to the appropriate node. 

Common variants to the 
default configuration

There are several changes you might wish to make to the default configuration:

■ replicate the AccessService service object for load balancing and/or failover and mark 
the assigned partition to be compiled

■ replicate business service object partitions for load balancing and/or failover, and mark 
the assigned partitions to be compiled

Modifying the Configuration
The same methods and considerations that apply to other WebEnterprise applications 
apply to WebEnterprise Designer applications. Please refer to Getting Started with 
WebEnterprise Designer for information on modifying your HTML application 
configuration. Remember to set the FORTE_WW_PORTS variable if you replicate the 
AccessService SO partition on the same node. Refer to “html_modelHandlers Service 
Objects” on page 188 for more information.

Environment drop list

Logical partitions browser

Logical partitions

Assigned partitions browser
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Testing the Application in a Distributed Environment
Once you have put the HTML application through a test run from the HTML Application 
Model Workshop, you should test it in a distributed environment from the Partition 
Workshop. 

� To test run an HTML application in distributed mode from the Partition Workshop:

1 In the Partition Workshop (displaying the html_modelHandlers configuration), click the 
Run button.

Alternatively, you can choose the Run > Run command. 

2 When you are done testing the application, exit it and close the Partition Workshop.

If you are unable to exit the application, you can use the Run > Cancel Run command at 
any time to cancel execution. 

This command cancels the client partition for the application. The remote partitions 
will still continue to run; use the Run > Stop Remote Partitions command to stop 
remote partitions.

� To test run your application in distributed mode from other workshops:

Note You can only do this after you have partitioned your application once.

1 In the Repository Workshop, select the HTMLtutAppHandlers project and choose Plan > 
Run > Run Distributed.

Alternatively, open the html_modelHandlers project and choose Run > Run Distributed.

2 When you are done testing the application, exit it and close the Partition Workshop.

If you are unable to exit the application, you can use Plan > Run > Cancel Run 
(Repository Workshop) or Run > Cancel Run (Project Workshop) at any time to cancel 
execution. 

This command cancels the client partition for the application. The remote partitions 
will still continue to run; use the Run > Stop Remote Partitions command to stop 
remote partitions.

See A Guide to the Forte 4GL Workshops for further information about testing applications 
in a distributed environment.
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Deploying the Application
To deploy a WebEnterprise Designer application, you must partition the application for 
each deployment environment in which it will run. After the application is correctly 
partitioned, you must create a separate distribution for each deployment environment.

The application distribution is a representation of the application outside the repository—
you use the application distribution to install the application in an environment.

� To deploy your HTML application:

1 In the Repository Workshop, double-click the main project (the html_modelHandlers 
project) for your application.

This opens the Project Workshop for the html_modelHandlers project.

2 In the Project Workshop, choose the File > Configure as > Server command.

This opens the Partition Workshop for the html_modelHandlers project.

Note If, after configuring for deployment, you want to modify this application and run it from 
the development environment, you must reconfigure the html_modelHandlers project 
as a client. (And then you must redistribute your application.)

3 In the Partition Workshop, select the desired environment from the environment drop 
list, if it is not already selected.

The Partition Workshop opens the configuration for the project or creates a default 
configuration if one does not already exist. 

4 Modify the configuration as desired.

See A Guide to WebEnterprise for information on modifying the default configuration.

5 When your configuration is the way you want it, use the File > Make Distribution 
command to make the application distribution.

Forte displays the Make Distribution dialog.

Figure 45 Make Distribution Dialog

6 Specify where you want the application distribution files placed by selecting an item 
from the drop list. 

Location where you want Forte to
place application distribution files.
The choice is Local or Remote.
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7 Specify whether to perform a Partial Make or Full Make distribution.

The first time you make a distribution, you should choose the Full Make option. 
Subsequently, you can choose Partial Make. A Partial Make creates the distribution only 
for those components that have changed since the last make.

Note If any of your partitions are compiled and you wish to use the Auto-Compile option of 
the Make Distribution command, you must ensure that your environment is set up for 
automatic compilation. (See the Forte 4GL System Management Guide for information 
on setting up your environment for automatic compilation.) If your environment is not 
set up for automatic compilation, you must compile the partitions by hand (see A Guide 
to the Forte 4GL Workshops for information about compiling partitions).

You should also make sure that you have marked the appropriate service objects as 
compiled.

8 Click the Make button.

Forte creates the distribution files and installs them on your machine. When finished, 
Forte displays the following message to inform you that the distribution is complete.

9 If you are deploying in more than one environment, select the next environment, make 
modifications to the configuration if necessary, and use the File > Make Distribution 
command to create the distribution.

Making the Application’s Template Files Accessible 
to the ScannerService SO

Your HTML template files that Forte generated in subdirectories of the document root 
directory must be accessible to the ScannerService service object. If you have replicated 
this service object, these files must be accessible to all replications. 

Note This does not apply to the document root/.base directory or its files. These are for 
development purposes only. For information on the .base directory, see “Generated 
Maintenance Files and Directory” on page 71.

To make the application’s generated template files accessible to the ScannerService service 
object, you must copy them to the node where the Scanner’s partition exists, in the 
directory specified by the document root property for that application.
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Copying the Application’s Template 
Files to the Scanner Partition
You can copy the document root directory containing the subdirectory of the application’s 
templates from your development environment to the environment of your Scanner 
Service partition using either of the following techniques:

■ Copy the application’s template file directory from one environment to the other using 
file copy, FTP, or any other methods of your operating system.

You can perform this copy either before or after deployment.

■ After you make the distribution, but before you install it, copy the application’s template 
file directory into the Scanner Service partition folder under the 
$FORTE_ROOT/appdist/partition_id directory.

At deployment time, the files will be copied into the partition’s machine. 

The partition_id directory name is constructed from the partition name in the Partition 
Workshop. For example, the partition containing the ScannerService service object in 
Figure 44 on page 191 is named HTMLtutAppHandlers_Cl0_Part1. The partition_id 
directory will be named HTMLtu1.

For complete information on this technique, see the Forte 4GL System Management 
Guide.

Once the template files are on the target node, either move them to the location specified 
by the application’s document root, or set the document root to the directory the files are 
in. The next section provides information on setting a WebEnterprise Designer 
application’s document root.

Setting Document Root on the 
ScannerService Service Object Partition
The Scanner Service must be aware of the top-most directory of the copied files. This top-
most directory is called the document root. You can set the value of an HTML application’s 
document root using any of the following methods, given in order of precedence:

1 Use the -docroot command-line argument when starting the partition containing the 
ScannerService service object.

2 Set the value of the FORTE_WW_DOCUMENT_ROOT environment variable.

This must be defined in portable (not local) file syntax (such as 
“%{FORTE_ROOT}/html/docs”).

3 Set the value of the DocumentRoot attribute of the ScannerService service object in the 
HTML model properties.

4 Use the default value, which is “%{FORTE_ROOT}/html/docs.”

Note These methods and priorities regarding the value of document root are slightly different 
than those discussed in A Guide to WebEnterprise, and apply specifically to WebEnterprise 
Designer.
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Running the Application
After you have deployed your application, you can run it.

� To run a deployed HTML application:

1 Start the Environment Console.

If you did not enable the Install in Current Environment option when you created your 
distribution (see Figure 45 on page 193), first load (using File > Load Distribution) and 
then install (using Component > Install) the application.

2 Double-click the node on which you made the distribution to open it.

Alternatively, select the node and choose Component > Open.

3 From the node window, click the triangular control to display the node’s contents.

4 Select the application and click the Start Up button.

Alternatively, select a server partition and choose Component > Start Up. 

When the partitions are marked “online,” your application is running. When the 
AccessService service object starts up, it will register itself with the Web server. Your Web 
server needs to be running when the AccessService partition starts.

5 Start your browser, if it is not already running.

6 Type in a URL with the following syntax:

Note that this is all one string with no breaks. You obtain the values for the variables in 
this string from the HTML Application Properties dialog, as shown in Figure 46. It is also 
found in the log for the Access partition.

[pluginURL|fortecgiURL]?servicename=WebEservicename

&templatename=htmlappname/Start.html
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Figure 46 Obtaining URL Elements from the Properties Dialog

For example, a string using the values in Figure 46 would be:

See the Forte 4GL Programming Guide for complete information about partitioning 
applications and making distributions. See the Forte 4GL System Management Guide for 
information on using the Environment Console.

Caution Because all Forte Web applications use the HTTP library, it must be installed in all 
deployment environments where the Web application is deployed. If any of the partitions 
in your Web application that access the HTTP library are compiled, the compiled form of 
the HTTP library must be installed in the deployment environment. WebEnterprise 
provides the HTTP library in both interpreted and compiled forms for installation in 
deployment environments. See the WebEnterprise Installation Guide for information. The 
library must be installed on any Forte node that runs a partition that includes an 
AccessService service object.

When installing compiled 
HTTP libraries on UNIX

If you install the compiled HTTP libraries on UNIX, follow these instructions: after you 
have compiled a partition that accesses the compiled HTTP library, do not move the 
compiled HTTP library (for example, by moving $FORTE_ROOT to a different disk or 
directory). If you do move the library after the partition is compiled, you must re-compile 
the partition so the partition and library can be correctly linked. 

When installing compiled 
HTTP libraries on NT

If you install the compiled HTTP libraries on NT, you need to add the 
$FORTE_ROOT/userapp/http/cl0 directory to the “PATH” environment variable.

pluginURL
fortecgiURL

WebEservicename

htmlappname

http://henna.forte.com/web.forte?servicename=HTMLtutAppService

&templatename=HTMLtutApp/Start.html
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The AccessService Log File
When the partition that includes the AccessService is started, its log file will include 
messages indicating that it has been successfully connected to the Web server, and give the 
starting URL for the application. the partition log; for more information, see the Forte 4GL 
System Management Guide. 

The following message indicates that this service started successfully:

The following message indicates the starting page for the application:

If your application includes multiple HTML models, there will be several such messages. 
Your users will only need to know the starting URL for the main model. If that model 
references other models, its links will have the proper URL.

Memory Considerations
Because of the nature of Web applications, the result set of data for a user is maintained in 
memory in the partition that includes the AccessService. The AccessService holds a session 
object for each user that includes that result set. The session object will be cleared and 
garbage collected when the session times out (which, by default, is irrespective of whether 
the user exits the browser or otherwise quits the application). The default session timeout 
is set with the ExpressHTTPAccess.SetupSessionManagement method. For a WebEnterprise 
Designer application, the timeout default is one hour. 

You can change the application’s timeout setting with the Page Handler Customization 
Wizard customization point “Modify session timeout” under the Application category. 

When you set the maximum memory for partitions that include an AccessService, you must 
take the timeout setting into account, as well as the number of concurrent users you will 
have and the average size of the result sets they will work with. See the Forte 4GL System 
Management Guide for information on setting the memory parameters for a partition. 

Enable access to HTMLtutAppService at port 6203 from 
http://henna.forte.com/cgi-forte/fortecgi.exe (plugInURL = 
http://henna.forte.com/web.forte)

*** URL of starting page = 
http://henna.forte.com/web.forte?ServiceName=

HTMLtutAppService&TemplateName=HTMLtutApp/Start.html
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and processing custom fields 67
customization 145, 159

BeforeSearch method 67

BeforeUpdate method 67

bus_class_pageHandler class, See Page 
handler classes

business_modelServices project 186

businessClass_qq_attribute.inc file 163

BusinessClass class
attribute IDs 62
InstanceStatus attribute 62
record status 62

Business classes, transferring data between 
pages and 37

BusinessClass objects
and attribute IDs 62
and InstanceStatus attributes 62
and their UpdateQuery attribute 63
checking whether updated 63
undoing changes 63
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Business class pages
generated HTML templates, fancy 73
generated HTML templates, generic 70
generated HTML templates, simple 72
modeling as a lookup page 127
restricting access to 176
transferring data between classes and 37

BusinessClient class, Revert method 63

Business models, generated service objects 186–190

Business rules, customizing 65

Business services, generated service objects 186–190

buttonlogon style element 107

buttons style element 107

C
captionform style element 107

captionlist style element 107

captionlogon style element 107

captionmenu style element 107

class identifiers
and page styles 105
scope 106

Class interaction diagram of WebEnterprise Designer 
classes 28

Code generation directives
and customization 92
and page design templates 91
description 91
page object 100

command syntax conventions 13

Component menu
New Service command 187
Open command 196
Start Up command 196

Configure as Server command 193

ConnectManagedSessions method 179

Cookies, in WebEnterprise applications 170

cool.css file, location 104

CSS1 style sheets, See Styles

CurrentRow attribute 39

Customizable classes
and ExpressHTTPAccess 33
automatically creating 50
deferring deletion 56
deleting page handler classes 54

Customization examples
adding a lookup link 126
adding data to command links 134
creating a drop or radio list manually 161
customizing a page design 93
customizing logon validation 173
customizing styles 108
displaying the record just inserted 151
entering and formatting dates 143
list of examples in examples chapter 124
managing subsidiary applications 179
mandatory field 158
modifying session timeout 183
populating data on an Insert page 139
removing a validation from a page mode 147
restricting access to pages 176
setting or removing a radio or drop list 

default 165
whole field validation 153

Customizations, preserving
file types in .base directory 77
function of .base directory 76
HTML changes only 76
lookup files 164
model changes 76
model changes, conflicting 77
summary 76

Customizing application security
customizing login validation example 174
customizing main models 179
customizing session timeout example 183
customizing subsidiary models 179
integrating with an authentication system 173
restricting access to pages 176
sharing security environment across 

applications 178
using logon pages 173

Customizing error pages
and HTMLScanner.GetErrorTemplate 

method 119
and HTTPAccess.GetErrorTemplate method 121
application-specific error template example 120
application-specific template with custom data 

example 120
creating your own 118
default error processing steps 114
error class-error template mapping 114
error directory 114
errors in customization 122
modifying default error pages 118
page design templates for 88
result set variables 116
with the Customization Wizard 118
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Customizing generated HTML templates
customizing a field on a search page 79
customizing font size on a data page 81
identifying hidden fields 75
identifying WebEnterprise tags 75
identifying WebEnterprise variables 75
linking to the Insert page URL 129
passing a selected value as a parameter 131
preserving customizations, See Customizations, 

preserving
removing validation from a single template 147
setting or removing a radio or drop list 

default 165
types of customization 74
using a variable from the calling page’s Data 

template 141
when customizing styles 109
where and where not to customize 74
whole field validation 153
without the Customization Wizard 125

Customizing generated lookup files
manually customizing drop lists or radio lists 161
preserving customizations 164
without the Customization Wizard 125

Customizing generated scripts files
setting or removing a radio or drop list 

default 165
without the Customization Wizard 125

Customizing page designs
bad selector errors 100
code generation errors 99
customizing menus 95
description of code generation directives 91
elements of design files 88
example 93
identifying a design in the Page Handler 

dialog 94
role of data template 96
role of display template 98
when to customize 87

Customizing page handler classes
adding data to command links example 134
displaying the record just inserted 151
entering and formatting dates 143
lookup link example 126
making a field mandatory 158
populating data on an Insert page example 139
removing validation from a Search page 147
techniques with business rules 65
techniques with ClassHandler classes 64
where to 60
without the Customization Wizard 125

Customizing styles
adding new elements 109
basic procedures 108
browser caching problems 112
creating a new style sheet 109
identifying a style in the Page Handler 

dialog 111
making a style browser-independent 112
only modifying existing elements 109
scope considerations 108

Customizing WebEnterprise Designer classes
creating a single customizable page handler 

class 49
creating customizable classes, overview 48
creating customizable page handler classes for all 

pages 49
customization techniques 64
error reporting 61
general considerations 48
global customization 68
how to override methods 60
local vs. global 61
result sets, manipulating 66
techniques with business rules 65

D
dataform style element 107

datalist style element 107

Data templates
See also Page modes
customization examples 131, 136, 141
modifying the design of 96

Data types, declared type vs. runtime type 28

Dates, formatting
creating drop lists for 144
example 143
TOOL code for 145

DBService SO
See also service_nameDBService
description of function 189
replicating 187

DecodeValue method 37, 38, 66

Decoding data, from a WebEnterprise request 38

Define HTML template for exceptions 
(customization) 118

Define subsidiary applications 
(customization) 33, 179

Deleting customizable page handler classes 54
Index
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Deploying WebEnterprise Designer applications
as client or server 193
installing HTML template files on Scanner 

partition 194
procedures 193–195
telling the Scanner SO where HTML pages 

are 195

Diagrams
AccessService startup 32
class interactions, WebEnterprise Designer 

classes 28
ExpressHandlers class hierarchy 25
HTML application runtime anatomy 19
HTTP class hierarchy 24
life of a template request 35
partitions and objects at runtime 21
scanner startup 34

Displaying the record just inserted example 151

DisplayPage method 36, 38, 66

display style element 106

Display templates, modifying design template of 98

–docroot command-line flag 195

Document root
accessibility of directory to the ScannerService 

SO 194
default specification 195
defined by FORTE_WW_DOCUMENT_ROOT 195

DoInsert method, customization 151

DoSearch method 67

Drop list customizing examples
manually modifying lookup file 161
removing or setting the default 165

E
EnableAccess method 33

Entering and formatting dates example 143

entry.CurrentRow_busClassPage variable 45

entry.CurrentRowIndex_busClassPage variable 45

entry.FirstVisibleRow_busClassPage variable 45

entry.list_busClassPage variable 45

entry.RequestStatus_busClassPage variable 45

entry.Rows_busClassPage variable 45

entry.VisibleRows_busClassPage variable 45

entry result set 44

Environment variables
FORTE_WW_DOCUMENT_ROOT 195
FORTE_WW_EDITOR 53
FORTE_WW_HTMLEDITOR 53, 125
FORTE_WW_PORTS 188

error directory 114

Error handling
See also Customizing error pages
customization of 118
default process 114
error directory 114

ErrorMgr class, AddError method 61

Error pages, page design templates for 88

ExpressClassHandler class
AddConstraints method 38
BeforeInsert method 67
BeforeInsert method customization 145, 159
BeforeSearch method 67
BeforeUpdate method 67
DecodeValue method 37, 38, 66
decoding data from a WebEnterprise request 38
DisplayPage method 36, 38, 66
DoInsert method customization 151
DoSearch method 67
FillResultSet method 38
FindHandler method 36
formatting data into a result set 37
FormatValue method 37, 66
GetFieldAttrID method 37
GetFieldIndexID method 37
GetPageData method 64
HandleCondition method 19, 36
HandleTag method 19, 36
implementing the TagHandlerIFace interface 35
NewQuery method 64
ProcessAction method 36
referenced objects 36
role in class structure 35
transferring data between classes and pages 37
UpdateAttr method 63
UpdateClass method 38

ExpressHandler class, FindHandler method 38

ExpressHandlers project
class hierarchy 25
subclassing for global customization 68

ExpressHTTPAccess class
customizing 33
EnableAccess method 33
functional description 32
HasLogonHandler attribute 33
Customizing WebEnterprise Designer Applications



203Section F
ExpressHTTPAccess class (continued)
LogonSession method 33
SetSessionManagement method 183
SetupAccess method 32, 33
Setup method 32
SetupSessionManagement method 33, 198

ExpressLogonHandler class
functional description 39
HandleCondition method 39

ExpressLogonHandler class, HandleCondition 
method 173

ExpressLookupInfo class
functional description 40
GetDisplayedNullValue method 40

ExpressPageData class
AddForeignData method 39
and foreign result sets 39
CurrentRow attribute 39
FirstVisibleRow attribute 39
functional description 39

ExpressScanner class
functional description 34
Handlers attribute 38

Express Services classes, and the Web application 
server 22

ExpressValueGenerator class 40

ExpressWindows project
class hierarchy 25

F
Field indexes

and business class page fields 37
and the GetFieldAttrID method 37
and the GetFieldIndexID method 37
converting between 37

Fields, hidden
examples 79
identifying in HTML templates 75

FillResultSet method 38

FindHandler method 36, 38

FirstVisibleRow attribute 39

Folder pages, and ExpressPageData 39

footer style element 106

FormatValue method 37, 66

Form pages, page design templates for 89

FORTE.ExecURL variable
description 44
example 79

FORTE.UniqueID variable
description 44
example 82

FORTE_WW_DOCUMENT_ROOT environment 
variable

and deployment 195
constraints 195
setting 195

FORTE_WW_EDITOR environment variable 53

FORTE_WW_HTMLEDITOR environment 
variable 53, 125

FORTE_WW_PORTS environment variable 188

FORTE result set 44

FORTE tags (FORTE EXECUTE, FORTE IF, FORTE 
ITERATE, etc.), See WebEnterprise tags

G
Generated .base directory files 77

Generated classes
customizing 49
from business model, See Customizing Forte 

Express Applications
from HTML application model 26
modifying 60

Generated HTML pages, See Generated HTML 
templates

Generated HTML templates
business class pages, fancy 73
business class pages, generic 70
business class pages, simple 72
customizing a field on a search page 79
customizing font size on a data page 81
identifying hidden fields 75
identifying WebEnterprise tags 75
identifying WebEnterprise variables 75
installing on Scanner partition 194
link pages, generic 71
logon pages, generic 72, 172
Main template 70
preserving customizations, See Customizations, 

preserving
Scripts template 70
Start page 71
summary 27
where and where not to customize 74

Generated lookup files 71

Generated maintenance files 71

Generated TOOL code, for logon pages 172
Index
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generic.html file
corresponding exceptions 114
result set variables 117

GetDisplayedNullValue method 40

GetErrorTemplate method
html_modelAccess class 121
html_modelScanner class 119
HTMLScanner class 119
HTTPAccess class 121
warning 121

GetFieldAttrID method 37

GetFieldIndexID method 37

GetPageData method 64

GetTextData method 61

Global customization
and supplier plans 68
procedures 68
when to do 61

H
HandleCondition method

and logon pages 173
and runtime control flow 36
and the ScannerService SO 19
and user authentication 39
and WebEnterprise tags 35
defined in TagHandlerIFace 35

Handler classes, See Page handler classes

Handlers attribute 38

HandleTag method
and runtime control flow 36
and the ScannerService SO 19
and WebEnterprise tags 35
defined in TagHandlerIFace 35

HasLogonHandler attribute 33

header style element 106

html_modelAccess class
and customizing ExpressHTTPAccess 33
ConnectManagedSessions method 179
GetErrorTemplate method 121
IsPrimarySession method 179
LogonSession method 173
SetSessionManagement method 183

html_modelAccessService SO
See also AccessService SO
and error processing 114
and the deployment process 188
and the ExpressHTTPAccess.Setup method 32
description 186

html_modelHandlers project
customizable subclasses 27
description 26
HTML application’s main project 186
service objects of 188

html_model HTML templates, See Generated HTML 
templates

html_modelScanner class
and the html_modelScannerService SO 34
description 20
GetErrorTemplate method 119

html_modelScannerService SO
See also ScannerService SO
and error processing 114
and runtime control flow 36
and the deployment process 188
description 186
object interaction diagram of startup 34

HTML 4.0, and WebEnterprise Designer 104

HTML application model
classes generated from 26

HTML applications
load balancing 19

HTML document root, See Document root

htmlscanner.html file
corresponding error class 114
result set variables 116

HTMLScanner class, GetErrorTemplate method 119

HTMLScannerException class
attribute-result set variable list 116
corresponding error file 114

HTML templates
and page design elements 88
using links 41

httpaccess.html file
corresponding error class 114
result set variables 117

HTTPAccess class
GetErrorTemplate method 121
SessionCreationURL attribute 39, 172

HTTPAccessException class
attribute-result set variable list 117
corresponding error file 114

HTTP library
and compiled partitions 188
class hierarchy 24
installing compiled 197
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I
id identifier, and page styles 106

Insert command
adding a JavaScript call to 156
adding data to 134, 139
and ExpressValueGenerator class 40
customizing BeforeInsert method 145, 159

Insert templates
See also Page modes
customization 

examples 129, 137, 142, 144, 153, 154, 166

InstanceStatus attribute 62

IsPrimarySession method 179

Is subsidiary application (customization) 33, 179

J
JavaScript examples

adding call to Insert button 156
boilerplate script 154
location of validation scripts 147
making a field mandatory 154
removing a default from a drop list 166, 167
removing a script call from a template 149

JavaScript fields, page design templates for 90

L
labelform style element 107

labellist style element 107

labelmodify style element 107

LinkName URL parameter 42

Link pages
HTML templates generated for 71
page design templates for 90

Link tags, identifying page styles with 105

listentry.busClassPage_qq_fieldName variable 45
example 81, 132, 136

listentry.qqRowNumber variable 45

listentry result set 44

List pages, page design templates for 89

Load balancing
and port numbers 188
with AccessService SOs 19, 188

Local customization 61

Logon pages
and SESSION_REQUIRED 172
code generated for 172
creating 171
customizing 173
how activated 172
HTML templates generated for 72
validation fields 171

LogonSession method 33, 173

Logon Validation (customization) 173

Lookup files
businessClass_qq_attribute.inc file 163
generated 71
manually customizing drop lists or radio lists 161
preserving customizations in 164

Lookup link example 126

M
Main projects

and partitioning 186
html_modelHandlers project 186

Main template 70

Make Distribution command 193

manifest.txt file 71

Memory considerations, and session timeout 198

Menu design templates, modifying 95

Menus, creating in a page design 95

menu style element 106

Methods, how to override 60

Modify session timeout (customization) 183, 198

modify style element 106

MsgCatalog class, GetTextData method 61

N
Nested pages

adding data to command links of 134
and ExpressPageData 39

NewClass class, compared to NewClassForInsert 
class 64

New HTML Page command 171

NewQuery method 64
Index
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O
Object interaction diagrams

AccessService startup 32
a template request 35
scanner startup 34

P
Page designs

and code generation 91
and menus 95
directory of templates 86
identifiers 94
role in Web page production 86
scope 86
what they determine 86
when to customize 87

Page design templates
description of template file names 88
fancy 73
for different page elements 89
for error pages 88
for form and list pages 89
for JavaScript scripts 90
for link pages 90
for lookup fields 90
for page modes 89
for start pages 88
simple 72
variations on fancy 73

Page design templates, selectors
_RC_ 88
_RR_Name_ 89
_UniqueName_ 90
Data 89
HasJavaScripts 90
IsAabModel 88
IsDataWindow 89
IsFormWindow 89
IsLinkWindow 90
IsListWindow 89
LookupFields 90

Page handler classes
and HandleTag and HandleCondition 

methods 35
BeforeInsert method customization 145, 159
connections between 38
customization techniques 64
desciption 20
DoInsert method customization 151

finding by name 38
referencing other page handlers 38
RestrictInsertAccess method customization 176

Page handler customizations
Application category 56
creating an initialized object in a page 64
customization techniques 64
customizing manually 60
Define HTML template for exceptions 118
Define subsidiary applications 33, 179
Fields category 66
getting the initial query 64
getting the result set 64
Insert (Database Operations) 145, 159
Is subsidiary application 33, 179
list of all customization points 58
local vs. global 61
Logon Validation 173
Modify session timeout 183, 198
Restricting access to page modes 176
summary of categories 57

Page Handler Customization Wizard
about 51
accessing online help 51, 57
application-wide customizations 56
automatically generating a customizable page 

handler class 53
customizing error pages 118
deleting customizations 54
indicator that customization exists 54
list of all customization points 58
Lookup Data Files example 163
using 52

Page modes
adding a variable to Insert command link in Data 

template 136
adding customized link to Data template 131
adding drop lists in the Insert template 144
adding lookup link to Insert template 126
adding mandatory field validation to Insert 

template 153
creating drop lists for date formatting on Insert 

template 143
customizing 74
page design templates for 89
passing data to Insert template 134
populating a field in the Insert 

template 142, 154
populating data on an Insert template 139
removing default from a drop list 166
removing validation from a search template 149
restricting access to 176
validating a whole form from a search 

template 153
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Partition command 190

Partitioning WebEnterprise Designer applications
as client or server 191
canceling if unable to exit 192
default configuration 190
main project (html_modelHandlers) 186
partition_id directory name 195
procedures 186–191
service objects 186
starting server partitions 196
stopping remote partitions 192
supplier project (business_modelServices) 186
testing distributed 192
unassigned service objects 191

PDF files, viewing and searching 16

Populating data on an Insert page example 139

Port numbers
and AccessService SOs 188
and FORTE_WW_PORTS 188

ProcessAction method 36

R
Radio list customizing examples

manually modifying lookup file 161
removing or setting the default 165

Referenced objects, and ExpressClassHandler class 36

Registration, customizing 33

report.txt file
and simple HTML changes 76
conflicting model changes 77
description 71
simple model changes 77

#reqstatus style element 107

Restricting access to page modes (customization) 176

RestrictInsertAccess method 176

Result sets
and attribute IDs 62
and BusinessClass.InstanceStatus attributes 62
and session management features 38
entry 44
foreign 39
formatting data into 37
FORTE 44
inserted record, changing default position 151
listentry 44
manipulating 66
USER 44

Result set variables
creating your own 118
description 116

ReturnTemplate URL parameter 42

Revert method 63

rowidlist style element 107

Run menu
Cancel Run command 192
Partition command 190
Run command 192
Stop Remote Partitions command 192

S
ScannerServer partition

and WebEnterprise Designer architecture 19
installing HTML template files on 194
when to compile 188

ScannerService SO
accessibility to the document root directory 194
and error processing 114
and the HandleCondition method 19
and the HandleTag method 19
description of functions 19, 189
replication status 188

Scripts template 70

Search templates, customization examples 149, 153

Security, See Customizing application security

Security environment, sharing
about 178
restrictions 180

Selection URL parameter 43

service_nameDBService 187

service_nameService 187

ServiceName URL parameter 41

Service objects
creating 187
description of interaction 189
generated from business model 186–190
generated from HTML model 186–190
html_modelAccessService 186
html_modelScannerService 186
service_nameDBService 187
service_nameService 187
unassigned 191
which can be replicated 188
Index
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Service SO
See also service_nameService
description of function 189
replicating 187

SESSION_AUTOCREATE property 171

SESSION_REQUIRED property 172

SessionCreationURL attribute 39, 172

Session management
and logon pages 172
and secure applications 170
and shopping cart applications 170
authenticating users 171
customizing 33
for included applications 33
how session ids are tracked 170
how session timeout works 181
ideal timeout setting 182
session property without logon page 171
sharing security environment across 

applications 178
storing state information in Web 

applications 170
tracking sessions 170

Session properties
when SESSION_AUTOCREATE is used 171
when SESSION_REQUIRED is used 172

Session timeout
and AccessService service object 198
customizing 183, 198
default 198
finding the ideal setting 182
how it works 181
resuming the session 181

SessionTimeOut attribute 181

SetSessionManagement method 183

SetupAccess method 32, 33

Setup method 32

SetupSessionManagement method
and session timeout 198
role in customization 33

Start page 71

Start pages, page design templates for 88

steel.css file, location 104

Style elements
#reqstatus 107
adata 106
alabel 106
alink 106
amenu 106

buttonlogon 107
buttons 107
captionform 107
captionlist 107
captionlogon 107
captionmenu 107
dataform 107
datalist 107
display 106
footer 106
header 106
labelform 107
labellist 107
labelmodify 107
menu 106
modify 106
rowidlist 107

Styles
and deprecated features 104
class identifier 105
conformation to HTML 4.0 104
customizing, See Customizing styles
definition of elements 106
description 104
identifying in link tags 105
id identifier 106
location of style sheet files 104
specifying in HTML template 105

Subsidiary applications, managing (example) 179

Supplier plans, See Supplier projects

Supplier projects
and partitioning 186
business_modelServices 186

T
TagHandlerIFace interface 20

TagHandlerIFace interface, implemented by 
ExpressClassHandler 35

TemplateName URL parameter 42

Template request, life of
detailed description 30
general overview 19
object interaction diagram of 35

Testing distributed 192

Three-tier architecture 18

TOOL code conventions 13
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U
UniqueID variable 83

Uniquifier URL parameter 43, 83, 131

UpdateAttr method 63

UpdateClass method 38

UpdateQuery attribute 63

URL parameters
Action 42
LinkName 42
ReturnTemplate 42
Selection 43
ServiceName 41
TemplateName 42
Uniquifier 43
usage 41

USER.TopPage variable
description 44
example 82

USER result set 44

V
Validation

adding to a field 148
and ExpressLookupInfo 40
creating a drop or radio list manually 161
making a field mandatory 158
removing a default from a drop list 166
removing from a page mode 147
removing from a template 149
setting or removing a radio or drop list 

default 165
whole field validation 153

Variables, environment, See Environment variables

Variables, WebEnterprise Designer, See 
WebEnterprise Designer variables

W
Web application server

and Express Services classes 22
architecture 20
example 20

WebEnterprise Designer
conformation to HTML 4.0 104
customization guidelines 20
customizing security, See Customizing application 

security
error directory 114
error handling 114
logical architecture 18
projects 23
result set variables 44, 116
runtime architecture 19
runtime scenarios 31
session management, See Session management
styles, See Styles
URL parameters 41
variables 44

WebEnterprise Designer applications
deploying 193–195
deploying as client or server 193
distributed testing 192
generated service objects 186–190
main project (html_modelHandlers) 186
partitioning 186–191
partitioning, default configuration 190
supplier project (business_modelServices) 186

WebEnterprise Designer classes
customizable 49
working with business classes 62

WebEnterprise Designer class structure
and server registration 33
and session management 33
authenticating logon information 33
diagram 28
role of ExpressClassHandler 35–38
role of ExpressHTTPAccess 32
role of ExpressLogonHandler class 39
role of ExpressLookupInfo class 40
role of ExpressPageData 39
role of ExpressScanner class 34
role of ExpressValueGenerator class 40

WebEnterprise Designer projects
ExpressHandlers project 25
html_modelHandlers project 26
HTTP Library 24

WebEnterprise Designer URL parameters
Action 42
LinkName 42
ReturnTemplate 42
Selection 43
Uniquifier 43
Index
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WebEnterprise Designer variables
entry.CurrentRow_busClassPage 45
entry.CurrentRowIndex_busClassPage 45
entry.FirstVisibleRow_busClassPage 45
entry.list_busClassPage 45
entry.RequestStatus_busClassPage 45
entry.Rows_busClassPage 45
entry.VisibleRows_busClassPage 45
examples 130, 131, 136, 141
FORTE.ExecURL 44
FORTE.parameter_name 116
FORTE.UniqueID 44
listentry.busClassPage_qq_fieldName 45, 132, 1

36
listentry.qqRowNumber 45
lookup link example 132
usage 44
USER.TopPage 44

WebEnterprise error handling 114

WebEnterprise Listening Port number
and FORTE_WW_PORTS 188
and load balancing 188

WebEnterprise tags
about 20
example of FORTE IF 79, 81
format convention used in book 36
identifying in HTML templates 75

WebEnterprise URL parameters
ServiceName 41
TemplateName 42
usage 41

WebEnterprise variables
examples 81
identifying in HTML templates 75

Web server
and fortecgi program 19
and Forte Web server plug-in 19

Web server root directory
and graphics files 163
and styles 104
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